68P09258A31-A Bay Level Offset Calibration

Test Equipment Set-up for RF Path Calibration

Follow the procedure iqj"able 3-35 to set up test equipment.

Table 3-35: Set Up Test Equipment for RF Path Calibration

Step Action

1 If it has not already been done, refer to the procedure irrFable 3-5 (on pagq3-17) to interface the LMF
computer terminal to the frame LAN A connector.

If it has not already been done, refer tqable 3-6 (on pagq3-26) to start a GUI LMF session.
If required, calibrate the test equipment per the procedure irpJable 3-27 (on pagq3-78).
NOTE

Verify the GPIB controller is properly connected and turned on.

! CAUTION

To prevent damage to the test equipment, all transmit (TX) test connections must be via the 30 dB
directional coupler for 800 MHz with an additional 20 dB in—line attenuator for 1.7/1.9 GHz.

4 For TX path calibration, connect the test equipment as shown irfffigure 3-16figure 3-17, or
figure 3-19, depending on the communications analyzer being used.

Transmit (TX) Path Calibration Description

The assigned channel frequency and power level (as measured at the top
of the frame) for transmit calibration are derived from the site CDF files.
For each BBX, the channel frequency is specified in the ChannelList
CDF file parameter and the power is specified in the SIFPilotPwr
CDF file parameter for the sector associated with the BBX (located
under the ParentSECTOR field of the ParentCARRIER CDF file
parameter).

NOTE If both the BTS—x.cdf and CBSC—x.cdf files are current, all
information will be correct on the LMF. If not, the carrier and
channel will have to be set for each test.

The calibration procedure attempts to adjust the power to within +0.5 dB
of the desired power. The calibration will pass if the error is less than
+1.5 dB.

The TX Bay Level Offset at sites WITHOUT the directional coupler
option, is approximately 42.0 dB +3.0 dB.

e Atsites WITHOUT RFDS option, BLO is approximately
42.0 dB $4.0 dB. A typical example would be TX output power
measured at BTS (36.0 dBm) minus the BBX TX output level
(approximately —6.0 dBm) would equate to 42 dB BLO.

The TX Bay Level Offset at sites WITH the directional coupler option,
is approximately 41.4 dB £3.0 dB. TX BLO = Frame Power Output
minus BBX output level.

¢ Example: TX output power measured at RFDS TX coupler
(39.4 dBm) minus the BBX TX output level (approximately
—2.0 dBm) and RFDS directional coupler/cable (approximately
—0.6 dBm) would equate to 41.4 dB BLO.
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TX Calibration and the LMF

The LMF Tests > TX > TX Calibration... and Tests > All Cal/Audit...
selections perform TX BLO calibration testing for installed BBX(s). The
All Cal/Audit... selection initiates a series of actions to perform TX
calibration, and if calibration is successful, download BLO and perform
TX audit. The TX Calibration... selection performs only TX
calibration. When TX Calibration... is used, BLO download and TX
audit must be performed as separate activities. The CDMA Test
Parameters window which opens when TX Calibration... or All
Cal/Audit... is selected contains several user—selectable features which
are described in the following subsections.

Rate Set Drop-down Pick List

The Rate Set Drop—down Box is enabled if at least one MCC card is
selected for the test. The available options for TX tests are 1 = 9600, and
3 = 9600 1X. Option 3 is only available if 1X cards are selected for the
test. The available transfer rate options for RX tests are 1 = 9600 and

2 = 14400. Option 2 is only available if no 1X cards are selected.

Verify BLO

In both the TX Calibration and All Cal/Audit dialog boxes, a Verify
BLO checkbox is provided and checked by default. After the actual TX
calibration is completed during either the TX Calibration or All
Cal/Audit process, the BLO derived from the calibration is compared to
a standard, acceptable BLO tolerance for the BTS. In some installations,
additional items may be installed in the transmit path. The additional
change in gain from these items could cause BLO verification failure
and, therefore, failure of the entire calibration. In these cases, either the
Verify BLO checkbox should be unchecked or the additional path losses
should be added into each applicable sector using the

Util>Edit>TX Coupler Loss... function.

Single-Sided BLO Checkbox

Another option that appears in the pull-down menu is Single—sided
BLO. Normally valid BLO values are some value plus—or—minus some
offset. The ranges that we currently use for calibration are wider than
necessary to accommodate the redundant BBX. The lower half of that
range is where non—-redundant BBXs should be. When Single-sided
BLO is selected, the result is only considered a success if it is in the
lower half of the range. If it was normally a success from 37-47 (which
is 42 +5), Single-sided BLO would make it a success only if the result
was from 37-42. To get the more stringent conditions, the operator
checks Single-sided BLO when calibrating non-redundant transceivers.
Single—sided BLO carries the likelihood of more failures. This option
should only be used by experienced CFEs.
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Test Pattern Drop-down Pick List

The Tests > TX > TX Calibration... menu window has a Test Pattern
pull-down menu. This menu has the following choices:

* Pilot (default) — performs tests using a pilot signal only. This pattern
should be used when running in—service tests. It only requires a BBX
to do the test.

¢ Standard - performs the tests using pilot, synch, paging and six
traffic channels. This pattern should be used on all non—in—service
tests. Standard requires a BBX and an MCC. Standard uses gain
values specified by the IS97 standard.

* CDFPilot —performs the tests using the pilot signal, however, the gain
is specified in the CDF file. Advanced users may use CDFPilot to
generate a Pilot pattern using the value specified by the PilotGain
parameter in the CDF file instead of a pre—determined value.

* CDF - performs the tests using pilot, synch, paging and six traffic
channels, however, the gain for the channel elements is specified in
the CDF file. Advanced users may use CDF to generate a standard
pattern. Instead of using the values specified by 1S97, the settings for
the following CDF parameters are used:

PilotGain
PchGain
SchGain
NomGain1Way

Set-up for TX Calibration

The workaround iqj“able 3-36 allows the user to manually set the BLO
limits to ensure that the redundant BBX BLO test does not fail due to the
preset offset being incorrectly set for the frame under test. A future LMF
release will correct this problem.

Table 3-36: Initial Set-up for TX Calibration

v~ Step Action

1 Delete the existing calibration file (if any) from the BTS folder on LMF
laptop from the location C:\wlmf\cdma\bts—#, where # is the BTS
number.

2 To edit the nominal TX BLO, from the Util menu, select Edit > TX
Nominal Offset. In the TX Cal Parameter window, make any necessary
changes to ensure the Tx BLO Nominal Offset (in dB) is correct:

— For 800 MHz, the value is 45.0 (dB), OR
— For 1900 MHz, the value is 43.0 (dB).

3 Download the data, which includes BLO values, to all the BBXs. From the
Device menu, select Download > Data
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TX Calibration

WARNING Before installing any test equipment directly to any TX OUT

connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

CAUTION Always wear an approved anti—static wrist strap while handling

any circuit card or module. If this is not done, there is a high
probability that the card or module could be damaged by ESD.

All Cal/Audit and TX Calibration Procedure

The LMF All Cal/Audit and TX calibration procedures are essentially
identical, except for the step that selects the type of procedure desired
(Refer to Step4 ipJable 3-37).

Prerequisites

Before running this procedure, be sure that the following have been
done:

¢ The card in slot CSM 1, GLIs, MCCs, and BBXs have correct code
and data loads.

® Primary CSM and MGLI are INS_ACT (bright green).
e All BBXs are OOS_RAM (yellow).

¢ If running calibration or audit using a test pattern other than Pilot,
MCCs are INS_ACT (bright green).

* Test equipment and test cables are calibrated and connected for TX
calibration.

* LMF is logged into the BTS in the GUI environment.

NOTE

Verify all BBX boards removed and repositioned have been
returned to their assigned shelves/slots. Any BBX boards moved
since they were downloaded will have to be downloaded again.

All Cal Audit/TX Path Calibration procedure

Follow the procedure irfable 3-37 to perform the All Cal/Audit and TX
path calibration test.

Table 3-37: All Cal/Audit and TX Calibration Procedure

»~| Step Action
1 If it has not already been done, configure test equipment for TX calibration by following the
procedure irpfable 3-35.
2 Click on the BBX(s) to be calibrated.
If the Test Pattern to be used is Standard, CDFPilot, or CDF, select at least one MCC (refer to
“Test Pattern Drop—down Pick List” under “TX Calibration and the LMF” in this section).
... continued on next page
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ﬂable 3-37: All Cal/Audit and TX Calibration Procedure

| Step

Action

For All Cal Audit...

— Click Tests in the BTS menu bar, and select TX > All Cal/Audit... from the pull-down
menus. A CDMA Test Parameters window will appear.

For TX Calibration

— Click Tests in the BTS menu bar, and select TX > TX Calibration from the pull-down
menus. A CDMA Test Parameters window will appear.

Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed
in the Channels/Carrier pick list.

NOTE

To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to
select multiple carrier(s)—sector(s).

Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box. If it is not, obtain the latest bts—#.cdf (or bts—#.necf) and cbsc—#.cdf files from the CBSC.

NOTE

If necessary, the correct channel number may be manually entered into the Carrier # Channels
box.

If at least one MCC was selected in Steq%, select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop—down list in the Rate Set box.

NOTE

The rate selection of 3 is only available if 1X cards are selected for the test.

If Verify BLO is to be used during the calibration, leave the checkbox checked (default).

If Single—Sided BLO is to be used during the calibration, click on the checkbox.

* IMPORTANT

Single—Sided BLO should only be used for primary BBXs. Do not check the box when
calibrating the redundant BBX.

10

In the Test Pattern box, select the test pattern to use for the calibration from the drop—down list
(refer to “Test Pattern Drop—down Pick List” under “TX Calibration and the LMF” in this section

— see pagqj—91).

11

Click OK to display the status report window followed by a Directions pop-up window.

12

Follow cable connection directions as they are displayed. When the calibration process is
completed, results will be displayed in the status report window.

13

Click on the Save Results or Dismiss button, as desired, to close the status report window.

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re—run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.
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Download BLO Procedure

After a successful TX path calibration, download the bay level offset
(BLO) calibration file data to the BBXs. BLO data is extracted from the
CAL file for the Base Transceiver Subsystem (BTS) and downloaded to
the selected BBX devices.

NOTE

If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

Prerequisites

Ensure the following prerequisites have been met before proceeding:
* BBXs being downloaded are OOS—-RAM (yellow).

® TX calibration is successfully completed.

Follow the steps iTJable 3-38 to download the BLO data to the BBXG.

Table 3-38: Download BLO

v~ Step Action

1 Select the BBX(s) to be downloaded.

2 Click Device in the BTS menu bar, and select Download
> BLO from the pull-down menus. A status report
window displays the result of the download.

NOTE

Selected device(s) do not change color when BLO is
downloaded.

3 Click on OK to close the status report window.

Calibration Audit Introduction

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibration offsets. The calibration audit
procedure measures the path gain or loss of every BBX transmit path at
the site. In this test, actual system tolerances are used to determine the
success or failure of a test. The same external test equipment set up is
used.

NOTE

RF path verification, BLO calibration, and BLO data download
to BBXs must have been successfully completed prior to
performing the calibration audit.
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TX Path Audit

Perform the calibration audit of the TX paths of all equipped BBX slots
per the procedure irfFable 3-39

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

NOTE If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

TX Audit Test

The Tests menu item, TX Audit, performs the TX BLO Audit test for a
BBX(s). All measurements are made through the appropriate TX output
connector using the calibrated TX cable setup.

Prerequisites

Before running this test, ensure that the following have been done:
CSM-1, GLIs, and BBXs have correct code load and data load.
Primary CSM and MGLI are INS.

All BBXs are OOS_RAM.

* Test equipment and test cables are calibrated and connected for TX
BLO calibration.

LMF is logged into the BTS.
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TX Path Audit procedure

After a TX calibration has been performed, or if verification of BLO data
in the CAL file is required, follow the procedure irrable 3-39 to
perform a BTS TX path audit.

Table 3-39: BTS TX Path Audit

»~| Step

Action

If it has not already been done, configure test equipment for TX path audit by following the procedure
irJable 3-35 (TX audit uses the same configuration as TX calibration).

Select the BBX(s) to be audited.

If the Test Pattern to be used is Standard, CDFPilot or CDF, select at least one MCC (refer to
“Test Pattern Drop—down Pick List” under “TX Calibraton and the LMF” in this section).

Click Tests in the BTS menu bar, and select TX>TX Audit... from the pull-down menus. A
CDMA Test Parameters window will appear.

Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.
NOTE

To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to
select multiple carrier(s)—sector(s).

Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box. If it is not, obtain the latest bts—#.cdf (or bts—#.necf) and cbsc—#.cdf files from the CBSC.

NOTE

The correct channel number may be manually entered into the Carrier # Channels box.

If at least one MCC was selected in Steq%, select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop—down list in the Rate Set box.

NOTE

The rate selection of 3 is only available if 1X cards are selected for the test.

Select Verify BLO (default) or Single-sided BLO.
NOTE

Single-sided BLO is only used when checking non-redundant transceivers.

In the Test Pattern box, select the test pattern from the drop—down list (refer to “Test Pattern
Drop—down Pick List” — see pagqj—91).

10

Click OK to display the status report window followed by a Directions pop-up window.

11

Follow the cable connection directions as they are displayed. When the calibration process is
completed, results will be displayed in the status report window.

12

Click on the Save Results or Dismiss button, as desired, to close the status report window.

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the Status Report window and provides information in the
Description field. Recheck the test setup and connection and re—run the
test. If the tests fail again, note specifics about the failure, and refer to
Chapter 6, Troubleshooting.
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All Cal/Audit Test

The Tests menu item, All Cal/Audit, performs the TX BLO Calibration
and Audit test for a XCVR(s). All measurements are made through the
appropriate TX output connector using the calibrated TX cable setup.

NOTE If the TX calibration portion of the test passes, the BLO data is
automatically downloaded to the BBX(s) before the audit portion
of the test is run.

Prerequisites

Before running this test, ensure that the following have been done:
e CSM-1, GLIs, BBXs have correct code and data loads.

® Primary CSM and MGLI are INS.

¢ All BBXs are OOS_RAM.

* Test equipment and test cables are calibrated and connected for TX
BLO calibration.

* LMF is logged into the BTS.
Follow the procedure iqj“able 3-40 to perform the All Cal/Audit test.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

Table 3-40: All Cal/Audit Test

»~| Step

Action

Select the BBX(s) to be tested.

NOTE

If STANDARD, CDFPilot, or CDF is selected for the TEST PATTERN, then at least one MCC
must be also selected.

From the Tests menu, select All Cal/Audit.

Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.
Press and hold the <Shift> or <Ctrl> key to select multiple items.

Type the appropriate channel number in the Carrier n Channels box.

If at least one MCC was selected in Stepd select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop—down list in the Rate Set box.

NOTE

The rate selection of 3 is only available if 1X cards are selected for the test.

Select Verify BLO or Single-sided BLO.
NOTE

Single-sided BLO is only used when checking non-redundant transceivers.

In the Test Pattern box, select the test pattern from the drop—down list (refer to “Test Pattern
Drop—down Pick List” — see pagqj—91).

Click on OK.

... continued on next page
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ﬂable 3-40: All Cal/Audit Test

v~ Step Action

9 Follow the cable connection directions as they are displayed. A status report window displays the
test results.

10 | Click on Save Results or Dismiss to close the status report window.

Create CAL File

The Create Cal File function gets the BLO data from BBXs and
creates/updates the CAL file for the BTS. If a CAL file does not exist, a
new one is created. If a CAL file already exists, it is updated. After a
BTS has been fully optimized, a copy of the CAL file must exist so it
can be transferred to the CBSC. If TX calibration has been successfully
performed for all BBXs and BLO data has been downloaded, a CAL file
exists. Note the following:

B
3
_

* The Create Cal File function only applies to selected (highlighted)
BBXs.

WARNING The user is not encouraged to edit the CAL file as this action can
cause interface problems between the BTS and the LMF. To
manually edit the CAL file, you must first logout of the BTS. If
you manually edit the CAL file and then use the Create Cal File
function, the edited information is lost.

Prerequisites

Before running this test, the following should be done:
* LMF is logged into the BTS.
* BBXSs are OOS_RAM with BLO downloaded.

Creating a CAL File

Table 3-41: Create CAL File

v~ Step Action

1 Select the applicable BBXs.

NOTE
The CAL file is only updated for the selected BBXSs.

Click on the Device menu.

Click on the Create Cal File menu item. A status report
window displays the results of the action.

4 Click OK to close the status report window.
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RFDS Set-up and Calibration

RFDS Set-up and Calibration

RFDS Description

NOTE

The RFDS is not available for the 48 V BTS at the time of this
publication.

RFDS Parameter Settings

The optional RFDS performs RF tests of the site from the CBSC or from
an LMF. The RFDS consists of the following elements:

* Antenna Select Unit (ASU)
* Fixed Wireless Terminal Interface Card (FWTIC)
* Subscriber Unit Assembly (SUA)

For complete information regarding the RFDS, refer to the CDMA
CDMA RFDS Hardware Installation; 68P64113A93, CDMA RFDS

User’s Guide; 68P64114A51, and the LMF Help function on—line
documentation.

The bts—#.cdf file includes RFDS parameter settings that must match the
installed RFDS equipment. The paragraphs below describe the editable
parameters and their defaults;Fable 3-42 explains how to edit the
parameter settings.

¢ RfdsEquip — valid inputs are 0 through 2.
0 = (default) RFDS is not equipped
1 = Non-Cobra/Patzer box RFDS
2 = Cobra RFDS

¢ TsuEquip - valid inputs are 0 or 1
0 = (default) TSU not equipped
1 =TSU is equipped in the system

* MCI1....4 — valid inputs are 0 or 1
0 = (default) Not equipped
1 = Multicouplers equipped in RFDS system
(9600 system REDS only)

* Asul/2Equip - valid inputs are 0 or 1
0 = (default) Not equipped
1 = Equipped

29

¢ TestOrigDN — valid inputs are *”’ (default) or a numerical string up to
15 characters. (This is the phone number the RFDS dials when
originating a call. A dummy number needs to be set up by the switch,
and is to be used in this field.)

NOTE

Any text editor may be used to open the bts—#.cdf file to verity,
view, or modify data. Because the bts—#.cdf file is generated on
a Unix system, a more sophisticated editor, such as MicroSoft
WordPad, will display file content in a more easily-read format
than many simple text editors.
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Checking and Setting RFDS Parameters

Follow the procedure ifable 3-42 to review and/or edit RFDS
parameters.

Table 3-42: RFDS Parameter Settings

Step

Action

Important! Log out of the BTS prior to performing this procedure.

Using a text editor, verify the following fields are set correctly in the bts—#.cdf file:
EXAMPLE:

1
0 (1 if system is non-duplexed)

AsulEquip
Asu2Equip
MclEquip
Mc2Equip
Mc3Equip
Mc4Equip
RfdsEquip = 2
TestOrigDN =
TsuEquip = 1

NOTE

The above is an example of entries extracted from the bts—#.cdf file that should have been generated
by the OMC-R and copied to the LMF. These fields will have been set by the OMC-R if the
RFDSPARM database is modified for the RFDS.

o O oo

"123456789"

Save changes and/or quit the editor.

Log into the BTS using an LMF GUI session (refer tqJable 3-6).

If no changes were made to the bts—#.cdf file fields listed in Ste3, proceed to Stegr). If changes were
made, continue with Steqﬁ.

6a

6b
6¢

6d
6e
6f

6g
6h

NOTE

To make certain the complete data download is accepted, the MGLI should be OOS_RAM (yellow)
when RFDS parameter settings are downloaded.

When changes are made to RFDS parameters in the bts—#.cdf file, data must be downloaded to the
MGLI by performing the following:

— To be sure it does not take control when the MGLI is disabled, manually disable the redundant
GLI card by unseating it from the backplane connectors and sliding it partially out of the shelf
slot.

— Click on the MGLI.

— Click on Device in the BTS menu bar, and select Disable from the pull-down menu. A status
report window shows the status of the operation.

— When the operation is complete, click OK to close the status report window.
— Click on the MGLI (now OOS_RAM (yellow)).

— Click on Device in the BTS menu bar, and select Download > Data from the pull-down menus
(selected devices do not change color when data is downloaded). A status report window shows
the status of the download.

— Click OK to close the status report window.
— Click on the MGLI.

... continued on next page
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[Table 3-42: RFDS Parameter Settings

Step Action
6i — Click on Device in the BTS menu bar, and select Enable from the pull-down menu. A status
report window shows the status of the operation.
6j — When the operation is complete, click OK to close the status report window.
! CAUTION
When the MGLI changes to INS_ACT, data will automatically be downloaded to the RFDS. During
this process, the RFDS LED will slowly begin flashing red and green for approximately 2—3 minutes.
DO NOT attempt to perform any functions with the RFDS until the LED remains steady green.
6k — Re-seat the redundant GLI card into the backplane connectors and lock it in place with the ejector
tabs.
61 — Once the redundant GLI initializes, download data to it by selecting the card and, in the BTS
menu bar, clicking Device and selecting Download > Data from the pull-down menus.
7 Any MCCs that were INS_ACT when the MGLI was disabled must be disabled, downloaded with
data, and re—enabled as follows:
7a — Select the devices to be reset by clicking on them or using Select from the BTS menu bar and
clicking on MCCs in the pull-down menu.
7b — In the BTS menu bar, click on Device and select Disable from the pull-down menu. A status
report window shows the status of the operation.
Tc — Click OK to close the status report window.
7d — Repeat Stea to select the MCCs.
Te — Click on Device in the BTS menu bar and select Download > Data from the pull-down menu.
(Selected devices do not change colot when data is downoaded.)
— A status report window shows the status of the download.
7t — Click on OK to close the status report window.
7g — When data download is complete, enable the MCCs by following the procedure iqj"able 3-17.
8 Click on the RFDS tab.
9 Status the RFDS TSU by performing the following:
9a — Click on the SUA to select it.
9b — Click on TSU in the BTS menu bar, and select Status TSU from the pull-down menu. A status
report shows the software version number for the TSIC and SUA.
9c — Click OK to close the status report window.
NOTE
If the LMF displays an error message, check the following:
* Ensure AMR cable is correctly connected from the BTS to the RFDS.
* Verify RFDS has power.
¢ Verify RFDS status LED is green.
* Verify entries in RFDS fields of the bts—#.cdf file are correct (refer to Steg3).
¢ Status the MGLI and ensure it is communicating (by Ethernet) with the LMF, and is in the proper
state (INS_ACT (bright green)).
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RFDS TSU NAM Programming

3

The Number Assignment Module (NAM) information needs to be
programmed into the TSU before it can receive and process test calls, or
be used for any type of RFDS test. The RFDS TSU NAM must be
programmed with the appropriate system parameters and phone number
during hardware installation. The TSU phone and TSU MSI must be
recorded for each BTS used for OMC-R RFDS software configuration.

NOTE The user will only need to program the NAM for the initial
install of the RFDS.

. Explanation of Parameters used when Programming the TSU NAM

[Jable 3-43 defines the parameters used when editing the tsu.nam file.

Table 3-43: Definition of Parameters

Access_Overload_Code
Slot_Index

System ID

Network ID

These parameters are obtained from the switch.

Primary_Channel A
Primary_Channel B
Secondary_Channel A
Secondary_Channel B

These parameters are the channels used in operation of the system.

Lock_Code
Security_Code
Service_Level
Station_Class_Mark

Do not change.

IMSI_11_12
IMSI_MCC

These fields are obtained at the OMC using the following command:
OMCO000>disp bts—# imsi

If the fields are blank, replace the IMSI fields in the NAM file to 0,
otherwise use the values displayed by the OMC.

MIN Phone Number

This field is the phone number assigned to the mobile. The ESN and
MIN should be entered into the switch as well.
NOTE

This field is different from the TODN field in the bts—#.cdf file. The
MIN is the phone number of the RFDS subscriber, and the TODN is
the number the subscriber calls.

3-102
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Valid NAM Ranges

[Jable 3-44 provides the valid NAM field ranges. If any of the ficlds are
missing or out of range, the RFDS errors out.

Table 3-44: Valid NAM Field Ranges
Valid Range
NAM Field Name Minimum Maximum

Access_Overload_Code 0 15
Slot_Index 0 7
System ID 0 32767
Network ID 0 32767
Primary_Channel A 25 1175
Primary_Channel B 25 1175
Secondary_Channel A 25 1175
Secondary_Channel B 25 1175
Lock_Code 0 999
Security _Code 0 999999
Service_Level 0 7
Station_Class_Mark 0 255
IMSI_11_12 0 99
IMSI_MCC 0 999
MIN Phone Number N/A N/A
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Set Antenna Map Data

The antenna map data must be entered manually if an RFDS is installed.
Antenna map data does not need to be entered if an RFDS is not
installed. The antenna map data is only used for RFDS tests and is
required if an RFDS is installed.

Prerequisite
* Logged into the BTS

Follow the procedure iqj“able 3-45 to set antenna map data for the
RFDS.

Table 3-45: Set Antenna Map Data

Step Action
1 Click on Util in the BTS menu bar, and select Edit > Antenna Map... from the pull-down menus. A
tabbed data entry pop—up window will appear.
2 In the data entry pop—up window, click on the TX Antenna Map or RX Antenna Map tab to select
the antenna map to be edited.
3 Locate the carrier and sector number for which data is to be entered or edited, and click in the column
where entry or editing is needed.
4 Enter/edit Antenna # and Antenna Label column data as needed for each carrier.
NOTE
Refer to the CDMA Help > Utility Menu > Edit—-Antenna Map... section of LMF Help function
on—line documentation for antenna map examples.
5 For each tab with changes, click on the Save button to save displayed values.
6 Click on the Dismiss button to close the window.
NOTE
* Values entered or changed after the Save button was used will be lost when the window is
dismissed.
* Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.
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Set RFDS Configuration Data

If an RFDS is installed, the RFDS configuration data must be manually
entered.

Prerequisite
* LMF is logged into the BTS

NOTE The entered antenna# index numbers must correspond to the
antenna# index numbers used in the antenna maps.

Follow the procedure i Jable 3-46 to set the RFDS Configuration Data.

-l

Table 3-46: Set RFDS Configuration Data

Step Action

1 Click on Util in the BTS menu bar, and select Edit > RFDS Configuration... from the pull-down
menus. A tabbed data entry pop—up window will appear.

2 In the data entry pop—up window, click on the TX RFDS Configuration or RX RFDS Configuration
tab, as required.

3 To add a new antenna number, perform the following:

3a — Click on the Add Row button.

3b — Click in the Antenna #, Cal Antenna, Scap Antenna, or Populate [Y/N] columns, as required.
3c — Enter the desired data.

4 To edit existing values, click in the data box to be changed and change the value.

NOTE

Refer to the CDMA Help > Utility Menu > Edit-RFDS Configuration... section of LMF Help
function on—line documentation for RFDS configuration data examples.

5 To delete a row, click on the row and then click on the Delete Row button.

6 For each tab with changes, click on the Save button to save displayed values.

7 Click on the Dismiss button to close the window.

NOTE

* Values entered or changed after the Save button was used will be lost when the window is
dismissed.

* Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.

Oct 2003 1X SC™ 4812T BTS Optimization/ATP 3-105



-l

RFDS Set-up and Calibration

68P09258A31-A

RFDS Calibration

The RFDS Calibration option is used to calibrate the RFDS TX and RX
paths.

TX Path Calibration — For a TX antenna path calibration the BTS
XCVR is keyed at a pre—determined power level and the BTS power
output level is measured by the RFDS. The power level is then measured
at the TX antenna directional coupler by the power measuring test
equipment item being used (power meter or analyzer). The difference
(offset) between the power level at the RFDS and the power level at the
TX antenna directional coupler is used as the TX RFDS calibration
offset value.

RX Path Calibration — For an RX antenna path calibration the RFDS is
keyed at a pre—determined power level and the power input level is
measured by the BTS BBX. A CDMA signal at the same power level
measured by the BTS BBX is then injected at the RX antenna directional
coupler by the communications system analyzer. The difference (offset)
between the RFDS—keyed power level and power level measured at the
BTS BBX is the RFDS RX calibration offset value.

RFDS calibration and the CAL file — The TX and RX RFDS
calibration offset values are written to the CAL file in the slot[385]
Block.

TSIC channel frequency — For each RFDS TSIC, the channel
frequency is determined at the lower third and upper third of the
appropriate band using the frequencies listed irrJable 3-47.

Table 3-47: RFDS TSIC Calibration Channel Frequencies
System Channel Calibration Points
800 MHz (A and B) 341 and 682
1.9 GHz 408 and 791

WARNING Before installing any test equipment directly to any TX OUT

connector, verify that there are no CDMA channels keyed.
Failure to do so can result in serious personal injury and/or
equipment damage.

Prerequisites
¢ Test equipment has been selected.
* Test equipment and test cables have been calibrated.

® TX calibration has been performed and BLO data has been
downloaded to the BBXSs.

* Test equipment and test cables are connected for TX calibration.

* Antenna map data has been entered for the site.
¢ BBXs are OOS-RAM.
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RFDS Calibration Procedure
Follow the procedure iqj"able 3-48 to perform RFDS calibration.

Table 3-48: RFDS Calibration Procedure

Step Action
1 In the LME, select the CDMA BTS—xxx tab.
2 If the BTS Control button is not selected (no black dot showing), click on the B button in the BTS
menu bar to select it.
3 Select the BBX(s) assigned to the carrier(s) and sector(s) which will be used in RFDS calibration
(refer tqFable 1-6 for BBX carrier and sector assignments).
4 Click on RFDS in the BTS menu bar, and select RFDS Calibration... from the pull-down menu. An
RFDS Calibration set—up window will be displayed.
5 In the Tests to Perform box, select TX Calibration or RX Calibration, as required
6 Enter the appropriate channel number(s) (refer tgFable 3-47) in the Channel Field box. To enter more
than one channel number, use the following methods:
— Separate non—sequential channel numbers with a comma and no spaces;
for example: 247,585,742.
— Enter a range of sequential channels by typing the first and last channel numbers in the range
separated by a dash and no spaces;
for example: 385-395.
7 If the frame is equipped with TX combiners, click in the Has Combiners checkbox.
8 Select the appropriate carrier(s) and sector(s) from the Carriers pick list (hold down the Shift or Ctrl
key while clicking on pick list items to select multiple carrier(s)—sector(s)).
9 Select the appropriate Rx branch (Main, Diversity or Both) in the drop—down list if performing RX
calibration.
10 | Click on the OK button. A status report window is displayed, followed by a Directions pop-up
window.
11 Follow the cable connection directions as they are displayed.
12 | When the test is completed, test results are displayed in the status report window.
13 Click on the OK button to close the status report window.
14 | Click on the Frame tab.
15 | Select the MGLI by clicking on it.
16 | Download updated RFDS offset data to the MGLI (see Sterf irrjable 3-42).
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Program TSU NAM

The NAM must be programmed before it can receive and process test

calls, or be used for any type of RFDS test.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

* MGLI is INS.

* TSU is powered up and has a code load.

Program NAM Procedure
Follow the procedure iqj"able 3-49 to program the TSU NAM.

Table 3-49: Program the TSU NAM

Step Action

1 Select the RFDS tab.

2 Select the SUA (Cobra RFDS) or TSU (GLI based RFDS).

3 Click on TSU in the BTS menu bar, and select Program TSU NAM from the pull-down menu. A
NAM programming window will appear.

4 Enter the appropriate information in the boxes (seqJable 3-43 an¢fable 3-44).
Click on the OK button to display the status report.
Click on the OK button to close the status report window.
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BTS Redundancy/Alarm Testing

Objective

This section tests the redundancy options that could be included in the
cell site. These tests verify, under a fault condition, that all modules
equipped with redundancy switch operations to their redundant partner
and resume operation. An example would be to pull the currently active
CSM and verity the standby CSM takes over distribution of the CDMA
reference signal.

Redundancy covers many BTS modules. Confirm the redundant options
included in the BTS, and proceed as required. If the BTS has only basic
power supply redundancy, the tests and procedures detailed in the
following tables should be bypassed.

*Jable 3-52. Miscellancous Alarm Tests (BTS Frame)

*Jable 3-53. BBX Redundancy Tests (BTS Frame)

°|j"able 3-54. CSM, GPS, & LFR/HSO Redundancy Alarm Tests
°|j"able 3-55. PA Redundancy Test

°|j"able 3-56. MGLI/GLI Redundancy Test

During redundancy verification of the test, alarms reported by the master
GLI (displayed via the alarm monitor) will also be verified/noted.

Test Equipment

The following pieces of test equipment are required to perform this test:
e LMF

e Communications Test Set

Redundancy/Alarm Test

Perform each of the following tests to verify BTS redundancy and to
confirm all alarms are received and reported by the BTS equipment. The
procedures should be performed on the following modules/boards:

* Power supply/converter modules in all frames

¢ Distribution shelf modules in the BTS frame

C—CCP shelf modules in the BTS frame (except MCCs)
PA modules in the BTS frame

AMR Customer defined input/output tests
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Test Equipment Setup

Follow the procedure iqj"able 3-50 to set up test equipment:

|NOTE

All alarm tests are performed using TX antenna 1

Table 3-50: Test Equipment Setup for Redundancy/Alarm Tests

Step Action

1 Interface the LMF computer to the BTS LAN A connector on
the BTS frame (refer tqJable 3-5, pagq3-17).

2 Login to the BTS.
Set up test equipment for TX Calibration at TXOUT1 (see

igure 3-16).

NOTE
If site is not equipped for redundancy, remove all GLI and
BBX boards installed in any redundant slot positions at this
time.

4 Display the alarm monitor by selecting Util>Alarm Monitor.

5 Unequip all customer defined AMR alarms reported via the

AMR Alarm connector (A & B) by clicking on MGLI, then
selecting Device>Set Alarm Relays>Unequipped.

NOTE

During configuration of MGLI alarm reporting, spurious
alarms may report. Allow the BTS to stabilize for 10 seconds.
If any alarms are actively being reported after the BTS has
stabilized, determine the cause before proceeding further.

3-110
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Power Supply Redundancy

Follow the steps irrJable 3-51 to verify redundancy of the power supply
modules. Alarms reported by the master GLI (displayed via the alarm
monitor) are also verified.

Table 3-51: Power Supply/Converter Redundancy (BTS Frame)

Step Action

1 Select the MGLI (highlight) and from the pulldown menu select:
Device>BBX/MAWI>Set Redundant Sector>Carrier—#-1-1
Device>BBX/MAWI>Set Pilot Only>Carrier—#-1-1
Device>BBX/MAWI>Set Pilot Gain>Carrier—#-1-1 and Pilot Gain = 262
2 Select (highlight) BBX—1 and from the pulldown menu select Device>BBX/MAWI>Key.
Set XCVR gain to 40 and enter the correct XCVR channel number.
Remove PS—1 from the power distribution shelf (seqdjigure 3-27).
— Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

— Verity no other modules went OOS.
5 Re-install PS—1.

Observe the alarm clears on the alarm monitor.
6 Repeat stepg# andj for PS-2 and PS-3.

NOTE
For +27 V systems, skip to stefq through steg30.

7 On -48 V systems, remove PS—4 (seqijigure 3-28).
— Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

— Verity no other modules went OOS.

8 Re-install PS—4.

Observe the alarm clears on the alarm monitor.
9 Repeat stepgq and§ for PS-5 through PS-9.

10 | Verify that all PWR/ALM LEDs are GREEN.
11 Select BBX-1 and Device>BBX/MAWI>Dekey
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Figure 3-27: SC 4812T C—CCP Shelf
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Figure 3-28: —48 V BTS Power Conversion Shelf
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Miscellaneous Alarm/Redundancy Tests

Follow the steps irJable 3-52 to verify alarms reported by the master
GLI are displayed via the alarm monitor if a BTS frame module failure
occurs.

Table 3-52: Miscellaneous Alarm Tests

Step

Action

Select Util>Alarm Monitor to display the alarm monitor window.

Perform the following to verify fan module alarms:

® Unseat a fan module (seqigure 3-29 orfjigure 3-30).

® Observe an alarm message was reported via the MGLI (as displayed on the alarm monitor).
® Replace fan module and verify the alarm monitor reports that the alarm clears.

® Repeat for all other fan modules in the BTS frame.

NOTE
Follow Step3 for Starter Frames and Steg# for Expansion Frames.

Starter Frames Only: Perform the following to verify MPC module alarms.
® Unseat MPC modules (seqfjigure 3-27) one at a time.
® Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

® Replace the MPC modules and verify the alarm monitor reports the alarm clears.

Expansion Frames Only: Perform the following to verify EMPC module alarms.
® Unseat EMPC modules (seqijigure 3-27) one at a time
® Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

® Replace the EMPC modules and verify the alarm monitor reports that the alarm clears.

If equipped with AMR redundancy, perform the following to verify AMR module redundancy/alarms.
® Unseat AMR 2 (seqfigure 3-27).

® Observe that an alarm message is reported via the MGLI (as displayed on the alarm monitor).

® Repeat StepgT through3 and/or%.

® Replace the AMR module and verify the alarm monitor reports that the alarm clears.

e Unseat AMR 1 and observe an alarm message was reported via the MGLI (as displayed on the alarm
monitor).

® Replace the AMR module and verify the LMF reports the alarm has cleared.

NOTE
All PWR/ALM LEDs should be GREEN at the completion of this test.
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Figure 3-29: +27 V BTS C-CCP Fan Modules
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able 3-53 to verify redundancy of the BBXs in the

C—CCP shelf. Alarms reported by the master GLI (displayed via the
alarm monitor) are also verified. This test can be repeated for additional

sectors at the customer’s discretion.
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Table 3-53: BBX Redundancy Alarms

Step Action

A WARNING
Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

1 Enable the primary, then the redundant BBX assigned to ANT 1 by selecting the BBX and
Device>BBX/MAWI>Key.

2 Observe that primary BBXs key up, and a carrier is present at each respective frequency.

3 Remove the primary BBX.

4 Observe a carrier is still present.
The Redundant BBX is now the active BBX for Antenna 1.

5 Replace the primary BBX and reload the BBX with code and data.

6 Re-enable the primary BBX assigned to ANT 1 and observe that a carrier is present at each respective
frequency.

7 Remove the redundant BBX and observe a carrier is still present.

8 The Primary BBX is now the active BBX for ANT 1.

9 Replace the redundant BBX and reload the BBX with code and data.

10 | Re-enable the redundant BBX assigned to ANT 1 and observe that a carrier is present at each
respective frequency:

11 | De-key the Xcvr by selecting Device>BBX/MAWI>Dekey.

12| Repeat StepgT through31 for additional BBXs/antennas, if equipped.
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CSM, GPS, & LFR/HSO Redundancy/Alarm Tests

Follow the procedure iqj“able 3-54 to verify the manual redundancy of
the CSM, GPS, and LFR/HSO boards. Verification of alarms reported is
also covered.

NOTE DO NOT perform the procedure irjable 3-54, unless the site is
configured with a LORAN-C or HSO timebase as a backup for
the GPS.

Table 3-54: CSM, GPS, & LFR/HSO, Redundancy/Alarm Tests

Step Action

A WARNING

Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

1 Enable the primary, then the redundant BBXs assigned to ANT 1 by selecting the BBX and
Device>BBX/MAWI>Key.

2 Disconnect the GPS antenna cable, located on top of the BTS frame.
This forces the LORAN-C LFR or HSO board timebase to become the CDMA timing source.

3 Observe a CDMA timing reference alarm and source change is reported by the alarm monitor.

4 Allow the LFR/HSO to become the active timing source.

* Verify the BBXs remain keyed and INS.

* Verify no other modules went OOS due to the transfer to LFR/HSO reference.
* Observe the PWR/ALM LEDs on the CSM 1 front panel are steady GREEN.

5 Reconnect the GPS antenna cable.

6 Allow the GPS to become the active timing source.

* Verify the BBXs remain keyed and INS.

* Verify no other modules went OOS due to the transfer back to the GPS reference.
* Observe the PWR/ALM LEDs on CSM 1 are steady GREEN.

7 Disable CSM 1 and enable CSM 2.
® Various CSM source and clock alarms are now reported and the site comes down.

* Alarms clear when the site comes back up.

8 Allow the CSM 2 board to go INS_ACT.

* Verify the BBXs are dekeyed and OOS, and the MCCs are OOS_RAM.

* Verify no other modules went OOS due to the transfer to CSM 2 reference.
* Observe the PWR/ALM LEDs on CSM 2 front panels are steady GREEN.

NOTE

It can take up to 20 minutes for the CSM to re-establish the GPS link and go INS. MCCs go
OOS_RAM.

9 Key BBXs 1 and R and observe a carrier is present.

10 | Repeat Stequ througl]j to verify CSM source redundancy with CSM 2.

... continued on next page
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ﬂable 3-54: CSM, GPS, & LFR/HSO, Redundancy/Alarm Tests

Step Action

* IMPORTANT
DO NOT ENABLE the redundant CSM.

11 | Disable CSM 2 and enable CSM 1.
® Various CSM Source and Clock alarms are reported and the site comes down.

* Alarms clear when the site comes back up.

12 | De-key the Xcvr by selecting Device>BBX/MAWI>Dekey.

13 | Allow the CSM 1 board to go INS_ACT.

* Verify the BBXs are de-keyed and OOS.

* Verify no other modules went OOS due to the transfer to CSM 1 reference.
* Observe PWR/ALM LEDs on the CSM 1 front panels are steady GREEN.

14 | Disable the primary and redundant BBXs.
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Power Amplifier (PA) Redundancy Test

Follow the procedure iqj"able 3-55 to verify redundancy of the Power
Amplifiers (PA).

WARNING First verify there are no BBX channels keyed BEFORE
moving the antenna connection. Failure to do so can result in
serious personal injury and/or equipment damage.

Table 3-55: Power Amplifier Redundancy Test

Step

Action

From the pulldown menu select:

Device>BBX/MAWI>Set Redundant Sector>Carrier—#-1-1
Device>BBX/MAWI>Set Pilot Only>Carrier—#-1-1
Device>BBX/MAWI>Set Pilot Gain> Carrier—#-1-1 and Pilot Gain = 262

Key-up the BBX assigned to the PAs associated with the sector under test (gain = 40).

Adjust the communications test set spectrum analyzer, as required, to observe the overall carrier
amplitude and IM Shelf and note for reference. These figures will be required later.

NOTE
Seqijigure 3-19 for test equipment setup, if required.

Push-in and release the breaker supplying the 1st PA of the pair.
NOTE

After power is removed, IM suppression takes a few seconds to settle out while compensating for the
removal of the 1st PA. The overall gain decreases by approximately 6 dB. The process must be
complete before proceeding.

Verify:
¢ The other PA module did not go OOS due to the loss of the PA.

® The overall carrier amplitude is reduced by approximately 6 dB and IM suppression on the analyzer
display remains basically unchanged.

e PA fault message is reported via the MGLI and displayed on the alarm monitor.

Re-apply power to the PA module and observe the alarm has cleared on the alarm monitor.

NOTE
All PWR/ALM LEDs should be GREEN at completion of test.

Repeat Stepg# througlt to verify the 2nd PA of the pair.

De-key the BBX.

A WARNING

First verify there are no BBX channels keyed when moving the antenna connection. Failure to do so
can result in serious personal injury and/or equipment damage.

Repeat Stepy ) through§ to verify PAs assigned to sectors 2 and 3 (if equipped). Move the test cable
on top of the BTS to OUT 2 and TX OUT 3 antenna connectors as required.
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MGLI/GLI Redundancy Test

CAUTION This test can only be performed when the MM path is established
by the MM (not just with LAPD link connected). Attempting to
force the GLIs to “hot swap” under alarm monitor control, when
isolated from the MM, causes MGLIs to hang up.

Table 3-56: MGLI/GLI Redundancy Test (with MM Connection Established)

Step

Action

NOTE

* This test assumes the alarm monitor is NOT connected to the BTS and the T1/E1 span is connected
and communication is established with the MM.

* BOTH GLIs must be INS before continuing.

Verify the BBXs are enabled and a CDMA carrier is present.

Identify the primary and redundant MGLI pairs.

Pull the MGLI that is currently INS-ACT and has cage control.

Observe the BBX remains GREEN, and the redundant MGLI is now active.

Verify no other modules go OOS due to the transfer of control to the redundant module.

Verify that the BBXs are enabled and a CDMA carrier is present.

Reinstall the MGLI and have the OMCR/CBSC place it back in-service.

0 NN N AW

Repeat StepsE]I througl]j to verify the other MGLI/GLI board.
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Alarms Testing

Alarm Verification

Alarm Reporting Display

ALARM connectors provide Customer Defined Alarm Inputs and
Outputs. The customer can connect BTS site alarm input sensors and
output devices to the BTS, thus providing alarm reporting of active
sensors as well controlling output devices.

The SC 4812T is capable of concurrently monitoring 36 input signals
coming into the BTS. These inputs are divided between 2 Alarm
connectors marked ‘ALARM A’ and ‘ALARM B’ located at the top of
the frame (seqdjigure 3-31). The ALARM A connector is always
functional; ALARM B is functional when an AMR module is equipped
in the AMR 2 slot in the distribution shelf. ALARM A port monitors
input numbers 1 through 18, while ALARM B port monitors input
numbers 19 through 36 (seqfjigure 3-32). State transitions on these input
lines are reported to the LMF and OMCR as MGLI Input Relay alarms.

ALARM A and ALARM B connectors each provide 18 inputs and 8
outputs. If both A and B are functional, 36 inputs and 16 outputs are
available. They may be configured as redundant. The configuration is set
by the CBSC.

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util>Alarm Monitor.

The following buttons are included:

* The Options button allows for a severity level (Warning, Minor, and
Major) selection. The default is all levels. To change the level of
alarms reported click on the Options button and highlight the desired
alarm level(s). To select multiple levels press the <Ctrl> key (for
individual selections) or <Shift> key (for a range of selections) while
clicking on the desired levels.

* The Pause button pauses/stops the display of alarms. When the Pause
button is clicked the name of the button changes to Continue. When
the Continue button is clicked, the display of alarms continues.
Alarms that occur between the time the Pause button is clicked and
the Continue button is clicked are not displayed.

* The Clear button clears the Alarm Monitor display. New alarms that
occur after the Clear button is clicked are displayed.

* The Dismiss button dismisses/closes the Alarm Monitor display.
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Figure 3-31: Alarm Connector Location and Connector Pin Numbering

\\ / ti-CDMA-WP-00041-v01-ildoc-ftw

The following procedures verify the customer defined alarms and relay
contacts are functioning properly. These tests are performed on all AMR
alarms/relays in a sequential manner until all have been verified. Perform
these procedures periodically to ensure the external alarms are reported
properly. Following these procedures ensures continued peak system
performance.

Purpose

Study the site engineering documents and perform the following tests
only after first verifying that the AMR cabling configuration required to
interconnect the BTS frame with external alarm sensors and/or relays
meet requirements called out in the SC 4812T Series BTS Installation
Manual.

NOTE Motorola highly recommends that you read and understand this
procedure in its entirety before starting this procedure.

Test Equipment

The following test equipment is required to perform these tests:
* LMF
¢ Alarms Test Box (CGDSCMIS00014) —optional

NOTE

Abbreviations used in the following figures and tables are
defined as:

* NC = normally closed

® NO = normally open

* COM or C = common

* CDO = Customer Defined (Relay) Output
* CDI = Customer Defined (Alarm) Input
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Figure 3-32: AMR Connector Pin Numbering

ACDI 18 ACDI1
Returns
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59 —— ! 59 2 1
Returns (AMR 1) (AMR 2)
B CDI 36 B CDI 19
FW00302
NOTE The preferred method to verify alarms is to follow the Alarms

Test Box Procedureﬁable 3-57. If not using an Alarm Test Box,
follow the procedure listed irrfable 3-58.

CDI Alarm Input Verification with Alarms Test Box

E’Lable 3-57 describes how to test the CDI alarm input verification using
the Alarm Test Box. Follow the steps as instructed and compare results
with the LMF display.

NOTE It may take a few seconds for alarms to be reported. The default
delay is 5 seconds. Leave the alarms test box switches in the new
position until the alarms have been reported.

Table 3-57: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

1 Connect the LMF to the BTS and log into the BTS.

2 Select the MGLI.

3 Click on the Device menu.

4 Click on the Set Alarm Relays menu item.

5 Click on Normally Open.
A status report window displays the results of the action.

6 Click on the OK button to close the status report window.

7 Set all switches on the alarms test box to the Open position.

8 Connect the alarms test box to the ALARM A connector (seqfjigure 3-31).

9 Set all of the switches on the alarms test box to the Closed position. An alarm should be reported for
each switch setting.

10 | Set all of the switches on the alarms test box to the Open position. A clear alarm should be reported
for each switch setting.

11 | Disconnect the alarms test box from the ALARM A connector.

12 | Connect the alarms test box to the ALARM B connector.

13 Set all switches on the alarms test box to the Closed position. An alarm should be reported for each
switch setting

... continued on next page
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Table 3-57: CDI Alarm Input Verification Using the Alarms Test Box

Step Action
14 Set all switches on the alarms test box to the Open position. A clear alarm should be reported for each
switch setting.
15 Disconnect the alarms test box from the ALARM B connector.
16 Select the MGLI.
17 Click on the Device menu.
18 | Click on the Set Alarm Relays menu item.
19 | Click on Normally Closed. A status report window displays the results of the action.
20 | Click OK to close the status report window.
Alarms should be reported for alarm inputs 1 through 36.
21 Set all switches on the alarms test box to the Closed position.
22 Connect the alarms test box to the ALARM A connector.
Alarms should be reported for alarm inputs 1 through 18.
23 Set all switches on the alarms test box to the Open position.
An alarm should be reported for each switch setting.
24 | Set all switches on the alarms test box to the Closed position.
A clear alarm should be reported for each switch setting.
25 Disconnect the alarms test box from the ALARM A connector.
26 Connect the alarms test box to the ALARM B connector.
A clear alarm should be reported for alarm inputs 19 through 36.
27 Set all switches on the alarms test box to the Open position.
An alarm should be reported for each switch setting.
28 | Set all switches on the alarms test box to the Closed position.
A clear alarm should be reported for each switch setting.
29 Disconnect the alarms test box from the ALARM B connector.
30 Select the MGLI.
31 Click on the Device menu.
32 | Click on the Set Alarm Relays menu item.
33 | Click on Unequipped.
A status report window displays the results of the action.
34 Click on the OK button to close the status report window.
35 Connect the alarms test box to the ALARM A connector.
36 | Set all switches on the alarms test box to both the Open and the Closed position.
No alarm should be reported for any switch settings.
... continued on next page
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Table 3-57: CDI Alarm Input Verification Using the Alarms Test Box

Step Action
37 | Disconnect the alarms test box from the ALARM A connector.
38 | Connect the alarms test box to the ALARM B connector.
39 | Set all switches on the alarms test box to both the Open and the Closed position.
No alarm should be reported for any switch settings.
40 | Disconnect the alarms test box from the ALARM B connector.
41 Load data to the MGLI to reset the alarm relay conditions according to the CDF file.

CDI Alarm Input Verification without Alarms Test Box

able 3-58 describes how to test the CDI alarm input verification
without the use of the Alarms Test Box. Follow the steps as instructed
and compare results with the LMF display.

NOTE It may take a few seconds for alarms to be reported. The default
delay is 5 seconds. When shorting alarm pins wait for the alarm
report before removing the short.

Table 3-58: CDI Alarm Input Verification Without the Alarms Test Box
Step Action
1 Connect the LMF to the BTS and log into the BTS.
2 Select the MGLI.
3 Click on the Device menu.
4 Click on the Set Alarm Relays menu item.
5 Click on Normally Open.
A status report window displays the results of the action.
6 Click on OK to close the status report window.
7 Refer tqfigure 3-32 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.
An alarm should be reported for each pair of pins that are shorted.
A clear alarm should be reported for each pair of pins when the short is removed.
8 Refer tqFigure 3-32 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.
An alarm should be reported for each pair of pins that are shorted.
A clear alarm should be reported for each pair of pins when the short is removed.
9 Select the MGLI.
10 | Click on the Device menu.
11 Click on the Set Alarm Relays menu item.
. .. continued on next page
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[Table 3-58: CDI Alarm Input Verification Without the Alarms Test Box

Step Action

12 | Click on Normally Closed.
A status report window displays the results of the action.

13 | Click on OK to close the status report window.
Alarms should be reported for alarm inputs 1 through 36.

14 | Refer tqfigure 3-32 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.

A clear alarm should be reported for each pair of pins that are shorted.
An alarm should be reported for each pair of pins when the short is removed.

15 | Refer tqfigure 3-32 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.

A clear alarm should be reported for each pair of pins that are shorted.
An alarm should be reported for each pair of pins when the short is removed.

16 Select the MGLI.

17 Click on the Device menu.

18 | Click on the Set Alarm Relays menu item.

19 | Click on Unequipped.
A status report window displays the results of the action.

20 | Click on OK to close the status report window.

21 Refer tqfigure 3-32 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.

No alarms should be displayed.

22 | Refer tqFigure 3-32 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.

No alarms should be displayed.

23 | Load data to the MGLI to reset the alarm relay conditions according to the CDF file.
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Pin and Signal Information for Alarm Connectors

[Jable 3-59 lists the pins and signal names for Alarms A and B.

Table 3-59: Pin and Signal Information for Alarm Connectors

*For —48V, reserved for Power Supply Module Alarm signal. NOT for use as CDOs or CDIs.
All Cust Rtrn 1-18 are electronically tied together at the RFMF.
All Cust Rtrn 19-36 are electronically tied together at the RFMF.

CDO = Customer Defined Output; CDI = Customer Defined Input;
NC - normally closed, NO — normally open, Com — common

The “A CDI” numbering is from the LMF/OMCR/CBSC perspective. LMF/OMCR/CBSC starts the numbering at 19
(giving 19 — 36). Actual cable hardware starts the numbering at 0 (giving 0-17)

Wire Signal Name Wire Signal Name

Pin | Color Alarm A Alarm B Pin | Color Alarm A Alarm B

1 | Blu/Wht A CDO1 NC B CDO9 NC 31 | Blu/Yel Cust Retn 4 B CDI 22

2 | Wht/Blu A CDO1 Com B CDOY Com 32 | Yel/Blu A CDI4 Cust Retn 22
3 | Org/Wht A CDO1 NO B CDO9 NO 33 | Org/Yel Cust Retn 5 B CDI 23

4 | Wht/Org A CDO2 NC B CDO10 NC 34 | Yel/Org A CDI 5 Cust Retn 23
5 | Grn/Wht A CDO2 Com B CDO10 Com 35 | Grn/Yel Cust Retn 6 B CDI 24

6 | Wht/Grn A CDO2 NO B CDO10 NO 36 | Yel/Grn A CDI 6 Cust Retn 24
7 | Brn/Wht A CDO3 NC B CDO11 NC 37 | Brn/Yel Cust Retn 7 B CDI 25

8 | Wht/Brn A CDO3 Com B CDO11 Com 38 | Yel/Brn ACDI7 Cust Retn 25
9 | Slt/Wht A CDO3 NO B CDO11 NO 39 | Slt/Yel Cust Retn 8 B CDI 26

10 | Wht/Slt A CDO4 NC B CDO12 NC 40 | Yel/Slt A CDI 8 Cust Retn 26
11 | Blu/Red A CDO4 Com B CDO12 Com 41 | Blu/Vio Cust Retn 9 B CDI 27

12 | Red/Blu A CDO4 NO B CDO12 NO 42 | Vio/Blu A CDI9 Cust Retn 27
13 | Org/Red A CDO5 NC B CDO13 NC 43 | Org/Vio Cust Retn 10 B CDI 28

14 | Red/Org A CDOS5 Com B CDO13 Com 44 | Vio/Blu A CDI 10 Cust Retn 28
15 | Grn/Red A CDO5 NO B CDO13 NO 45 | Grn/Vio Cust Retn 11 B CDI 29

16 | Red/Gm A CDO6 NC B CDO14 NC 46 | Vio/Grn A CDI 11 Cust Retn 29
17 | Brn/Red A CDO6 Com B CDO14 Com 47 | Brn/Vio Cust Retn 12 B CDI 30

18 | Red/Brn A CDO6 NO B CDO14 NO 48 | Vio/Brn A CDI 12 Cust Retn 30
19 | Slt/Red A CDO7 NC B CDO15 NC 49 | Slt/Vio Cust Retn 13 B CDI 31

20 | Red/Slt A CDO7 Com B CDO15 Com 50 | Vio/Slt A CDI 13 Cust Retn 31
21 | Blu/Blk A CDO7 NO B CDO15 NO 51 | Red/Wht Cust Retn 14 B CDI 32

22 | Blk/Blu A CDOS NC B CDO16 NC 52 | Wht/Red |ACDI 14 Cust Retn 32
23 | Org/Blk A CDOS8 Com B CDO16 Com 53 | Blk/Wht Cust Retn 15 B CDI 33

24 | Blk/Org A CDO8 NO B CDO16 NO 54 | Wht/BIk A CDI 15 Cust Retn 33
25 | Grn/Blk Cust Retn 1 B CDI 19 55 | Yel/Wht Cust Retn 16 B CDI 34
26 | Blk/Gmn ACDI1 Cust Retn 19 56 | Wht/Yel A CDI 16 Cust Retn 34
27 | Brn/BIk Cust Retn 2 B CDI 20 57 | Vio/Wht Cust Retn 17 B CDI 35

28 | BIk/Brn A CDI 2 Cust Retn 20 58 | Wht/Vio A CDI 17 Cust Retn 35
29 | Slt/Blk Cust Retn 3 B CDI 21 +27V | 59 |BIk/Red Cust Retn 18 B CDI 36

*Pwr Conv Alm —48V
30 | BIKk/SIt A CDI 3 Cust Retn 21 +27V | 60 | Red/Blk A CDI 18 Cust Retn 36
*Pwr Conv Retn —48V
NOTE
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Automated Acceptance Test Procedures

Introduction

The Automated Acceptance Test Procedure (ATP) allows Cellular Field
Engineers (CFEs) to run automated acceptance tests on all equipped BTS
subsystem devices using the Local Maintenance Facility (LMF) and
supported test equipment per the current Cell Site Data File (CDF)
assignment.

The results of these tests (at the option of the operator) are written to a
file that can be printed. All tests are controlled from the LMF platform
using the GPIB interface, therefore, only recommended test equipment
supported by the LMF can be used.

This chapter describes the tests run from the GUI environment, which is
the recommended method. The GUI provides the advantages of
simplifying the LMF user interface, reducing the potential for miskeying
commmands and associated parameters, and speeding up the execution
of complex operations involving multiple command strings. If you feel
the command line interface (CLI) will provide additional insight into the
progress of ATPs and problems that could possibly be encountered, refer
to LMF CLI Commands.

NOTE

— Before performing any tests, use an editor to view the
“Caveats” section of the “readme.txt” file in the c:\wlmf
folder for any applicable information.

— The ATP test is to be performed on out-of-service (OOS)
sectors only.

— DO NOT substitute test equipment not supported by the
LMF.

Refer to Chapter for detailed interconnection information needed for
calibrating equipment, cables, and other test equipment set components.

4-2
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Reduced ATP

NOTE

Equipment has been factory—tested for FCC compliance. If
license—governing bodies require documentation supporting
SITE compliance with regulations, a full ATP may be necessary.
Perform the Reduced ATP only if reports for the specific BTS
site are NOT required.

After downloading the proper operational software to the BTS, the CFE
must perform these procedures (minimal recommendation):

1. Verify the TX/RX paths by performing TX Calibration, TX Audit,
and FER tests.

2. Retrieve Calibration Data required for normal site operation.

Should failures occur while performing the specified tests, refer to the
Basic Troubleshooting section of this manual for help in determining the
failure point. Once the point of failure has been identified and corrected,
refer to the BTS Optimization and ATP Test Matrix (fable C-3) to
determine the applicable test that must be performed.

In the unlikely event that the BTS passes these tests but has a forward
link problem during normal operation, the CFE should then perform the
additional TX tests for troubleshooting: TX spectral mask, TX rho, and
TX code domain.

NOTE

Refer to Chapter for detailed information on test set
connections for calibrating equipment, cables and other test set
components, if required.

Customer requirements determine which ATP tests are to be performed
and the field engineer selects the appropriate ATP tests to run.

Oct 2003
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ATP Test Options

There are three different ATP testing options that can be performed to
completely test a BTS. Depending on your requirements, one of the
following ATP testing options should be runfJable 4-1 provides the
procedure to execute an ATP test. To completely test a BTS, run the ATP
tests according to one of the following ATP testing options:

ATP Testing Option 1

e All TX/RX test — Executes all the TX and RX tests as described in
testing option 2.

ATP Testing Option 2

o All TX test — TX tests verify the performance of the BTS transmit line
up. These include the GLI, MCC, BBX, and CIO cards, the LPAs and
passive components including splitters, combiners, bandpass filter,
and RF cables.

* All RX test — RX tests verify the performance of the BTS receiver line
up. These includes the MPC (for starter frames), EMPC (for
expansion frames), CIO, BBX, MCC, and GLI cards and the passive
components including RX filter (starter frame only), and RF cables.

ATP Testing Option 3

These tests can be run individually:
TX Mask test

Rho test

Pilot Time Offset test

Code Domain Power test

FER test

NOTE The Full Optimization test can be run if you want the TX path
calibrated, BLO downloaded, and TX audited before all the TX
and RX tests are run.

NOTE If manual testing has been performed with the HP analyzer,
remove the manual control/system memory card from the card
slot and set the I0 CONFIG to the Talk & Listen mode before
starting the automated testing.

NOTE The STOP button can be used to stop the testing process.
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ATP Test Prerequisites

Before attempting to run any ATP tests, ensure the following have been
completed:

* BTS has been optimized and calibrated (see Chapter3).
* LMF is logged into the BTS.

* CSMs, GLIs, BBXs, MCCs, and TSU (if the RFDS is installed) have
correct code load and data load.

® Primary CSM, GLI, and MCCs are INS_ACT (bright green).
* BBXs are calibrated and BLOs are downloaded.

* No BBXSs are keyed (transmitting).

e BBXs are OOS_RAM (yellow).

¢ Test cables are calibrated.

¢ Test equipment is connected for ATP tests (seqjigure 3-19 through
fjigure 3-24 starting on pagq3-68).

¢ Test equipment has been warmed up 60 minutes and calibrated.
¢ GPIB is on.

* BTS transmit connectors are properly terminated for the test(s) to be
performed.

WARNING Before performing the FER, be sure that all PAs are turned OFF
(circuit breakers pulled) or that all transmitter ports are properly
terminated.

All transmit ports must be properly terminated for all ATP tests.

Failure to observe these warnings may result in bodily injury or
equipment damage.

TX OUT Connection

NOTE Many of the acceptance test procedures require taking
measurements at the TX OUT (BTS/RFDS) connector. At sites
without RFDS installed, all measurements will be via the BTS
TX OUT connector. At sites with RFDS installed, all
measurements will be via the RFDS directional coupler TX
OUT connector.
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Required Test Equipment

The following test equipment is required:

* LMF

* Power meter (used with HP8921A/600 and Advantest R3465)
¢ Communications system analyzer

* Signal generator for FER testing (required for a/l communications
system analyzers for 1X FER)

WARNING — Before installing any test equipment directly to any BTS
TX OUT connector, verify that there are no CDMA
channels keyed.

— At active sites, have the OMCR/CBSC place the carrier
assigned to the PAs under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.

NOTE The test equipment must be re—calibrated before using it to
perform the TX Acceptance Tests.
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Individual Acceptance Tests

The following individual ATP tests can be used to evaluate specific
aspects of BTS operation against individual performance requirements.
All testing is performed using the LMF GUI environment.

TX Testing

TX tests verify any given transmit antenna path and output power
control. All tests are performed using the external, calibrated test
equipment. All measurements are made at the appropriate BTS TX OUT
connector(s).

TX tests verify TX operation of the entire CDMA forward link using
selected BBXs assigned to respective sector antennas. Each BBX is
keyed up to generate a CDMA carrier (using both bbxlevel and BLO)
at the CDF file—specified carrier output power level.

RX Testing

RX testing verifies receive antenna paths for BBXs selected for the test.
All tests are performed using the external, calibrated test equipment to
inject a CDMA RF carrier with all zero longcode at the specified RX
frequency at the appropriate BTS RX IN connector(s).

RX tests verify RX operation of the entire CDMA reverse link using all
equipped MCCs assigned to all respective sector/antennas.

Individual Tests

The following individual tests can be used to verify the results of
specific tests.

Spectral Purity TX Mask (Primary & Redundant BBX)

This test verifies that the transmitted CDMA carrier waveform generated
on each sector meets the transmit spectral mask specification with
respect to the assigned CDF file values.

Waveform Quality (rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in
ANSI-J_STD-019. “Rho” represents the correlation between actual and
perfect CDMA modulation spectrum. A rho value of 1.0000 represents
100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Pilot
Gain = 262, PN Offset = 0).

Code Domain Power (Primary & Redundant BBX)

This test verifies the code domain power levels, which have been set for
all ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures < -27 dB (with respect to total COMA channel
power).
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Frame Error Rate

The Frame Error Rate (FER) test verifies RX operation of the entire
CDMA Reverse Link using all equipped MCCs assigned to all
respective sectors/antennas. This test verifies the BTS sensitivity on all
traffic channel elements currently configured on all equipped MCCs at
an RF input level of =119 dBm (or —116 dBm if using TMPC).

4-8
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ATP Test Procedure

Follow the procedure irﬂ" able 4-1 to perform any ATP test.

Table 4-1: ATP Test Procedure
Step Action
1 Be sure that all prerequisites described on pagq#4-5 have been met.
NOTE
If the LMF has been logged into the BTS with a different Multi-Channel Preselector setting than the
one to be used for this test, the LMF must be logged out of the BTS and logged in again with the new
Multi-Channel Preselector setting. Using the wrong MPC setting can cause a false test failure.
2 Select the device(s) to be tested.
From the Tests menu, select the desired test from the pulldown menu:
— All TX/RX ATP... / All TX ATP... / All RX ATP... or
— TX > (TX Mask... / Rho... / Pilot Time Offset... / Code Domain Power...) or
— RX > FER..

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list. To select multiple items, hold down the <Shift> or <Ctrl> key while making the selections.

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box. If it is not, obtain the latest bts—#.cdf (or bts—#.necf) and cbsc—#.cdf files from the CBSC.
NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 If applicable, select Verify BLO (default) or Single-sided BLO.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

7 For RX select the appropriate RX branch (Both, Main, or Diversity) in the drop—down list.

8 In the Rate Set box, select the appropriate data rate (1=9600, 2=14400, 3=9600 1X) from the
drop—down list.

NOTE

The Rate Set selection of 1 is only available if non—1X cards are selected for the test.
The Rate Set selection of 2 is only available if non—1X cards are selected for the test.
The Rate Set selection of 3 is only available if 1X cards are selected for the test.

9 Enter the channel elements to be tested for the RX ATP in the Channel Element(s) box. By default,

all channel elements are specified.
Use one of the following methods to enter more than one channel element:
— Enter non—sequential channel elements separated by a comma and no spaces (for example;
0,5,15).
— Enter a range of sequential channel elements by typing the first and last channel elements
separated by two periods (for example; 0..15).
NOTE
The channel element numbers are 0 based; that is the first channel element is 0.
... continued on next page
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ﬂable 4-1: ATP Test Procedure

Step

Action

10

If applicable, select a test pattern from the Test Pattern pick list.
NOTE

¢ Selecting Pilot (default) performs tests using only a pilot signal.

¢ Selecting Standard performs tests using pilot, synch, paging and 6 traffic channels. This requires
an MCC to be selected.

¢ Selecting CDFPilot performs tests using only a pilot signal, however, the gain for the channel
elements is specified in the CDF file.

¢ Selecting CDF performs tests using pilot, synch, paging and 6 traffic channels, however, the gain
for the channel elements is specified in the CDF file.

11

Click on the OK button. The status report window and a Directions pop-up are displayed.

12

Follow the cable connection directions as they are displayed, and click the Continue button to begin
testing. The test results are displayed in the status report window.

13

Click on Save Results or Dismiss. If Dismiss is used, the test results will not be saved in the test
report file.
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Individual ATP Test Background Information

TX Spectral Purity Transmit Mask Acceptance Test (Tx Mask)

This test verifies the spectral purity of each BBX carrier keyed up at a
specific frequency, per the current CDF file assignment. All tests are
performed using the external calibrated test set, controlled by the same
command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

The Pilot Gain is set to 541 for each antenna, and all channel elements
from the MCCs are forward-link disabled. The BBX is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only). BBX power output is set to obtain +40 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler).

NOTE

TX output power is set to +40 dBm by setting BTS power level
to +33.5 dBm to compensate for 6.5 dB increase from pilot gain
set to 541.

The calibrated communications test set measures and returns the
attenuation level of all spurious and IM products in a 30 kHz resolution
bandwidth. With respect to the mean power of the CDMA channel
measured in a 1.23 MHz bandwidth in dB, verify that results meet
system tolerances at the following test points:

e 1.7/1.9 GHz:
— at least 45 dB @ + 900 kHz from center frequency
— at least —45 dB @ — 900 kHz from center frequency
¢ 800 MHz:
— at least 45 dB @ + 750 kHz from center frequency
— at least —45 dB @ — 750 kHz from center frequency
— at least =60 dB @ — 1980 kHz from center frequency
— at least =60 dB @ — 1980 kHz from center frequency
The BBX then de-keys, and, if selected, the MCC is re-configured to

assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.

Seqjable 4-1 to perform this test.
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Figure 4-1: TX Mask Verification Spectrum Analyzer Display
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TX Waveform Quality (rho) Acceptance Test

This test verifies the transmitted Pilot channel element digital waveform
quality of each BBX carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all channel elements
from the MCCs are forward link disabled. The BBX is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to

40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
channel element digital waveform quality (rho) in dB, verifying that the
result meets system tolerances:

* Waveform quality (tho) should be =0.912 (-0.4dB).
The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path

under test. The test is then repeated.

Seqjable 4-1 to perform this test.
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TX Pilot Time Offset Acceptance Test

This test verifies the transmitted Pilot channel element Pilot Time Offset
of each BBX carrier keyed up at a specific frequency per the current
CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all TCH elements from
the MCCs are forward link disabled. The BBX is keyed up, using both
bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to

40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
Time Offset in ps, verifying results meet system tolerances:

* Pilot Time Offset should be within <3 us of the target PT
Offset (0 us).

The BBX then de-keys, and if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path

under test. The test is then repeated.

Seqjable 4-1 to perform this test.

TX Code Domain Power/Noise Floor Acceptance Test

This test verifies the Code Domain Power/Noise of each BBX carrier
keyed up at a specific frequency per the current CDF file assignment.
All tests are performed using the external calibrated test set controlled by
the same command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

For each sector/antenna under test, the Pilot Gain is set to 262. All MCC
channel elements under test are configured to generate Orthogonal
Channel Noise Source (OCNS) on different odd Walsh codes and to be
assigned a full-rate gain of 81. The maximum number of MCC/CEs to
be tested an any one time is 32 (32 odd Walsh codes). If more than 32
CEs exist, then multiple sets of measurements are made; so all channel
elements are verified on all sectors.

BBX power output is set to 40 dBm as measured at the TX OUT
connector (on either the BTS or RFDS directional coupler).

Verify the code domain power levels, which have been set for all ODD
numbered Walsh channels, using the OCNS command. This is done by
verifying that Pilot Power (dBm) minus OCNS Power (dBm) is equal to
10.2 = 2 dB and that the noise floor of all “OFF” Walsh channels
measures < —27 dB (with respect to total CDMA channel power).

NOTE

When performing this test using the LMF and the MCC is an MCCSE
or MCC24E, the redundant BBX may fail or show marginal
performance. This is due to a timing mismatch that the LMF does not
address. Performing this test from the CBSC will not have this timing
problem.
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The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated. Upon completion of the test, the
OCNS is disabled on the specified MCC/CE.

Seqjable 4-1 to perform this test.

Figure 4-2: Code Domain Power and Noise Floor Levels
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RX Frame Error Rate (FER) Acceptance Test

This test verifies the BTS FER on all traffic channel elements currently
configured on all equipped MCCs (full rate at 1% FER) at an RF input
level of =119 dBm [or —116 dBm if using Tower Top

Amplifier (TMPC)]. All tests are performed using the external calibrated
test set as the signal source controlled by the same command. All
measurements are via the LMF.

The Pilot Gain is set to 262 for each TX antenna, and all channel
elements from the MCCs are forward-link disabled. The BBX is keyed
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up, using only bbxlvl level offsets, to generate a CDMA carrier (with
pilot channel element only). BBX power output is set to —20 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler). The BBX must be keyed to enable the RX receive
circuitry.

The LMF prompts the MCC/CE under test to measure all zero longcode
and provide the FER report on the selected active MCC on the reverse
link for both the main and diversity RX antenna paths, verifying that
results meet the following specification:

* FER returned less than 1% and total frames measured is 1500
All MCC/CE:s selected are tested on the specified RX antenna path. The
BBX then de-keys and, if selected, the MCC is re-configured to assign

the applicable redundant BBX to the current RX antenna paths under
test. The test is then repeated.

SeqJable 4-1 to perform this test.
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Generating an ATP Report

Background
Each time an ATP test is run, an ATP report is updated to include the
results of the most recent ATP tests if the Save Results button is used to
close the status report window. The ATP report is not updated if the
status reports window is closed using the Dismiss button.

ATP Report

Each time an ATP test is run, a separate report is created for each BTS
and includes the following for each test:

® Test name

¢ BBX number

¢ Channel number
¢ (Carrier number
¢ Sector number

e Upper test limit
* Lower test limit
® Test result

¢ PASS or FAIL

* Description information (if applicable)
* Time stamp

* Details/Warning information (if applicable)

The report can be printed if the LMF computer is connected to a printer.
Follow the procedure in thqFable 4-2 to view and/or print the ATP
report for a BTS.

Table 4-2: Generating an ATP Report

v~ Step Action

1 Click on the Login tab (if not in the forefront).

2 Select the desired BTS from the available Base Station
pick list.

3 Click on the Report button.

Click on a column heading to sort the report.

5 — If not desiring a printable file copy, click on the
Dismiss button.

— If requiring a printable file copy, select the desired
file type in the picklist and click on the Save button.

4-16 1X SC™ 4812T BTS Optimization/ATP Oct 2003



0 MOTOROLA

Chapter 5

Prepare to Leave the Site g

Oct 2003 1X SC™ 4812T BTS Optimization/ATP 5-1



-l

Updating Calibration Data Files 68P09258A31-A

Updating Calibration Data Files

Software Release caveats

With Software Release 2.16.1.x, the packet BTS will NOT detect a new
calibration file on the OMC-R. A manual workaround is available in
bulletin cdma_g_bts_059. This will be corrected in Software Release
2.16.3.

Software Release 2.16.3 will allow the user to load the calibration file
from the LMF directly onto the MGLI. The MGLI will then ftp the new
calibration file to the OMC-R, thereby eliminating the need for the user
to place the calibration file at the OMC-R.

Copy and Load Cal File to to CBSC

After completing the TX calibration and audit, updated CAL file
information must be moved from the LMF Windows environment back
to the CBSC, a Unix environment. The following procedures detail
moving files from one environment to the other.

Copying CAL files from LMF to a Diskette

Follow the procedures irrfable 5-1 to copy the CAL files from an LMF
computer to a 3.5 diskette.

Table 5-1: Copying CAL Files to a Diskette

Step

Action

1 With Windows running on the LMF computer, insert a disk into Drive A:\.

Launch the Windows Explorer application program from the Start > Programs menu list.

Select the applicable <x>:\<lmf home directory/cdma/bts—# folder.

Drag the bts—#.cal file to Drive A.

DB~ W N

Repeat Steps 3 and 4, as required, for other bts—# folders.
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Copying CAL Files from Diskette to the CBSC

Follow the procedure irfable 5-2 to copy CAL files from a diskette to
the CBSC.

Table 5-2: Procedures to Copy CAL Files from Diskette to the CBSC

Step Action

1 Log into the CBSC on the OMC-R Unix workstation using your account name and password.

Place the diskette containing calibration files (cal files) in the workstation diskette drive.

2
3 Type eject —q and press the Enter key.
4 Type mount and press the Enter key. Verify that £loppy/no_name is displayed.

NOTE

If the eject command has been previously entered, floppy/no_name will be appended with a
number. Use the explicit £loppy/no_name reference displayed.

5 Type in cd /floppy/no_name and press the Enter key.

6 Type in Is -lia and press the Enter key. Verify the bts—#.cal file filename appears in the displayed
directory listing.

7 Type in cd and press the Enter key.

8 Type in pwd and press the Enter key. Verify the displayed response shows the correct home directory
(/home/<user’s name>).

-l

9 With Solaris versions of Unix, create a Unix—formatted version of the bts—#.cal file in the home
directory by performing the following:

9a — Type in dos2unix /floppy/no_name/bts—#.cal bts—#.cal and press the Enter key.
Where: # = BTS number for which the CAL file was created
NOTE

Other versions of Unix do not support the dos2unix command. In these cases, use the Unix cp (copy)
command. The copied files will contain DOS line feed characters which must be edited out with a
Unix text editor.

10 | Type in Is -l *.cal and press the Enter key. Verify the CAL files have been copied. Verify all CAL
files to be transferred appear in the displayed listing.

11 Type eject and press the Enter key.

12 Remove the diskette from the workstation.
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Prepare to Leave the Site

External Test Equipment Removal

Perform the procedure iqj"able 5-3 to disconnect the test equipment and
configure the BTS for active service.

Table 5-3: External Test Equipment Removal

Step Action

1 Disconnect all external test equipment from all TX and RX
connectors on the top of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed
lines at the top of the frame.

CAUTION Verify that all sector antenna feed lines are connected to the
correct ports on the frame. Crossed antenna cables will cause
system degradation of call processing.

NOTE Each module or device can be in any state prior to downloading.
Each module or device will be in an OOS_RAM state after
downloading has completed.

— For all LMF commands, information in italics represents
valid ranges for that command field.

— Only those fields requiring an input will be specified.
Default values for other fields will be assumed.

— For more complete command examples (including system
response details), refer to the CDMA LMF User Guide.
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BTS Site Span Configuration Verification

able 5-4 describes how to verify the current Span Framing Format and
Line Build Out (LBO) parameters. ALL MGLI2/GLI2 boards in all
C—CCP shelves that terminate a T1/E1 span should be verified.

Table 5-4: BTS Span Parameter Configuration

Step Action

1 Connect a serial cable from the LMF COM1 port (via null modem board) to the front panel of the
MGLI2 MMI port (seqijigure 5-1).

2 Start an MMI communication session with MGLI2 by using the Windows desktop shortcut icon (see
[Jable 3-3 on pagq3-13).
NOTE

The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

3 Enter the following MMI command to display the current MGLI2/GLI2 framing format and line code
configuration (in bold type):

span view <cr>
Observe a display similar to the options shown below:
COMMAND ACCEPTED: span view

The parameter in NVM is set to T1_2.

The frame format in flash is set to use T1_2.
Equalization:
Span A — Default (0-131 feet for T1/J1, 120 Ohm for El)

Span B — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span C — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span D — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span E — Default (0-131 feet for T1/J1, 120 Ohm for El)
Span F — Default (0-131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate
The actual rate is 0

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11 . ciieieirieeeeecacescacccccnscnnns

3—40[]
NOTE
— Defaults for span equalization are 0-131 feet for T1/J1 spans and 120 Ohm for E1.

— Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.
— There is no need to change from defaults unless the OMC-R/CBSC span configuration requires it.

— If the current MGLI2/GLI2 framing format and line code configuration does not display the
correct choice, proceed tqj" able 5-5.

4 Repeat stepg througl3 for all remaining GLIs.

Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then EXit from the drop—down menu.
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Figure 5-1: MGLI2/GLI2 MMI Port Connection
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Set BTS Site Span Configuration

Iﬁ

Perform the procedure irpJable 5-5 to configure the Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI2/GLI2
boards in all C—CCP shelves that terminate a T1/E1 span must be
configured.

NOTE Perform the following procedure ONLY if span configurations
loaded in the MGLI2/GLI2s do not match those in the
OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 5-5: Set BTS Span Parameter Configuration

Step Action

1 If not already done, connect a serial cable from the LMF COM1 port (via null modem board) to the
front panel of the MGLI2 MMI port (seqfjigure 5-1).

2 Start an MMI communication session with CSM-1 by using the Windows desktop shortcut icon (see
[Jable 3-3 on pagq3-13).
NOTE

The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

... continued on next page
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[Table 5-5: Set BTS Span Parameter Configuration

Step Action
3 If required only, enter the following MMI command for each span line to set the BTS span parameters
to match that of the physical spans a — f run to the site:
span_config <option#1> <option#2> <option#3> <option#4> <option#5>
option#l = the span to change (a—f)
option#2 = the span type (0 —8):
0-E1_1 (HDB3, CCS, CRC—4)
1-E1 2 (HDB3, CCS)
2 - E1 3 (HDB3, CAS, CRC4, TS16)
3 - E1_4 (HDB3, CAS, TS16)
4 —-T1_1 (AMI, DS1 AT&T D4, without ZCS, 3 to 1 packing, Group 0 unusable)
5-T1 2 (B8ZS, DS1 AT&T ESF, 4 to 1 packing, 64K link)
6 —J1 1 (B8ZS, J1 AT&T ESF, Japan CRC6, 4 to 1 packing)
7 —1J1 2 (B8ZS, J1 AT&T ESF, US CRC6, 4 to 1 packing)
8 —T1 3 (AMI, DS1 AT&T D4, with ZCS, 3 to 1 packing, Group 0 unusable)
option#3 = the link speed (56 or 64) Kbps
option#4 = the span equalization (0 —7):
0-T1_6 (T1,J1:long haul)
1-T1 4 (T1,J1:393-524 feet)
2-T1 4 (T1,J1:131-262 feet)
3 —E1_75 (E1:75 Ohm)
4-T1 4 (T1,J1:0-131 feet)
5—-T1 4 (T1,J1:524-655 feet)
6 —T1 4 (T1,J1:262-393 feet)
7 —E1_120 (E1:120 Ohm)
option#5 = the slot that has LAPD channel (0 —31)
Example for setting span configuration to E1_2, 64 Kbps, E1_120—Ohm, LAPD channel 1:
span _config a 1 64 7 1
span _config £ 1 64 7 1
Example for setting span configuration to T1_2, 64 Kbps, T1_4 (0-131 feet), LAPD channel O:
span _config a 5 64 4 0
span _config £ 5 64 4 0
NOTE
Make sure that spans a — f are set to the same span type and link speed. The equalization may be
different for each individual span.
After executing the span_config command, the affected MGLI2/GLI2 board MUST be reset and
re—loaded for changes to take effect.
Although defaults are shown, always consult site specific documentation for span type and rate used at
the site.
4 Press the RESET button on the GLI2 for changes to take effect.
... continued on next page
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[Table 5-5: Set BTS Span Parameter Configuration

Step

Action

This completes the site specific BTS Span setup for this GLI. Move the MMI cable to the next GLI2
and repeat stepg an¢4 for ALL MGLI2/GLI2 boards.

6 Terminate the Hyperterm session and disconnect the LMF from the MGLI/SGLI.
LMF Removal
Perform the procedure irrable 5-6 as required to terminate the LMF
GUI session and remove the LMF computer.
Table 5-6: Terminate the LMF Session and Remove the LMF
Step Action
! CAUTION
DO NOT power down the CDMA LMF without performing the procedure indicated below.
Corrupted/lost data files may result, and in some cases, the CDMA LMF may lock up.
1 Log out of all BTS sessions and exit LMF by clicking on File in the LMF window menu bar and selecting
Logout and Exit from the pull-down list.
2 From the Windows Task Bar click Start>Shutdown. Click Yes when the Shut Down Windows
message appears.
3 Wait for the system to shut down and the screen to go blank.
4 Disconnect the LMF terminal Ethernet connector from the BTS cabinet.
5 Disconnect the LMF serial port, the RS-232 to GPIB interface box, and the GPIB cables as required
for equipment transport.

5-8
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Re—connect BTS T1/E1 Spans and Integrated Frame Modem

Before leaving the site, connect any T1 span TELCO connectors that
were removed to allow the LMF to control the BTS. Refer tqJable 5-7
andjigure 5-2 as required.

Table 5-7: T1/E1 Span/IFM Connections

Step Action

1 Connect the 50-pin TELCO cables to the BTS span I/O board 50—pin TELCO connectors.

2 If used, connect the dial-up modem RS-232 serial cable to the Site I/O board RS-232 9—pin
sub D connector.

NOTE
Verify that you connect both SPAN cables (if removed previously), and the Integrated Frame
Modem (IFM) “TELCO” connector.

Figure 5-2: Site and Span I/O Boards T1 Span Connections
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Reset All Devices and Initialize Site Remotely

Devices in the BTS should not be left with data and code loaded from
the LMF. The configuration data and code loads used for normal
operation could be different from those stored in the LMF files. Perform
the procedure irpFable 5-8 to reset all devices and initialize site remotely.

Table 5-8: Reset BTS Devices and Remote Site Initialization

Step Action
1 Terminate the LMF session by following the procedures irable 5-6.
2 Reconnect spans by following the procedure irable 5-7.
3 — If BTS is configured for circuit operation, go to Ster4.
— If BTS is configured for packet operation, go to Stef 3.
4 Circuit BTS Procedure:
4a | From the BTS site, contact the OMC-R and request the operator to perform a BTS reset.
or
At the BTS site:
— unseat one GLI card at a time and wait for 30 seconds;
— reseat the GLI and wait for it to complete its initialization (this takes about one minute);
— repeat for the second GLI.
4b | Depending on the number of installed operational GLI cards, perform one of the following:
— With fully redundant GLIs, contact the OMC-R and request the operator to run the ACTIVATE
command for the BTS.
— For a non-redundant GLI or a frame where the redundant GLI is not operational, contact the
OMC-R and request the operator:
¢ ACTIVATE the GLI to set the Nextload attribute for the GLI to the one for the current BSS
software version;
¢ Disable the GLI;
¢ Enable the GLI to allow the MM to load the software version specified by the Nextload
attribute;
* Once the GLI is INS_ACT, contact the OMC-R and request the operator ACTIVATE the BTS.
— Once the GLI cards are loaded with the specified code version, the active GLI will verify and
update, as required, the RAM and, if it is necessary, ROM code loads for the installed CSM,
MCC, and BBX cards using the DLM.
... continued on next page
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ﬂable 5-8: Reset BTS Devices and Remote Site Initialization

Step

Action

Sa

Packet BTS procedure:

From the BTS site, contact the OMC-R and request the operator to PREACTIVATE the BTS to the
required software version for the BSS. There are two types of PREACTIVATE load processes:

— Rolling Upgrade: This load process is only available when the BTS cards are populated for full
redundancy as applicable.

— Quick Reboot: This process is used when there is not full redundancy for the BTS cards. The
GLI3 will disable and reboot to the new load. This will cause all the other cards to go out of
service. Once it is rebooted, the GLI3 determines which cards require a new load and then
downloads the cards in the order which they establish communication with the GLI3 following
their reboot. The GLI3 can reload up to 16 devices simultaneously.

After all activities at the site have been completed, contact the OMC-R and confirm that the BTS is
under OMC-R control.
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Basic Troubleshooting Overview

Overview

The information in this section addresses some of the scenarios likely to
be encountered by Cellular Field Engineering (CFE) team members.
This troubleshooting guide was created as an interim reference document
for use in the field. It provides basic “what to do if” basic
troubleshooting suggestions when the BTS equipment does not perform
per the procedure documented in the manual.

Comments are consolidated from inputs provided by CFEs in the field
and information gained form experience in Motorola labs and
classrooms.
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Troubleshooting: Installation

Cannot Log into Cell-Site

Follow the procedure iqj"able 6-1 to troubleshoot a login failure.

Table 6-1: Login Failure Troubleshooting Procedures

v~ Step Action

1 If the MGLI LED is solid RED, it implies a hardware failure. Reset the MGLI by re-seating it. If
this persists, install a known good MGLI card in the MGLI slot and retry. A Red LED may also
indicate no Ethernet termination at top of frame.

2 Verify that T1 is disconnected (seqFable 3-4 on pagq3-16).
If T1 is still connected, verify the CBSC has disabled the BTS.

3 Try pinging the MGLI (seq Fable 3-11 on pagq3-34).

Verify the LMF is connected to the Primary LMF port (LAN A) in the front of the BTS (see
[Jable 3-5 on pagq3-17).

Verify the LMF was configured properly (see Preparing the LMF section starting on page 3—0).
Verify the BTS-LMF cable is RG-58 [flexible black cable of less than 76 cm (2.5 feet) length].

o

Verify the Ethernet ports are terminated properly (seqijigure 3-9 on pagq3-33).

0| | | N

Verify a T-adapter is not used on the LMF side port if connected to the BTS front LMF primary
port.

9 Try connecting to the I/O panel (top of frame). Use BNC T-adapters at the LMF port for this
connection.

10 | Re-boot the LMF and retry.

11 Re-seat the MGLI and retry.

12 | Verify IP addresses are configured properly.

Cannot Communicate to Power Meter

Follow the procedure irﬂable 6-2 to troubleshoot a power meter
communication failure.

Table 6-2: Troubleshooting a Power Meter Communication Failure

»~| Step Action

1 Verify the Power Meter is connected to the LMF with a GPIB adapter.

2 Verify the cable setup as specified in Chapter 3.

3 Verify the GPIB address of the power meter is set to the same value displayed in the applicable
GPIB address box of the LMF Options window Test Equipment tab. Refer tqJable 3-25 or
[Jable 3-26 and the GPIB Addresses section of Appendix T for details.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to the CDMA 2000 Test Equipment
Preparation section of AppendixT for details.

... continued on next page

Oct 2003 1X SC™ 4812T BTS Optimization/ATP 6-3



-l

Troubleshooting: Installation 68P09258A31-A

Table 6-2: Troubleshooting a Power Meter Communication Failure

v~ Step Action
5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then cycle GPIB box power and
retry.
6 Verify the LMF computer COM1 port is not used by another application; for example, if a
HyperTerminal window is open for MMI, close it.
7 Reset all test equipment by clicking Util in the BTS menu bar and selecting

Test Equipment>Reset from the pull-down lists.

Cannot Communicate to Communications Analyzer

Follow the procedure irrable 6-3 to troubleshoot a communications
analyzer communication failure.

Table 6-3: Troubleshooting a Communications Analyzer Communication Failure

»~| Step Action

1 Verify signal generator is connected to LMF with GPIB adapter.

2 Verify cable connections as specified in Chapter 3.

3 Verify the signal generator GPIB address is set to the same value displayed in the applicable GPIB
address box of the LMF Options window Test Equipment tab. Refer tqFable 3-25 orfable 3-26
and the GPIB Address section of Appendix for details.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to the CDMA 2000 Test Equipment
Preparation section of AppendixH for details.

5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then cycle the GPIB box power
and retry.

6 Verify the LMF computer COM1 port is not used by another application; for example, if a
HyperTerminal window is open for MMI, close it.

7 Reset all test equipment by clicking Util in the BTS menu bar and selecting
Test Equipment>Reset from the pull-down lists.
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Troubleshooting: Download

Cannot Download CODE to Any Device (card)

Follow the procedure irﬂ" able 6-4 to troubleshoot a code download
failure.

Table 6-4: Troubleshooting Code Download Failure

v~ Step Action

1 Verify T1 is disconnected from the BTS.

2 Verify the LMF can communicate with the BTS device using the Status function.

3 Communication to the MGLI must first be established before trying to talk to any other BTS
device.
The MGLI must be INS_ACT state (green).

4 Verify the card is physically present in the cage and powered-up.

5 If the card LED is solid RED, it implies hardware failure.
Reset the card by re-seating it.
If the LED remains solid red, replace with a card from another slot & retry.

NOTE

The card can only be replaced by a card of the same type.

6 Re-seat the card and try again.

7 If a BBX reports a failure message and is OOS_RAM, the code load was OK. Use the LMF
Status function to verify the load.

8 If the download portion completes and the reset portion fails, reset the device by selecting the
device and Reset.

9 If a BBX or an MCC remains OOS_ROM (blue) after code download, use the LMF
Device > Status function to verify that the code load was accepted.

10 If the code load was accepted, use LMF Device > Download > Flash to load RAM code into flash
memory.

Cannot Download DATA to Any Device (Card)

Perform the procedure iqj"able 6-5 to troubleshoot a data download
failure.

Table 6-5: Troubleshooting Data Download Failure

v~ Step Action

1 Re-seat the card and repeat code and data load procedure.
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Cannot ENABLE Device

Before a device can be enabled (placed in-service), it must be in the
OOS_RAM state (yellow) with data downloaded to the device. The color
of the device changes to green once it is enabled.

The three states that devices can be changed to are as follows:
* Enabled (green, INS)

* Disabled (yellow, OOS_RAM)

* Reset (blue, OOS_ROM)

Follow the procedure iqj“able 6-6 to troubleshoot a device enable
failure.

Table 6-6: Troubleshooting Device Enable (INS) Failure

v~ Step Action

1 Re-seat the card and repeat the code and data load procedure.

2 If the CSM cannot be enabled, verify the CDF file has correct latitude and longitude data for cell
site location and GPS sync.

3 Ensure the primary CSM is in INS_ACT state.

NOTE
MCCs will not go INS without the CSM being INS.

4 Verify the 19.6608 MHz CSM clock; MCCs will not go INS otherwise.

5 The BBX should not be enabled for ATP tests.

6 If MCCs give “invalid or no system time”, verify the CSM is operable.

Miscellaneous Errors

Perform the procedure irpfable 6-7 to troubleshoot miscellaneous
failures.

Table 6-7: Miscellaneous Failures

v~ Step Action

1 If LPAs continue to give alarms, even after cycling power at the circuit breakers, then connect an
MMI cable to the LPA and set up a Hyperterminal connection (seq Fable 3-3 on pagq3-13).

2 Enter ALARMS in the Hyperterminal window.
The resulting LMF display may provide an indication of the problem.
(Call Field Support for further assistance.)
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Troubleshooting: Calibration

Bay Level Offset Calibration Failure

Perform the procedure iqj"able 6-8 to troubleshoot a BLO calibration
failure.

Table 6-8: Troubleshooting BLO Calibration Failure

»~| Step

Action

Verify the Power Meter is configured correctly (see the test equipment setup section in Chapter 3)
and connection is made to the proper TX port.

Verify the parameters in the bts—#.cdf file are set correctly for the following bands:

For 1900 MHz:

Bandclass=1; Freq_Band=16; SSType=16
For 800 MHz:

Bandclass=0; Freq_Band=8; SSType=8
For 1700 MHz:

Bandclass=4; Freq_Band=128; SSType=16

Verify that no LPA in the sector is in alarm state (flashing red LED).
Reset the LPA by pulling the circuit breaker and, after 5 seconds, pushing back in.

Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.

Verify the GPIB adapter is not locked up.

Under normal conditions, only two green LEDs must be ‘ON’ (Power and Ready).

If any other LED is continuously ‘ON’, power-cycle (turn power off and on) the GPIB Box and
retry.

Verify the sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power Ref
signal.

If communication between the LMF and Power Meter is operational, the Meter display will show
“RES”.
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Cannot Load BLO

For Load BLO failures seqj"able 6-7.

Calibration Audit Failure

Follow the procedure iqj"able 6-9 to troubleshoot a calibration audit
failure.

Table 6-9: Troubleshooting Calibration Audit Failure

v~ Step Action
1 Verify the Power Meter is configured correctly (refer to the test equipment setup section of
Chapter 3).
2 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.
3 Verify that no LPA is in alarm state (rapidly flashing red LED).
Reset the LPA by pulling the circuit breaker and, after 5 seconds, pushing back in.
4 Verify that no sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power
Ref signal.
5 After calibration, the BLO data must be re-loaded to the BBXs before auditing.
Click on the BBX(s) and select Device>Download BLO.
Re-try the audit.
6 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be “ON” (Power and Ready).
If any other LED is continuously “ON”, power-cycle (turn power off and on) the GPIB Box and
retry.
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Troubleshooting: Transmit ATP

BTS passed Reduced ATP tests but has forward link problem during normal
operation

Follow the procedure irﬂ" able 6-10 to troubleshoot a Forward Link
problem during normal operation.

Table 6-10: Troubleshooting Forward Link Failure (BTS Passed Reduced ATP)

»~| Step Action
1 Perform these additional TX tests to troubleshoot a forward link problem:
— TX mask
— TX ho
— TX code domain

Cannot Perform TX Mask Measurement

Follow the procedure iqj"able 6-11 to troubleshoot a TX mask
measurement failure.

Table 6-11: Troubleshooting TX Mask Measurement Failure

»~| Step Action

1 Verify that TX audit passes for the BBX(s).

2 If performing manual measurement, verify analyzer setup.

3 Verify that no LPA in the sector is in alarm state (flashing red LED).
Re-set the LPA by pulling the circuit breaker and, after 5 seconds, pushing it back in.

Cannot Perform Rho or Pilot Time Offset Measurement

Follow the procedure iqj"able 6-12 to troubleshoot a rho or pilot time
offset measurement failure.

Table 6-12: Troubleshooting Rho and Pilot Time Offset Measurement Failure

»~| Step Action
1 Verify presence of RF signal by switching to spectrum analyzer screen.
2 Verify PN offsets displayed on the analyzer is the same as the PN offset in the CDF file.
3 Re-load BBX data and repeat the test.
4 If performing manual measurement, verify analyzer setup.
5 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the LPA by pulling the

circuit breaker and, after 5 seconds, pushing back in.

6 If Rho value is unstable and varies considerably (e.g. .95,.92,.93), this may indicate that the GPS
is still phasing (i.e., trying to reach and maintain O freq. error).

Go to the freq. bar in the upper right corner of the Rho meter and select Hz. Press <Shift-avg>
and enter 10, to obtain an average Rho value. This is an indication the GPS has not stabilized
before going INS and may need to be re-initialized.
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Cannot Perform Code Domain Power and Noise Floor Measurement

Perform the procedure iqj"able 6-13 to troubleshoot a code domain and
noise floor measurement failure.

Table 6-13: Troubleshooting Code Domain Power and Noise Floor Measurement Failure

»~| Step Action
1 Verify presence of RF signal by switching to spectrum analyzer screen.
2 Verify PN offset displayed on analyzer is same as PN offset being used in the CDF file.
3 Disable and re-enable MCC (one or more MCCs based on extent of failure).
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Troubleshooting: Receive ATP

Multi—-FER Test Failure

Perform the procedure iqj"able 6-14 to troubleshoot a Multi—-FER
failure.

Table 6-14: Troubleshooting Multi-FER Failure

v~ Step Action
1 Verify the test equipment set up is correct for an FER test.
2 Verify the test equipment is locked to 19.6608 and even second clocks.
On the HP8921A test set, the yellow LED (REF UNLOCK) must be OFF.
3 Verify the MCCs have been loaded with data and are INS-ACT.
4 Disable and re-enable the MCC (one or more based on extent of failure).
5 Disable, re-load code and data, and re-enable the MCC (one or more MCCs based on extent of
failure).
6 Verify the antenna connections to frame are correct based on the directions messages.
Oct 2003 6-11
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Troubleshooting: CSM Check-list

Problem Description

Many of the Clock Synchronization Manager (CSM) board failures may
be resolved in the field before sending the boards to the factory for
repair. This section describes known CSM problems identified in field
returns, some of which are field-repairable. Check these problems before
returning suspect CSM boards.

Intermittent 19.6608 MHz Reference Clock/GPS Receiver Operation

No GPS Reference Source

Checksum Failure

If having any problems with CSM board kit numbers, SGLN1145 or
SGLN4132, check the suffix with the kit number. If the kit has version
“AB?”, then replace with version “BC” or higher, and return model “AB”
to the repair center.

Check the CSM boards for proper hardware configuration. CSM kit
SGLN1145, in Slot 1, has an on-board GPS receiver; while kit
SGLN4132, in Slot 2, does not have a GPS receiver. Any incorrectly
configured board must be returned to the repair center. Do not attempt to
change hardware configuration in the field. Also, verify the GPS
antenna is not damaged and is installed per recommended guidelines.

The CSM could have corrupted data in its firmware resulting in a
non-executable code. The problem is usually caused by either electrical
disturbance or interruption of data during a download. Attempt another
download with no interruptions in the data transfer. Return the CSM
board back to the repair center if the attempt to reload fails.

GPS Bad RX Message Type

This problem is believed to be caused by a later version of CSM
software (3.5 or higher) being downloaded, via LMF, followed by an
earlier version of CSM software (3.4 or lower), being downloaded from
the CBSC. Download again with CSM software code 3.5 or higher.
Return the CSM board back to the repair center if the attempt to reload
fails.

CSM Reference Source Configuration Error

This problem is caused by incorrect reference source configuration
performed in the field by software download. CSM kits SGLN1145 and
SGLN4132 must have proper reference sources configured (as shown
below) to function correctly.

CSM Kit Hardware CSM Slot Reference Source CDF Value
No. Configuration No. Configuration
SGLN1145 | With GPS Receiver 1 Primary = Local GPS 0
Backup = Either LFR or HSO 2or18
SGLN4132 | Without GPS Receiver 2 Primary = Remote GPS 1
Backup = Either LFR or HSO 2or18
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Takes Too Long for CSM to Come INS

This problem may be caused by a delay in GPS acquisition. Check the
accuracy flag status and/or current position. Refer to the GSM system
time/GPS and LFR/HSO verification section in Chapter 3. At least one
satellite should be visible and tracked for the “surveyed” mode and four
satellites should be visible and tracked for the “estimated” mode. Also,
verify correct base site position data used in “surveyed” mode.
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C-CCP Backplane Troubleshooting

Introduction

Connector Functionality

The C—CCP backplane is a multi-layer board that interconnects all the
C—CCP modules. The complexity of this board lends itself to possible
improper diagnoses when problems occur.

The following connector overview describes the major types of

backplane connectors along with the functionality of each. This

information allows the CFE to:

* Determine which connector(s) is associated with a specific problem
type.

¢ Isolate problems to a specific cable or connector.

Primary “A” and Redundant “B” Inter Shelf Bus
Connectors

The 40 pin Inter Shelf Bus (ISB) connectors provide an interface bus
from the master GLI to all other GLIs in the modem frame. Their basic
function is to provide clock synchronization from the master GLI to all
other GLIs in the frame.

The ISB also provides the following functions:
* Span line grooming when a single span is used for multiple cages.
* MMI connection to/from the master GLI to cell site modem.

* Interface between GLIs and the AMR (for reporting BTS alarms).

Span Line Connector

The 50—pin span line connector provides a primary and secondary (if
used) span line interface to each GLI in the C—CCP shelf. The span line
is used for MM/EMX switch control of the Master GLI and also all the
BBX traffic.

Primary “A” and Redundant “B” Reference Distribution
Module Input/Output

The Reference Distribution Module (RDM) connectors route the 3 MHz
reference signals from the CSMs to the GLIs and all BBXs in the
backplane. The signals are used to phase lock loop all clock circuits on
the GLIs and BBX boards to produce precise clock and signal
frequencies.

Power Input (Return A, B, and C connectors)

Provides a +27 volt or —48 volt input for use by the power supply
modules.

6-14
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Power Supply Module Interface

Each power supply module has a series of three different connectors to
provide the needed inputs/outputs to the C—CCP backplane. These
include a VCC/Ground input connector, a Harting style multiple pin
interface, and a +15 V/Analog Ground output connector. The C—CCP
Power Modules convert +27 or —48 Volts to a regulated +15, +6.5, and
+5.0 Volts to be used by the C—CCP shelf cards. In the —48 V BTS, the
LPA power modules convert —48 Volts to a regulated +27 Volts.

GLI Connector

This connector consists of a Harting 4SU digital connector and a
6—conductor coaxial connector for RDM distribution. The connectors
provide inputs/outputs for the GLIs in the C—CCP backplane.

GLI 10Base-2 Ethernet “A” and “B” Connections

These BNC connectors are located on the C—CCP backplane and routed
to the GLI board. This interface provides all the control and data
communications between the master GLI and the other GLI, between
gateways, and for the LMF on the LAN.

BBX Connector

Each BBX connector consists of a Harting 2SU/1SU digital connector
and two 6—conductor coaxial connectors. These connectors provide DC,
digital, and RF inputs/outputs for the BBXs in the C—CCP backplane.

CIO Connectors

* RX RF antenna path signal inputs are routed through RX Tri-Filters
(on the I/O plate), and via coaxial cables to the two MPC modules —
the six “A” (main) signals go to one MPC; the six “B” (diversity) to
the other. The MPC outputs the low—noise—amplified signals via the
C—CCP backplane to the CIO where the signals are split and sent to
the appropriate BBX.

* A digital bus then routes the baseband signal through the BBX, to the
backplane, then on to the MCC slots.

* Digital TX antenna path signals originate at the MCCs. Each output
is routed from the MCC slot via the backplane appropriate BBX.

e TX RF path signal originates from the BBX, through the backplane to
the CIO, through the CIO, and via multi-conductor coaxial cabling to
the LPAs in the LPA shelf.

C-CCP Backplane Troubleshooting Procedure

[Jable 6-15 througlFable 6-24 provide procedures for troubleshooting
problems that appear to be related to a defective C—CCP backplane. The
tables are broken down into possible problems and steps that should be
taken in an attempt to find the root cause.

NOTE [Jable 6-15 througl-Jable 6-24 must be completed before
replacing ANY C—CCP backplane.
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Digital Control Problems

No GLI Control via LMF (all GLIs)

Follow the procedure iqj"able 6-15 to troubleshoot a GLI control via
LMEF failure.

Table 6-15: No GLI Control via LMF (all GLIs)

»~| Step Action

Check the 10Base-2 ethernet connector for proper connection, damage, shorts, or opens.

Verify the C—CCP backplane Shelf ID DIP switch is set correctly.

Visually check the master GLI connector (both board and backplane) for damage.

Replace the master GLI with a known good GLI.

No GLI Control through Span Line Connection (All GLlIs)

Follow the procedures iqj"able 6-16 an¢-Jable 6-17 to troubleshoot GLI
control failures.

Table 6-16: No GLI Control through Span Line Connection (Both GLIs)

Step Action
1 Verify the C—CCP backplane Shelf ID DIP switch is set correctly.
2 Verify that the BTS and GLIs are correctly configured in the OMCR/CBSC data base.
3 Visually check the master GLI connector (both board and backplane) for damage.
4 Replace the master GLI with a known good GLI.
5 Check the span line inputs from the top of the frame to the master GLI for proper connection and
damage.
6 Check the span line configuration on the MGLI (seqJable 5-4 on pagq3-5).
Table 6-17: MGLI Control Good — No Control over Co—located GLI
Step Action
1 Verify that the BTS and GLIs are correctly configured in the OMCR CBSC data base.
2 Check the ethernet for proper connection, damage, shorts, or opens.
3 Visually check all GLI connectors (both board and backplane) for damage.
4 Replace the remaining GLI with a known good GLI.
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No AMR Control (MGLI good)

Perform the procedure imrJ¥able 6-18 to troubleshoot an AMR control
failure when the MGLI control is good.

Table 6-18: MGLI Control Good — No Control over AMR
Step Action

1 Visually check the master GLI connector (both board and backplane) for damage.
2 Replace the master GLI with a known good GLI.
3 Replace the AMR with a known good AMR.

No BBX Control in the Shelf — (No Control over
Co-located GLlIs)

Perform the procedure iqj"able 6-19 to troubleshoot a BBX control in
the shelf failure.

Table 6-19: No BBX Control in the Shelf — No Control over Co—located GLIs

Step Action

1 Visually check all GLI connectors (both board and backplane) for damage.

Replace the remaining GLI with a known good GLI.

Visually check BBX connectors (both board and backplane) for damage.

AW

Replace the BBX with a known good BBX.

No (or Missing) Span Line Traffic

Perform the procedure iqj"able 6-20 to troubleshoot a span line traffic
failure.

Table 6-20: MGLI Control Good — No (or Missing) Span Line Traffic

Step Action

1 Visually check all GLI connectors (both board and backplane) for damage.

Replace the remaining GLI with a known good GLI.

Visually check all span line distribution (both connectors and cables) for damage.

If the problem seems to be limited to one BBX, replace the MGLI with a known good MGLI.

Perform the BTS Span Parameter Configuration ( seqFable 5-4 on pagq3-5).

QN N AW N

Ensure that ISB cabling is correct.
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No (or Missing) MCC Channel Elements

Perform the procedure iqj"able 6-21 to troubleshoot a channel elements
failure.

Table 6-21: No MCC Channel Elements

Step Action
1 Verify MCC channel elements (CEs) are correct. MCCTYPE codes are: MCC8E=0, MCC24E=2,
MCC-1X=3.
2 If the problem seems to be limited to one MCC, replace the MCC with a known good MCC.
— Check connectors (both board and backplane) for damage.
3 If no CEs on any MCC:
— Verity clock reference to CIO.
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DC Power Problems

Perform the procedure irﬂ" able 6-22 to troubleshoot a DC input voltage
to power supply module failure.

WARNING Potentially lethal voltage and current levels are routed to the
BTS equipment. This test must be carried out with a second
person present, acting in a safety role. Remove all rings, jewelry,
and wrist watches prior to beginning this test.

No DC Input Voltage to Power Supply Module

Table 6-22: No DC Input Voltage to Power Supply Module

Step Action

1 Verify DC power is applied to the BTS frame.

2 Verify there are no breakers tripped.

* IMPORTANT
If a breaker has tripped, remove all modules from the applicable shelf supplied by the breaker and

attempt to reset it.
— If the breaker trips again, there is probably a cable or breaker problem within the frame.

— If the breaker does not trip, there is probably a defective module or sub—assembly within the shelf.

Verify that the C—CCP shelf breaker on the BTS frame breaker panel is functional.

Use a voltmeter to determine if the input voltage is being routed to the C—CCP backplane by
measuring the DC voltage level on the PWR_IN cable.

— If the voltage is not present, there is probably a cable or breaker problem within the frame.

— If the voltage is present at the connector, reconnect and measure the level at the “VCC” power
feed clip on the distribution backplane.

— If the voltage is correct at the power clip, inspect the clip for damage.

If everything appears to be correct, visually inspect the power supply module connectors.

Replace the power supply module with a known good module.

7 If steps%]] througl fail to indicate a problem, a C—CCP backplane failure (possibly an open trace) has
occurred.
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No DC Voltage (+5, +6.5, or +15 Volts) to a Specific GLI,
BBX, or Switchboard

Perform the procedure irﬂ" able 6-23 to troubleshoot a DC input voltage
to GLI, BBX, or Switchboard failure.

Table 6-23: No DC Input Voltage to any C—CCP Shelf Module

Step Action
1 Verify the steps irjable 6-22 have been performed.
2 Inspect the defective board/module (both board and backplane) connector for damage.
3 Replace suspect board/module with known good board/module.

TX and RX Signal Routing Problems

Perform the procedure irﬂ" able 6-24 to troubleshoot TX and RX signal
routing problems.

Table 6-24: TX and RX Signal Routing Problems

Step

Action

Inspect all Harting Cable connectors and back—plane connectors for damage in all the affected board

slots.

Perform steps in the RF path troubleshooting flowchart in this manual.
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Module Front Panel LED Indicators and Connectors

Module Status Indicators

Each of the non-passive plug-in modules has a bi-color (green & red)
LED status indicator located on the module front panel. The indicator is
labeled PWR/ALM. If both colors are turned on, the indicator is yellow.

Each plug-in module, except for the fan module, has its own alarm
(fault) detection circuitry that controls the state of the PWR/ALM LED.

The fan TACH signal of each fan module is monitored by the AMR.
Based on the status of this signal, the AMR controls the state of the
PWR/ALM LED on the fan module.

LED Status Combinations for All Modules (except GLI, CSM, BBX, MCC)

PWR/ALM LED

The following list describes the states of the module status indicator.
* Solid GREEN — module operating in a normal (fault free) condition.

* Solid RED — module is operating in a fault (alarm) condition due to
electrical hardware failure.

Note that a fault (alarm) indication may or may not be due to a complete
module failure and normal service may or may not be reduced or
interrupted.

DC/DC Converter LED Status Combinations

The PWR CNVTR has alarm (fault) detection circuitry that controls the
state of the PWR/ALM LED. This is true for both the C-CCP and LPA
power converters.

PWR/ALM LED

The following list describes the states of the bi-color LED.
* Solid GREEN — module operating in a normal (fault free) condition.

* Solid RED — module is operating in a fault (alarm) condition due to
electrical hardware problem.
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CSM LED Status Combinations
PWR/ALM LED

The CSMs include on-board alarm detection. Hardware and
software/firmware alarms are indicated via the front panel indicators.

After the memory tests, the CSM loads OOS-RAM code from the Flash
EPROM, if available. If not available, the OOS—ROM code is loaded
from the Flash EPROM.

* Solid GREEN — module is INS_ACT or INS_STBY no alarm.

¢ Solid RED - Initial power up or module is operating in a fault (alarm)
condition.

¢ Slowly Flashing GREEN — OOS_ROM no alarm.
* Long RED/Short GREEN — OOS_ROM alarm.

¢ Rapidly Flashing GREEN — OOS_RAM no alarm or INS_ACT in
DUMB mode.

e Short RED/Short GREEN — OOS_RAM alarm.
* Long GREEN/Short RED — INS_ACT or INS_STBY alarm.
* Off —no DC power or on-board fuse is open.

* Solid YELLOW — After a reset, the CSMs begin to boot. During
SRAM test and Flash EPROM code check, the LED is yellow. (If
SRAM or Flash EPROM fail, the LED changes to a solid RED and
the CSM attempts to reboot.)

. Figure 6-1: CSM Front Panel Indicators & Monitor Ports
6

5o SYNC

o%@“ MONITOR

03 PWR/ALM
£ Indicator

°§@<\ FREQ

g MONITOR

FW00303

... continued on next page
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FREQ Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the 19.6608 MHz clock generated by the CSM. When
both CSM 1 and CSM 2 are in an in-service (INS) condition, the CSM 2
clock signal frequency is the same as that output by CSM 1.

The clock is a sine wave signal with a minimum amplitude of +2 dBm
(800 mVpp) into a 50 € load connected to this port.

SYNC Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the “Even Second Tick” reference signal generated by the
CSMs.

At this port, the reference signal is a TTL active high signal with a pulse
width of 153 nanoseconds.

MMI Connector — Only accessible behind front panel. The
RS-232 MMI port connector is intended to be used primarily in
the development or factory environment, but may be used in the
field for debug/maintenance purposes.

GLI2 LED Status Combinations

The GLI2 module has indicators, controls and connectors as described
below and shown il]jigure 6-2.

The operating states of the 5 LEDs are:

ACTIVE

Solid GREEN — GLI2 is active. This means that the GLI2 has shelf
control and is providing control of the digital interfaces.

Off — GLI2 is not active (i.e., Standby). The mate GLI2 should be
active.

MASTER
* Solid GREEN — GLI2 is Master (sometimes referred to as MGLI2).
e Off — GLI2 is non-master (i.e., Slave).

ALARM
e Solid RED — GLI2 is in a fault condition or in reset.

¢ While in reset transition, STATUS LED is OFF while GLI2 is
performing ROM boot (about 12 seconds for normal boot).

¢ While in reset transition, STATUS LED is ON while GLI2 is
performing RAM boot (about 4 seconds for normal boot).

e Off — No Alarm.
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STATUS

* Flashing GREEN- GLI2 is in service (INS), in a stable operating
condition.

* On - GLI2 is in OOS RAM state operating downloaded code.
¢ Off — GLI2 is in OOS ROM state operating boot code.

SPANS
* Solid GREEN - Span line is connected and operating.

* Solid RED — Span line is disconnected or a fault condition exists.

GLI2 Pushbuttons and Connectors

RESET Pushbutton — Depressing the RESET pushbutton
causes a partial reset of the CPU and a reset of all board devices.
The GLI2 is placed in the OOS_ROM state

MMI Connector — The RS-232MMI port connector is intended
to be used primarily in the development or factory environment
but may be used in the field for debug/maintenance purposes.

LAN Connectors (A & B) — The two 10BASE2 Ethernet circuit
board mounted BNC connectors are located on the bottom front
edge of the GLI2; one for each LAN interface, A & B. Ethernet
cabling is connected to tee connectors fastened to these BNC
connectors.

6-24
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Module Front Panel LED Indicators and Connectors

Figure 6-2: GLI2 Front Panel
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MMI PORT ‘>D

CONNECTOR

ACTIVELED —— 1]

/—/»O

LED

OPERATING STATUS
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STATUS

OFF — operating normally
ON — briefly during power-up when the Alarm LED turns
OFF.

RESET
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releasing the switch.

ALARM

OFF — operating normally
ON — briefly during power-up when the Alarm LED turns
OFF.

SPANS

BIFS%W GREEN —when éhe GLIZ IS INS (In-service)
— card is powered down, In initialization, or in standby

GREEN — operating normally

YELLOW — one or more of the equipped initialized spans is
receiving a remote alarm indication signal from the far end
RED — one or more of the equipped initialized spans is in an

alarm state

MASTER

arartitTotat

The pair of GLI2 cards include a redundant status. The
card in the top shelf is designated by hardware as the
active card; the card in the bottom shelf is in the standby
@hide operating normally in active mode

OFF — operating normally in standby mode

MMI PORT
CONNECTO

An RS-232, serial, asynchronous communications link for
Ruse as an MMI port. This port supports 300 baud, up to a
maximum of 115,200 baud communications.

ACTIVE

Shows the operating status of the redundant cards. The
redundant card toggles automatically if the active card is
@Rovactioe fedlsd operating normally

OFF — standby card operating normally

FW00225
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GLI3 Front Panel

fjigure 6-3 shows the GLI3 front panel.
Figure 6-3: GLI3 Front Panel

LED OPERATING STATUS ] ]
BPR A Connects to either a BPR or expansion cage and is wired as
an ethernet client.
BPR B Connects to either a BPR or expansion cage and is wired as
an ethernet client.

AUX Wired as an ethernet client for direct connection to a personal
computer with a standard ethernet cable. It allows connection
of ethernet “sniffer” when the ethernet switch is properly
configured for port monitoring

GLI Supports the cross—coupled ethernet circuits to the mate GLI

E/ﬁ

100BASE-T to
I BTS Packet Router

using a double crossover cable. gG/ or Expansion cage
RESET Pressing and releasing the switch resets all functions on ’ 100BASE_T
ALARM BBFS5perating normally 2 [Cj¥ Auxiliary Monitor

ON - briefly during power-up when the Alarm LED turns - °

OFF Dual 100BASE-T
Span SEBW &RERNowened dosvaiLilBirbtiAGdtioagorioe)standby o G* {2 gzg‘ugr']ﬁ;#“

GREEN — operating normally

(Mate) GLI3

YELLOW — one or more of the equipped initialized spans is

receiving a remote alarm indication signal from the far end E>© Reset Switch

RED — one or more of the equipped initialized spans is in an éE‘?E‘,\H Span (LED)

alarm state——— . . = | Alarm (LED)
MMI An RS-232, serial, asynchronous communications link for S MMI Port

use as an MMI port. This port supports 300 baud, up to a h

maximum of 115,200 baud communications. JOSCy— Active (LED)
STATUS OFF — operating normally Status (LED)

ON — briefly during power-up when the Alarm LED turns

QOFE

ACTIVE ShOW¥ fABEBRY ativgefdiine SiLidsdbimbarfenies) The
redundant card toggles automatically if the active card is
@Rovactioe fedlsd operating normally

OFF — standby card operating normally

ti-CDMA-WP-00064-v01-ildoc-ftw
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BBX LED Status Combinations

PWR/ALM LED

The BBX module has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

The following list describes the states of the bi-color LED:
* Solid GREEN - INS_ACT no alarm

¢ Solid RED Red - initializing or power-up alarm

¢ Slowly Flashing GREEN — OOS_ROM no alarm

* Long RED/Short GREEN — OOS_ROM alarm

¢ Rapidly Flashing GREEN — OOS_RAM no alarm

e Short RED/Short GREEN — OOS_RAM alarm

* Long GREEN/Short RED — INS_ACT alarm

MCC LED Status Combinations

The MCC module has LED indicators and connectors as described
below (seqjigure 6-4). Note that the figure does not show the
connectors as they are concealed by the removable lens.

The LED indicators and their states are as follows:

PWR/ALM LED
e RED - fault on module

ACTIVE LED

¢ Off — module is inactive, off-line, or not processing traffic.

¢ Slowly Flashing GREEN — OOS_ROM no alarm.

¢ Rapidly Flashing Green — OOS_RAM no alarm.

¢ Solid GREEN — module is INS_ACT, on-line, processing traffic.

PWR/ALM and ACTIVE LEDs

* Solid RED — module is powered but is in reset or the BCP is inactive.

MMI Connectors

* The RS-232 MMI port connector (four-pin) is intended to be used
primarily in the development or factory environment but may be used
in the field for debugging purposes.

* The RJ-11 ethernet port connector (eight-pin) is intended to be used
primarily in the development environment but may be used in the field
for high data rate debugging purposes.
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Figure 6-4: MCC Front Panel

PWR/ALM LED ———={]

INTV/HMd

LED COLOR OPERATING STATUS

PWR/ALM RED OFF — operating normally
ON — briefly during power-up and during
failure  conditions

LENS An alarm is generated in the event of a failure
(REMOVABLE) | ACTIVE GREEN | RAPIDLY BLINKING — Card is
code-loaded but  not enabled
SLOW BLINKING — Card is not
code-loaded
ON — card is code-loaded and enabled
RED | ONINSa/AEddMEilion
SLOW FLASHING (alternating with green)
— CHI  bus inactive on power-up

— FW00224

ACTIVE LED — 1]

JAILOY

LPA Shelf LED Status Combinations

LPA Module LED

Each LPA module contains a bi—color LED just above the MMI

connector on the front panel of the module. Interpret this LED as

follows:

* GREEN — LPA module is active and is reporting no alarms (Normal
condition).

* Flashing GREEN/RED — LPA module is active but is reporting an
low input power condition. If no BBX is keyed, this is normal and
does not constitute a failure.
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Basic Troubleshooting — Span Control Link

Span Problems (No Control Link)

Perform the procedure iqj"able 6-25 to troubleshoot a control link
failure.

Table 6-25: Troubleshoot Control Link Failure

»~| Step

Action

Connect the CDMA LMF computer to the MMI port on the applicable MGLI/GLI as shown in
igure 6-5 orfjigure 6-6.

Start an MMI communication session with the applicable MGLI/GLI by using the Windows
desktop shortcut icon.

Once the connection window opens, press the CDMA LMF computer Enter key until the GLI>
prompt is obtained.

At the GLI> prompt, enter:
config ni current <cr> (equivalent of span view command)

The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.

Equalization:
Span A — Default (0-131 feet for T1/J1, 120 Ohm for E1)
Span B — Default (0-131 feet for T1/J1, 120 Ohm for E1)
Span Default (0-131 feet for T1/J1, 120 Ohm for El)
Span Default (0-131 feet for T1/J1, 120 Ohm for El)
Span Default (0-131 feet for T1/J1, 120 Ohm for El)
Span Default (0-131 feet for T1/J1, 120 Ohm for El)

HHEOQ

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate
The actual rate is 0

NOTE
Defaults for span equalization are 0—131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.
There is no need to change from defaults unless the OMC-R/CBSC span configuration requires it.

The span configurations loaded in the GLI must match those in the OMCR/CBSC database for the
BTS. If they do not, proceed tqFable 6-26.

Repeat stepg througl3 for all remaining GLIs.

If the span settings are correct, verify the edlc parameters using the show command.
Any alarm conditions indicate that the span is not operating correctly.

* Try looping back the span line from the DSX panel back to the MM, and verify that the looped
signal is good.

¢ Listen for control tone on the appropriate timeslot from the Base Site and MM.

Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the drop—down menu.

If no TCHs in groomed MCCs (or in whole C—CCP shelf) can process calls, verify that the ISB
cabling is correct and that ISB A and ISB B cables are not swapped.
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Figure 6-5: MGLI/GLI Board MMI Connection Detail
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Figure 6-6: GLI3 Board MMI Connection Detail
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Set BTS Site Span Configuration

[Jable 6-26 describes how to set the span parameter configuration.

NOTE Perform the following procedure ONLY if span configurations
loaded in the MGLI/GLIs do not match those in the
OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 6-26: Set BTS Span Parameter Configuration

Step

Action

If not previously done, connect the CDMA LMF computer to the MMI port on the applicable
MGLI/GLI as shown irffjigure 6-5.

If there is no MMI communication session in progress with the applicable MGLI/GLI, initiate one
by using the Windows desktop shortcut icon.

At the GLI> prompt, enter:
config ni format <option> <cr>

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni format option
Next available options:
LIST — Option : Span Option

El1 1 : El_ 1 — E1 HDB3 CRC4 no TS16
El 2 : E1 2 — E1 HDB3 no CRC4 no TS16
El 3 : El_3 — E1 HDB3 CRC4 TS16
El 4 : El 4 — E1 HDB3 no CRC4 TS16
T1 1 : Tl 1 — D4, AMI, No ZCS
T1 2 : Tl 2 — ESF, B8ZS
Jl 1 : J1_1 — ESF, B8ZS (Japan) — Default
J1 2 : J1_2 — ESF, B8zZS
T1 3 : T1 3 — D4, AMI, ZCS

>

NOTE

With this command, all active (in—use) spans will be set to the same format.

To set or change the span type, enter the correct option from the list at the entry prompt (>), as
shown in the following example:

> T1_2 <cr>

NOTE

The entry is case—sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:

CP: Invalid command
GLI2>

An acknowledgement similar to the following will be displayed:

The value has been programmed. It will take effect after the next reset.
GLI2>

... continued on next page
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[Table 6-26: Sct BTS Span Parameter Configuration

| Step

Action

If the current MGLI/GLI span rate must be changed, enter the following MMI command:
config ni linkspeed <cr>
The terminal will display a response similar to the following:

Next available options:
LIST — 1linkspeed : Span Linkspeed

56K : 56K (default for Tl 1 and Tl 3 systems)

64K : 64K (default for all other span configurations)
>

NOTE

With this command, all active (in—use) spans will be set to the same linkspeed.

To set or change the span linkspeed, enter the required option from the list at the entry prompt (>),
as shown in the following example:

>64K <cr>
NOTE

The entry is case—sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:

CP: Invalid command

GLI2>

An acknowledgement similar to the following will be displayed:

The value has been programmed. It will take effect after the next reset.
GLI2>

If the span equalization must be changed, enter the following MMI command:
config ni equal<cr>
The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal span equal
Next available options:
LIST — span : Spa

: Span
: Span
: Span
: Span
: Span
: Span

HhOQQUoTo
HEHOQW >

. .. continued on next page
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[Table 6-26: Sct BTS Span Parameter Configuration

Step

Action

10

At the entry prompt (>), enter the designator from the list for the span to be changed as shown in
the following example:

>a<cr>

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal a equal
Next available options:

LIST — equal : Span Equalization

0 : 0-131 feet (default for T1/J1)

: 132-262 feet
: 263—-393 feet
: 394-524 feet
: 525-655 feet
¢ LONG HAUL
: 75 OHM
: 120 OHM (default for E1)

Noudes W

>

11

At the entry prompt (>), enter the code for the required equalization from the list as shown in the
following example:
>0<cr>

The terminal will display a response similar to the following:

>0
The value has been programmed. It will take effect after the next reset.
GLI2>

12

Repeat Stequ througl}jl for each in—use span.

NOTE
— After executing the config ni format, config ni linkspeed, and/or config ni equal
commands, the affected MGLI/GLI board MUST be reset and reloaded for changes to take
effect.
— Although defaults are shown, always consult site specific documentation for span type and
linkspeed used at the site.

13

Press the RESET button on the MGLI/GLI for changes to take effect.

14

Once the MGLI/GLI has reset, execute the following command to verify span settings are as
required:

config ni current <cr> (equivalent of span view command)

The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.
Equalization:
Span A — 0-131 feet
Span — 0-131 feet
Span — Default (0-131 feet for T1/J1, 120 Ohm for E1l)
Span Default (0-131 feet for T1/J1, 120 Ohm for El)
Span — Default (0-131 feet for T1/J1, 120 Ohm for E1l)
Span — Default (0-131 feet for T1/J1, 120 Ohm for El)

HEY QW
|

Linkspeed: 64K
Currently, the link is running at 64K
The actual rate is 0

. .. continued on next page
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[Table 6-26: Sct BTS Span Parameter Configuration

v~ Step Action

15 | If the span configuration is not correct, perform the applicable step from this table to change it and
repeat Stepg 33 anq 34 to verify required changes have been programmed.

16 Return to Steqj ofj"able 6-25.
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Notes
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Optimization (Pre—ATP) Data Sheets

Verification of Test Equipment Used

Table A-1: Verification of Test Equipment Used

Manufacturer Model Serial Number

Comments:
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Site Checklist A

Table A-2: Site Checklist

OK Parameter Specification Comments
] | Deliveries Per established procedures
(] | Floor Plan Verified

Inter Frame Cables:
| Ethernet Per procedure
| Frame Ground Per procedure
U Power Per procedure

Factory Data:
| BBX Per procedure
U Test Panel Per procedure
| RFDS Per procedure
[ | Site Temperature
L] | Dress Covers/Brackets

Preliminary Operations

Table A-3: Preliminary Operations
OK Parameter Specification Comments
(] | Shelf ID Dip Switches Per site equipage
(L | BBX Jumpers Verified per procedure
] | Ethernet LAN verification Verified per procedure
Comments:
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A Pre—Power and Initial Power Tests

Table A-4: Pre—power Checklist

OK Parameter Specification Comments

] | Pre—power—up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications

Internal Cables:

[ ISB (all cages) verified

U CSM (all cages) verified

U Power (all cages) verified

Ethernet Connectors

U LAN A ohms verified

U LAN B ohms verified

U LAN A shield isolated

| LAN B shield isolated

U Ethernet Boots installed

L] | Air Impedance Cage (single cage) installed

[ | Initial power—up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications:

Comments:
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Optimization (Pre—ATP) Data Sheets

General Optimization Checklist

Table A-5: Pre—power Checklist

OK Parameter Specification Comments
LEDs illuminated
Frame fans operational

LMF to BTS Connection
Preparing the LMF
Log into the LMF PC

Create site specific BTS directory per procedure
Create master—bts—cdma directory per procedure

Download device loads
Moving/Linking files

per procedure
per procedure

per procedure
per procedure

Ping LAN A
Ping LAN B

per procedure
per procedure

Download/Enable MGLIs
Download/Enable GLIs

Set Site Span Configuration
Download CSMs
Download

Enable CSMs
Download/Enable MCCs
Download BBXs
Download TSU (in RFDS)
Program TSU NAM

per procedure
per procedure
per procedure
per procedure
per procedure
per procedure
per procedure
per procedure
per procedure
per procedure

ooyl du o duodod oo

Test Set Calibration

per procedure

Comments:
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GPS Receiver Operation

Table A-6: GPS Receiver Operation
OK Parameter Specification Comments
L1 | GPS Receiver Control Task State: Verify parameter
tracking satellites
[ | Initial Position Accuracy: Verify Estimated
or Surveyed
] | Current Position: RECORD in ms
lat and cm also
lon convert to deg
height min sec
[ | Current Position: satellites tracked Verify parameter
Estimated: as appropriate:
(>4) satellites tracked,(>4) satellites visible
Surveyed:
(>1) satellite tracked,(>4) satellites visible
L1 | GPS Receiver Status:Current Dilution of Verify parameter
Precision
(PDOP or HDOP): (<30)
U Current reference source: Verify parameter
Number: 0; Status: Good; Valid: Yes
Comments:
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A

LFR Receiver Operation

Table A-7: LFR Receiver Operation

OK Parameter Specification Comments
L] | Station call letters M X Y Z as specified in site

assignment. documentation
] | SNratiois > 8 dB
| LFR Task State: Ifr Verify parameter

locked to station xxxx
] | Current reference source: Verify parameter

Number: 1; Status: Good; Valid: Yes

Comments:
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A LPA IM Reduction

Table A-8: LPA IM Reduction
Parameter Comments
OK | Lpa CARRIER Specification
# 4:1 &2:1 2:1 Dual BP Dual BP
3-Sector 6-Sector 3-Sector 6-Sector
| 1A C1 C1 C1 C1 No Alarms
] | 1B C1 C1 C1 C1 No Alarms
] | 1C C1 C1 C1 C1 No Alarms
] | 1D C1 C1 C1 C1 No Alarms
| 2A C2 C2 C2 No Alarms
] | 2B C2 C2 C2 No Alarms
] | 2C Cc2 C2 Cc2 No Alarms
] | 2D C2 C2 C2 No Alarms
] | 3A C3 C1 C1 No Alarms
] | 3B C3 C1 C1 No Alarms
] | 3C C3 C1 C1 No Alarms
] | 3D C3 C1 C1 No Alarms
] | 4A C4 Cc2 No Alarms
] | 4B C4 C2 No Alarms
] | 4C C4 C2 No Alarms
] | 4D C4 C2 No Alarms
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Optimization (Pre—ATP) Data Sheets

LPA Convergence

Table A-9: LPA Convergence

OK Parameter Specification Data
LPA # Converged
O 1A Verify per procedure & upload
0 B convergence data
0 1C
0 1D
O 2A Verify per procedure & upload
0 B convergence data
0 2C
0 2D
| 3A Verify per procedure & upload
0 3B convergence data
| 3C
| 3D
O 4A Verify per procedure & upload
0 AB convergence data
0 4C
O 4D
Oct 2003 1X SC™ 4812T BTS Optimization/ATP A9
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. Optimization (Pre—ATP) Data Sheets 68P09258A31-A

A TX BLO/Power Output Verification for 3—Sector Configurations

1-Carrier
2—Carrier Non—adjacent Channels
4—Carrier Non—adjacent Channels

Table A-10: TX BLO Calibration (3—S: 1-C, and 2— and 4-C Non-adjacent Channels)

OK | Parameter Specification Comments
BBX-1, ANT-1 = dB
- BBX-1, ANT-1 = dB
Calibrate | TX Bay Level Offset = 42 dB (+4 dB) | BBX-2, ANT-2=__ dB
. carrier 1 prior to calibration BBX-r, ANT-2 = dB
BBX-3, ANT-3 = dB
- BBX-1, ANT-3 = dB
BBX-7, ANT-1 = dB
- BBX-1, ANT-1 = dB
Calibrate | TX Bay Level Offset = 42 dB (+4 dB) | BBX-8, ANT-2=__ dB
. carrier 2 | prior to calibration BBX-r, ANT-2 = dB
BBX-9, ANT-3 = dB
u BBX-r, ANT-3= __ dB
BBX—4, ANT-1 = dB
- BBX-1, ANT-1 = dB
Calibrate | TX Bay Level Offset = 42 dB (+4 dB) | BBX-5,ANT-2=__ dB
d carrier 3 prior to calibration BBX-r, ANT-2 = dB
BBX-6, ANT-3 = dB
- BBX-1, ANT-3 = dB
BBX-10, ANT-1= __ dB
- BBX-1, ANT-1 = dB
Calibrate | TX Bay Level Offset = 42 dB (+4 dB) | BBX-11, ANT-2=__ dB
d carrier 4 prior to calibration BBX-r, ANT-2 = dB
BBX-12, ANT-3= __ dB
a BBX-r, ANT-3= _ dB
BBX-1, ANT-1 = dB
- BBX-1, ANT-1 = dB
Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution BBX-2, ANT-2=___ dB
u uct post calibration BBX-1, ANT-2 = dB

carrier 1 -

BBX-3, ANT-3 = dB
- BBX-1, ANT-3 = dB

... continued on next page
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Optimization (Pre—ATP) Data Sheets

Table A-10: TX BLO Calibration (3-S: 1-C, and 2— and 4-C Non-adjacent Channels)

OK | Parameter Specification Comments

BBX-7, ANT-1 = dB

a BBX-1, ANT-1 = dB

Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-8, ANT-2=___ dB

u uct post calibration BBX-1, ANT-2 = dB
carrier 2 -

BBX-9, ANT-3 = dB

- BBX-1, ANT-3 = dB

BBX—4, ANT-1 = dB

a BBX-1, ANT-1 = dB

Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-5, ANT-2=___ dB

u uct post calibration BBX-1, ANT-2 = dB
carrier 3 -

BBX-6, ANT-3 = dB

- BBX-1, ANT-3 = dB

BBX-10, ANT-1=__ dB

a BBX-1, ANT-1 = dB

Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-11, ANT-2=___dB

u uct post calibration BBX-r, ANT-2 = dB
carrier 4 -

BBX-12, ANT-3=__ dB

- BBX-1, ANT-3 = dB

Comments:
2—Carrier Adjacent Channel
Table A-11: TX BLO Calibration (3—S: 2—-C Adjacent Channels)
OK | Parameter Specification Comments

BBX-1, ANT-1 = dB

a BBX-1, ANT-1 = dB

Calibrate | TX Bay Level Offset = 42 dB (typical), BBX-2, ANT-2=__ dB

u carrier 1 38 dB (minimum) prior to calibration BBX-1, ANT-2 = dB

BBX-3, ANT-3 = dB

- BBX-1, ANT-3 = dB

... continued on next page
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Optimization (Pre—ATP) Data Sheets

68P09258A31-A

Table A-11: TX BLO Calibration (3-S:

2—C Adjacent Channels)

OK | Parameter Specification Comments
BBX-7, ANT-4 = dB
a BBX-1, ANT-4 = dB
Calibrate | TX Bay Level Offset = 42 dB (typical), BBX-8, ANT-5=__ dB
u carrier 2 38 dB (minimum) prior to calibration BBX-1, ANT-5 = dB
BBX-9, ANT-6 = dB
- BBX-1, ANT-6 = dB
BBX-1, ANT-1 = dB
a BBX-1, ANT-1 = dB
Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-2, ANT-2=__ dB
u uct post calibration BBX-1, ANT-2 = dB

carrier 1 -
BBX-3, ANT-3 = dB
- BBX-1, ANT-3 = dB
BBX-7, ANT4 = dB
a BBX-1, ANT-4 = dB
Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution BBX-8, ANT-5=__ dB
u udit | st calibration BBX-r, ANT-5= _ dB
carrier 2 -
BBX-9, ANT-6 = dB
- BBX-1, ANT-6 = dB
Comments:
3—Carrier Adjacent Channels
4—Carrier Adjacent Channels

Table A-12: TX BLO Calibration (3—S: 3— or 4-C Adjacent Channels)

OK | Parameter Specification Comments
BBX-1, ANT-1 = dB
a BBX-1, ANT-1 = dB
Calibrate | TX Bay Level Offset = 42 dB (+4 dB) | BBX-2, ANT-2=___ dB
. carrier 1 prior to calibration BBX-r, ANT-2 = dB
BBX-3, ANT-3 = dB
- BBX-r1, ANT-3 = dB

... continued on next page
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68P09258A31-A Optimization (Pre—ATP) Data Sheets

Table A-12: TX BLO Calibration (3-S: 3— or 4-C Adjacent Channels)
OK | Parameter Specification Comments

BBX-7, ANT-1 = dB

- BBX-1, ANT-1 = dB

Calibrate | TX Bay Level Offset = 42 dB (+4 dB) | BBX-8, ANT-2=__ dB

. carrier 2 | prior to calibration BBX-r, ANT-2 = dB

BBX-9, ANT-3 = dB

- BBX-1, ANT-3 = dB

BBX—4, ANTH4 = dB

- BBX-1, ANT—4 = dB

Calibrate | TX Bay Level Offset = 42 dB (+4 dB) | BBX-5,ANT-5=__ dB

d carrier 3 prior to calibration BBX-r, ANT-5 = dB

BBX-6, ANT-6 = dB

- BBX-1, ANT-6 = dB

BBX-10, ANT-4= __ dB

a BBX-3, ANT-4= _ dB

Calibrate | TX Bay Level Offset = 42 dB (+4 dB) | BBX-11, ANT-5=__ dB

. carrier 4 | prior to calibration BBX-r, ANT-5 = dB

BBX-12, ANT-6 = __dB

- BBX-1, ANT-6 = dB

BBX-1, ANT-1 = dB

- BBX-1, ANT-1 = dB

Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-2, ANT-2=__ dB

u uct post calibration BBX-r, ANT-2 = dB
carrier 1 -

BBX-3, ANT-3 = dB

- BBX-1, ANT-3 = dB

BBX-7, ANT-1 = dB

- BBX-1, ANT-1 = dB

Cagbr(ail.ttlon 0 dB (+0.5 dB) for gain set resolution | BBX-8, ANT-2=__ dB

u uct post calibration BBX-r, ANT-2 = dB
carrier 2 -

BBX-9, ANT-3 = dB

- BBX-1, ANT-3 = dB

. .. continued on next page
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Optimization (Pre—ATP) Data Sheets

68P09258A31-A

Table A-12: TX BLO Calibration (3-S: 3— or 4-C Adjacent Channels)

OK | Parameter Specification Comments
BBX-4, ANTH4 = dB
a BBX-1, ANT-4 = dB
0 Caglilr(ailittlon 0 dB (+0.5 dB) for gain set resolution BBX-5, ANT-5=__ dB
carrier 3 post calibration BBX-1, ANT-5 = dB
BBX-6, ANT-6 = dB
- BBX-1, ANT-6 = dB
BBX-10, ANT-4=__ dB
a BBX-1, ANT-4 = dB
0 Caglilr(ailittlon 0 dB (+0.5 dB) for gain set resolution BBX-11, ANT-5=__ dB
carrier 4 post calibration BBX-1, ANT-5 = dB
BBX-12, ANT-6=__ dB
a BBX-1, ANT-6 = dB
Comments:
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Optimization (Pre—ATP) Data Sheets

TX BLO/Power Output Verification for 6-Sector Configurations

1-Carrier

2—Carrier Non—adjacent Channels

Table A-13: TX BLO Calibration (6-S: 1-C, 2—C Non-adjacent Channels)
OK | Parameter Specification Comments

BBX-1,ANT-1=__ dB

a BBX-1, ANT-1=__ dB
BBX-2, ANT-2 = dB

a BBX-1, ANT-2 = :dB
BBX-3, ANT-3=__ dB

- Calibrate | TX Bay Level Offset = 42 dB (typical), BBX-r, ANT-3=___dB
carrier 1 | 38 dB (minimum) prior to calibration BBX—4, ANT—4 = dB

a BBX-1, ANT-4 = :dB
BBX-5,ANT-5=_ dB

a BBX-r, ANT-5=_ dB
BBX-6, ANT-6=__ dB

a BBX-r, ANT-6=_ dB
BBX-7,ANT-1=__ dB

a BBX-1, ANT-1=__ dB
BBX-8, ANT-2=__ dB

a BBX-1, ANT-2=_ dB
BBX-9, ANT-3=__ dB

- Calibrate | TX Bay Level Offset = 42 dB (typical), BBX-r, ANT-3=___dB
carrier 2 | 38 dB (minimum) prior to calibration BBX-10, ANT—4 = dB

- BBX-3, ANT-4 = :dB
BBX-11, ANT-5=__ dB

a BBX-r, ANT-5=_ dB
BBX-12, ANT-6=__ dB

a BBX-r, ANT-5=_ dB

... continued on next page
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Optimization (Pre—ATP) Data Sheets

68P09258A31-A

Table A-13: TX BLO Calibration (6-S: 1-C, 2-C Non—adjacent Channels)

OK | Parameter Specification Comments
BBX-1,ANT-1=___ dB
a BBX-1, ANT-1=___ dB
BBX-2, ANT-2 = dB
a BBX-1, ANT-2 = :dB
BBX-3,ANT-3=___ dB
- Cagtzlr(allit: oM 1odB (+0.5 dB) for gain set resolution BBX-r, ANT-3=___ dB
. post calibration BBX-4. ANT—4 = dB
0 carrier 1 s o
BBX-1, ANT-4=__ dB
BBX-5, ANT-5=_ dB
a BBX-1, ANT-5=_ dB
BBX-6, ANT-6 = dB
a BBX-1, ANT-6 = :dB
BBX-7, ANT-1 = dB
a BBX-1, ANT-1 = :dB
BBX-8, ANT-2=__ dB
a BBX-1, ANT-2=___ dB
BBX-9, ANT-3=___ dB
- Cagtzlr(allit: oM 1odB (iQ.5 dB) for gain set resolution BBX-r, ANT-3=___ dB
q carrier 2 post calibration BBX-10, ANT-4 = _ dB
BBX-1, ANT-4=__ dB
BBX-11, ANT-5=__ dB
a BBX-1, ANT-5=_ dB
BBX-12, ANT-6=__ dB
a BBX-1, ANT-6=___ dB
Comments:
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68P09258A31-A Optimization (Pre—ATP) Data Sheets

BTS Redundancy/Alarm Tests A

Table A-14: BTS Redundancy/Alarm Tests
OK Parameter Specification Data
(] |SIF: Misc. alarm tests Verify per procedure
(] |MGLI redundancy test Verify per procedure
(] |GLIredundancy test Verify per procedure
Power supply/converter Verify per procedure
u redundancy
[ |Misc. alarm tests Verify per procedure
CSM, GPS, & LFR Verify per procedure
- redundancy/alarm tests
(] |LPA redundancy test Verify per procedure
Comments:
TX Antenna VSWR
Table A-15: TX Antenna VSWR
OK Parameter Specification Data
VSWR — <(15:1)
- Antenna 1
VSWR — <(15:1)
- Antenna 2
VSWR — <(15:1)
u Antenna 3
VSWR — <(15:1)
- Antenna 4
VSWR — <(15:1)
u Antenna 5
VSWR - <(15:1)
u Antenna 6
Comments:
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Optimization (Pre—ATP) Data Sheets

68P09258A31-A

RX Antenna VSWR
Table A-16: RX Antenna VSWR
OK Parameter Specification Data
VSWR — <(15:1)
u Antenna 1
VSWR — <(15:1)
u Antenna 2
VSWR — <(15:1)
J Antenna 3
VSWR — <(15:1)
u Antenna 4
VSWR — <(15:1)
J Antenna 5
VSWR - <(15:1)
J Antenna 6
Comments:
AMR Verification
Table A-17: AMR CDI Alarm Input Verification
OK Parameter Specification Data

Verify CDI alarm input
operation (“ALARM A”
(numbers 1 -18)

BTS Relay #XX —
Contact Alarm
Sets/Clears

Verify CDI alarm input

BTS Relay #XX —

[ |operation (“ALARM B” Contact Alarm
(numbers 19 —-36) Sets/Clears
Comments:
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Site Serial Number Check List A

C-CCP Shelf

Site/OA & B
C—-CCP Shelf
CSM-1
CSM-2
HSO
CCD-1
CCD-2
AMR-1
AMR-2
MPC-1
MPC-2
Fans 1-3
GLI-1
GLI-2
BBX-1
BBX-2
BBX-3
BBX—4
BBX-5
BBX-6
BBX-7
BBX-8
BBX-9
BBX-10
BBX-11
BBX-12
BBX-—r
MCC-1
MCC-2
MCC-3
MCC+4
MCC-5
MCC-6
MCC-7
MCC-8
MCC-9
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Site Serial Number Check List

68P09258A31-A

LPAs

MCC-10
MCC-11
MCC-12
CIO
SWITCH
PS-1
PS-2
PS-3

LPA 1A
LPA 1B
LPA 1C
LPA 1D
LPA 2A
LPA 2B
LPA 2C
LPA 2D
LPA 3A
LPA 3B
LPA 3C
LPA 3D
LPA 4A
LPA 4B
LPA 4C
LPA 4D

Power Conversion Shelf (—48 V BTS Only)

AMR
PS 4
PS5
PS 6
PS 7
PS8
PS9
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Appendix B

PN Offset/l & Q Offset Register

Programming Information
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PN Offset Programming Information 68P09258A31-A

PN Offset Programming Information

PN Offset Background

PN Offset Usage

All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 128 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Opverall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBXs, where the corresponding
I & Q registers reside.

The PN offset values are determined on a per BT'S/per sector(antenna)
basis as determined by the appropriate cdf file content. A breakdown of
this information is found i Jable B-1.

Only the 14—chip delay is currently in use. It is important to determine
the RF chip delay to be able to test the BTS functionality. This can be
done by ascertaining if the CDF file FineTxAdj value was set to “on”
when the MCC was downloaded with “image data”. The FineTxAdj
value is used to compensate for the processing delay (approximately
20 uS) in the BTS using any type of mobile meeting [S-97
specifications.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 74 chip table.

NOTE

CDF file I and Q values can be represented in DECIMAL or
HEX. If using HEX, add Ox before the HEX value. If necessary,
convert HEX values irJable B-1 to decimal before comparing
them to cdf file I & Q value assignments.

B-2
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PN Offset Programming Information

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q I Q
PN (Dec.) (Hex.)
0 17523 23459 4473 5BA3
1 32292 32589 7E24 7F4D
2 4700 17398 125C 43F6
3 14406 26333 3846 66DD
4 14899 4011 3A33 OFAB
5 17025 2256 4281 08D0
6 14745 18651 3999 48DB
7 2783 1094 OADF 0446
8 5832 21202 16C8 52D2
9 12407 13841 3077 3611
10 31295 31767 7A3F 7C17
11 7581 18890 1D9D 49CA
12 18523 30999 4858 7917
13 29920 22420 74E0 5794
14 25184 20168 6260 4EC8
15 26282 12354 66AA 3042
16 30623 11187 779F 2BB3
17 15540 11834 3CB4 2E3A
18 23026 10395 59F2 289B
19 20019 28035 4E33 6D83
20 4050 27399 0FD2 6B07
21 1557 22087 0615 5647
22 30262 2077 7636 081D
23 18000 13758 4650 35BE
24 20056 11778 4E58 2E02
25 12143 3543 2F6F 0DD7
26 17437 7184 441D 1C10
27 17438 2362 441E 093A
28 5102 25840 13EE 64F0
29 9302 12177 2456 2F91
30 17154 10402 4302 28A2
31 5198 1917 144E 077D
32 4606 17708 11FE 452C
33 24804 10630 60E4 2986
34 17180 6812 431C 1A9C
35 10507 14350 290B 380E
36 10157 10999 27AD 2AF7
37 23850 25003 5D2A 61AB
38 31425 2652 7AC1 0A5C
39 4075 19898 OFEB 4DBA
40 10030 2010 272E 07DA
41 16984 25936 4258 6550
42 14225 28531 3791 6F73
43 26519 11952 6797 2EBO
44 27775 31947 6C7F 7CCB
45 30100 25589 7594 63F5
46 7922 11345 1EF2 2¢51
47 14199 28198 3777 6E26
48 17637 13947 44E5 367B
49 23081 8462 5A29 210E
50 5099 9595 13EB 257B

.. . continued on next page
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q | Q
PN (Dec.) (Hex.)
51 32743 4670 7FE7 123E
52 7114 14672 1BCA 3950
53 7699 29415 1E13 72E7
54 19339 20610 4B8B 5082
55 28212 6479 6E34 194F
56 29587 10957 7393 2ACD
57 19715 18426 4D03 47FA
58 14901 22726 3A35 58C6
59 20160 5247 4ECO 147F
60 22249 29953 56E9 7501
61 26582 5796 67D6 16A4
62 7153 16829 1BF1 41BD
63 15127 4528 3B17 11B0
64 15274 5415 3BAA 1527
65 23149 10294 5A6D 2836
66 16340 17046 3FD4 4296
67 27052 7846 69AC 1EA6
68 13519 10762 34CF 2A0A
69 10620 13814 297¢C 35F6
70 15978 16854 3E6A 41D6
71 27966 795 6D3E 031B
72 12479 9774 30BF 262E
73 1536 24291 0600 5EE3
74 3199 3172 0C7F 0C64
75 4549 2229 11¢5 08B5
76 17888 21283 45E0 5323
77 13117 16905 333D 4209
78 7506 7062 1D52 1B96
79 27626 7532 6BEA 1D6C
80 31109 25575 7985 63E7
81 29755 14244 743B 37A4
82 26711 28053 6857 6D95
83 20397 30408 4FAD 76C8
84 18608 5094 48B0 13E6
85 7391 16222 1CDF 3F5E
86 23168 7159 5A80 1BF7
87 23466 174 5BAA 00AE
88 15932 25530 3E3C 63BA
89 25798 2320 64C6 0910
90 28134 23113 6DE6 5A49
91 28024 23985 6D78 5DB1
92 6335 2604 18BF 0A2C
93 21508 1826 5404 0722
94 26338 30853 66E2 7885
95 17186 15699 4322 3D53
96 22462 2589 57BE 0A1D
97 3908 25000 0F44 61A8
98 25390 18163 632E 46F3
99 27891 12555 6CF3 3108
100| 9620 8670 2594 21DE

.. . continued on next page
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68P09258A31-A PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn
14-Chip Delay

Pilot | Q I Q

PN (Dec.) (Hex.)
101| 6491 1290 195B 0504
102| 16876 4407 41EC 1137
103| 17034 1163 428A 048B
104 | 32405 12215 7E95 2FB7
105| 27417 7253 6B19 1¢55
106 8382 8978 20BE 2312
107| 5624 25547 15F8 63CB
108 1424 3130 0590 0Cc3a
109 13034 31406 32EA 7AAE
110| 15682 6222 3D42 184E
111| 27101 20340 69DD 4F74
112| 8521 25094 2149 6206
113 30232 23380 7618 5B54
114 6429 10926 191D 2AAE
115| 27116 22821 69EC 5925
116| 4238 31634 108E 7B92
117| 5128 4403 1408 1133
118 14846 689 39FE 02B1
119| 13024 27045 32E0 69A5
120| 10625 27557 2981 6BA5
121| 31724 16307 7BEC 3FB3
122| 13811 22338 35F3 5742
123| 24915 27550 6153 6BIE
124| 1213 22096 04BD 5650
125 2290 23136 08F2 5460
126 31551 12199 7B3F 2FA7
127| 12088 1213 2F38 04BD
128| 7722 936 1E2A 03A8
129 | 27312 6272 6AB0 1880
130 23130 32446 S5A5A 7EBE
131 594 13555 0252 34F3
132 25804 8789 64CC 2255
133 31013 24821 7925 60F5
134 32585 21068 TF49 524C
135 3077 31891 0CO05 7C93
136 17231 5321 434F 14C9
137| 31554 551 7B42 0227
138| 8764 12115 223C 2F53
139 15375 4902 3COF 1326
140 13428 1991 3474 07¢7
141| 17658 14404 44FA 3844
142| 13475 17982 34A3 463E
143 22095 19566 564F 4C6E
144 | 24805 2970 60E5 0B9A
145 4307 23055 10D3 S5A0F
146 23292 15158 5AFC 3B36
147| 1377 29094 0561 7146
148 28654 653 6FEE 028D
149 6350 19155 18CE 4AD3
150 16770 23588 4182 5C24

.. . continued on next page
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68P09258A31-A

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q | Q
PN (Dec.) (Hex.)
151| 14726 10878 3986 2A7E
152| 25685 31060 6455 7954
153| 21356 30875 536C 7898
154 | 12149 11496 2F75 2CES8
155| 28966 24545 7126 5FE1
156| 22898 9586 5972 2572
157 1713 20984 06B1 51F8
158| 30010 30389 753A 76B5
159| 2365 7298 093D 1c82
160 | 27179 18934 6A2B 49F6
161| 29740 23137 742C 5A61
162| 5665 24597 1621 6015
163| 23671 23301 5C77 5B05
164| 1680 7764 0690 1E54
165| 25861 14518 6505 38B6
166 | 25712 21634 6470 5482
167| 19245 11546 4B2D 2D1A
168| 26887 26454 6907 6756
169| 30897 15938 78B1 3E42
170| 11496 9050 2CE8 235A
171 1278 3103 04FE 0C1F
172| 31555 758 7B43 02F6
173| 29171 16528 71F3 4090
174| 20472 20375 4FF8 4F97
175| 5816 10208 16B8 27E0
176 | 30270 17698 763E 4522
177| 22188 8405 56AC 20D5
178| 6182 28634 1826 6FDA
179 32333 1951 7E4D 079F
180 | 14046 20344 36DE 4F78
181| 15873 26696 3E01 6848
182| 19843 3355 4D83 0D1B
183| 29367 11975 72B7 2EC7
184 13352 31942 3428 7cC6
185 22977 9737 59C1 2609
186| 31691 9638 7BCB 25A6
187| 10637 30643 298D 77B3
188| 25454 13230 636E 33AE
189| 18610 22185 48B2 56A9
190| 6368 2055 18E0 0807
191 7887 8767 1ECF 223F
192 7730 15852 1E32 3DEC
193| 23476 16125 5BB4 3EFD
194| 889 6074 0379 17BA
195| 21141 31245 5295 7A0D
196 20520 15880 5028 3E08
197| 21669 20371 54A5 4F93
198| 15967 8666 3ESF 21DA
199| 21639 816 5487 0330
200| 31120 22309 7990 5725

.. . continued on next page
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PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q | Q
PN (Dec.) (Hex.)
201| 3698 29563 0E72 737B
202 16322 13078 3FC2 3316
203 | 17429 10460 4415 28DC
204 21730 17590 54E2 44B6
205| 17808 20277 4590 4F35
206| 30068 19988 7574 4E14
207 | 12737 6781 31c1 1A7D
208 | 28241 32501 6E51 7EF5
209| 20371 6024 4F93 1788
210| 13829 20520 3605 5028
211| 13366 31951 3436 7CCF
212 25732 26063 6484 65CF
213 19864 27203 4D98 6A43
214 5187 6614 1443 19D6
215 23219 10970 5AB3 2ADA
216 28242 5511 6E52 1587
217 | 6243 17119 1863 42DF
218 445 16064 01BD 3ECO
219 21346 31614 5362 7B7E
220| 13256 4660 33cs8 1234
221 18472 13881 4828 3639
222 25945 16819 6559 41B3
223 31051 6371 794B 18E3
224 1093 24673 0445 6061
225| 5829 6055 16C5 17A7
226| 31546 10009 7B3A 2719
227| 29833 5957 7489 1745
228 18146 11597 46E2 2D4D
229 24813 22155 60ED 568B
230| 47 15050 002F 3ACA
231| 3202 16450 0C82 4042
232 21571 27899 5443 6CFB
233| 7469 2016 1D2D 07E0
234 25297 17153 62D1 4301
235| 8175 15849 1FEF 3DE9
236| 28519 30581 6F67 7775
237| 4991 3600 137F 0E10
238| 7907 4097 1EE3 1001
239 17728 671 4540 029F
240 14415 20774 384F 5126
241 30976 24471 7900 5F97
242 26376 27341 6708 6ACD
243| 19063 19388 4A77 4BBC
244 19160 25278 4AD8 62BE
245| 3800 9505 0ED8 2521
246| 8307 26143 2073 661F
247 12918 13359 3276 342F
248 19642 2154 4CBA 086A
249 24873 13747 6129 35B3
250 22071 27646 5637 6BFE

.. . continued on next page
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q I Q
PN (Dec.) (Hex.)
251| 13904 1056 3650 0420
252 27198 1413 6A3E 0585
253 | 3685 3311 0E65 OCEF
254| 16820 4951 41B4 1357
255| 22479 749 57CF 02ED
256 6850 6307 1AC2 18A3
257| 15434 961 3c4a 03C1
258 | 19332 2358 4B84 0936
259 8518 28350 2146 6EBE
260 14698 31198 396A 79DE
261| 21476 11467 53E4 2CCB
262 30475 8862 7708 229E
263 23984 6327 5DB0 18B7
264 1912 7443 0778 1D13
265| 26735 28574 686F 6F9E
266 15705 25093 3D59 6205
267 | 3881 6139 0F29 17FB
268| 20434 22047 4FD2 561F
269 16779 32545 418B 7F21
270| 31413 7112 7AB5 1BC8
271| 16860 28535 41DC 6F77
272| 8322 10378 2082 288A
273| 28530 15065 6F72 3AD9
274| 26934 5125 6936 1405
275| 18806 12528 4976 30F0
276| 20216 23215 4EF8 5AAF
277| 9245 20959 241D 51DF
278| 8271 3568 204F ODFO
279| 18684 26453 48FC 6755
280 | 8220 29421 201C 72ED
281 6837 24555 1AB5 5FEB
282 9613 10779 258D 2A1B
283 31632 25260 7B90 62AC
284 | 27448 16084 6B38 3ED4
285| 12417 26028 3081 65AC
286 30901 29852 78B5 749C
287 | 9366 14978 2496 3A82
288| 12225 12182 2FC1 2F96
289 | 21458 25143 53D2 6237
290 | 6466 15838 1942 3DDE
291 8999 5336 2327 14D8
292| 26718 21885 685E 557D
293 3230 20561 0C9E 5051
294 27961 30097 6D39 7591
295| 28465 21877 6F31 5575
296 6791 23589 1A87 5C25
297 | 17338 26060 43BA 65CC
298| 11832 9964 2E38 26EC
299 11407 25959 2C8F 6567
300 15553 3294 3ccl OCDE

.. . continued on next page
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PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q | Q
PN (Dec.) (Hex.)
301| 17418 30173 440A 75DD
302| 14952 15515 3168 3C9B
303| 52 5371 0034 14FB
304 27254 10242 6A76 2802
305| 15064 28052 3AD8 6D94
306 10942 14714 2ABE 397A
307| 377 19550 0179 4CSE
308| 14303 8866 37DF 22A2
309 | 24427 15297 5F6B 3BC1
310| 26629 10898 6805 2R92
311 20011 31315 4E2B 7A53
312| 16086 19475 3ED6 4C13
313 | 24374 1278 5F36 04FE
314 9969 11431 26F1 2CA7
315| 29364 31392 72B4 7AA0
316| 25560 4381 63D8 111D
317 28281 14898 6E79 3A32
318| 7327 23959 1C9F 5D97
319| 32449 16091 7EC1 3EDB
320| 26334 9037 66DE 234D
321 14760 24162 39A8 5E62
322| 15128 6383 3B18 18EF
323 29912 27183 74D8 6A2F
324 4244 16872 1094 41E8
325| 8499 9072 2133 2370
326| 9362 12966 2492 32R6
327 10175 28886 27BF 70D6
328| 30957 25118 78ED 621E
329 12755 20424 31D3 4FC8
330| 19350 6729 4B96 1A49
331 1153 20983 0481 51F7
332 29304 12372 7278 3054
333| 6041 13948 1799 367C
334 21668 27547 54A4 6B9B
335| 28048 8152 6D90 1FD8
336| 10096 17354 2770 43ca
337| 23388 17835 5B5C 45AB
338| 15542 14378 3CB6 382A
339| 24013 7453 5DCD 1D1D
340| 2684 26317 0A7C 66CD
341| 19018 5955 4R4A 1743
342| 25501 10346 639D 286A
343| 4489 13200 1189 3390
344 31011 30402 7923 76C2
345 29448 7311 7308 1C8F
346| 25461 3082 6375 0COA
347 11846 21398 2E46 5396
348| 30331 31104 7678 7980
349| 10588 24272 295¢C 5EDO
350 32154 27123 7D9A 69F3

.. . continued on next page
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q | Q
PN (Dec.) (Hex.)
351| 29572 5578 7384 15CA
352 13173 25731 3375 6483
353| 10735 10662 29EF 29A6
354| 224 11084 00E0 2B4C
355| 12083 31098 2F33 797A
356| 22822 16408 5926 4018
357| 2934 6362 0B76 18DA
358| 27692 2719 6C2C 0A9F
359| 10205 14732 27DD 398C
360 7011 22744 1B63 58D8
361| 22098 1476 5652 05C4
362| 2640 8445 0A50 20FD
363| 4408 21118 1138 527E
364| 102 22198 0066 56B6
365| 27632 22030 6BFO 560E
366| 19646 10363 4CBE 287B
367| 26967 25802 6957 64CA
368| 32008 2496 7D08 09CO
369| 7873 31288 1EC1 7A38
370| 655 24248 028F 5EBS
371 25274 14327 62BA 37F7
372 16210 23154 3F52 5A72
373| 11631 13394 2D6F 3452
374| 8535 1806 2157 070E
375 19293 17179 4B5D 431B
376 12110 10856 2F4E 2A68
377 21538 25755 5422 649B
378| 10579 15674 2953 3D3A
379| 13032 7083 32E8 1BAB
380| 14717 29096 397D 71A8
381| 11666 3038 2D92 0BDE
382| 25809 16277 64D1 3F95
383| 5008 25525 1390 63B5
384| 32418 20465 7EA2 4FF1
385| 22175 28855 569F 70B7
386 11742 32732 2DDE 7FDC
387| 22546 20373 5812 4F95
388| 21413 9469 53A5 24FD
389| 133 26155 0085 662B
390| 4915 6957 1333 1B2D
391| 8736 12214 2220 2FB6
392 1397 21479 0575 53E7
393| 18024 31914 4668 7CAA
394| 15532 32311 3CAC 7TE37
395| 26870 11276 68F6 2coc
396| 5904 20626 1710 5092
397 | 24341 423 5F15 01A7
398| 13041 2679 32F1 0A77
399| 23478 15537 5BB6 3CB1
400| 1862 10818 0746 2A42

.. . continued on next page
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PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q | Q
PN (Dec.) (Hex.)
401| 5850 23074 16DA 5A22
402| 5552 20250 15B0 4F1A
403| 12589 14629 312D 3925
404| 23008 29175 59E0 71F7
405| 27636 13943 6BF4 3677
406 17600 11072 44C0 2B40
407 | 17000 29492 4268 7334
408| 21913 5719 5599 1657
409| 30320 7347 7670 1CB3
410 28240 12156 6E50 2F7C
411 7260 25623 1c5C 6417
412 17906 27725 45F2 6C4D
413| 5882 28870 16FA 70C6
414 22080 31478 5640 7AF6
415 12183 28530 2F97 6F72
416 23082 24834 5A2A 6102
417 17435 9075 441B 2373
418 18527 32265 485F 7E09
419 31902 3175 7C9E 0C67
420 18783 17434 495F 441a
421 20027 12178 4E3B 2F92
422 7982 25613 1F2E 640D
423| 20587 31692 5068 7BCC
424 10004 25384 2714 6328
425| 13459 18908 3493 49DC
426| 13383 25816 3447 64D8
427 28930 4661 7102 1235
428 4860 31115 12FC 798B
429| 13108 7691 3334 1E0B
430 24161 1311 5E61 051F
431 20067 16471 4E63 4057
432 2667 15771 0A6B 3D9B
433 13372 16112 343cC 3EF0
434 28743 21062 7047 5246
435| 24489 29690 5FA9 73FA
436 249 10141 00F9 279D
437| 19960 19014 4DF8 4A46
438 29682 22141 73F2 567D
439 31101 11852 797D 2E4C
440 27148 26404 6A0C 6724
441| 26706 30663 6852 77C7
442 5148 32524 141c 7F0C
443 4216 28644 1078 6FE4
444 5762 10228 1682 27F4
445 245 23536 00F5 5BF0
446 21882 18045 557A 467D
447 3763 25441 0EB3 6361
448| 206 27066 00CE 69BA
449 28798 13740 707E 35AC
450 | 32402 13815 7E92 35F7

.. . continued on next page
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ﬂable B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip Delay

Pilot I Q | Q
PN (Dec.) (Hex.)
451| 13463 3684 3497 0E64
452 15417 23715 3c39 5CA3
453 23101 15314 5A3D 3BD2
454 14957 32469 3A6D 7ED5
455| 23429 9816 5B85 2658
456 12990 4444 32BE 115¢C
457 12421 5664 3085 1620
458| 28875 7358 70CB 1CBE
459| 4009 27264 0FA9 6A80
460 | 1872 28128 0750 6DEO
461| 15203 30168 3B63 75D8
462| 30109 29971 759D 7513
463| 124001 3409 5DC1 0D51
464 4862 16910 12FE 420E
465| 14091 20739 370B 5103
466| 6702 10191 1A2E 27CF
467| 3067 12819 0BFB 3213
468| 28643 19295 6FE3 4BSF
469| 21379 10072 5383 2758
470 20276 15191 4F34 3B57
471| 25337 27748 62F9 6C64
472 19683 720 4CE3 02D0
473 10147 29799 27A3 7467
474 16791 27640 4197 6BF8
475| 17359 263 43CF 0107
476 13248 24734 33co 609E
477| 22740 16615 58D4 40E7
478| 13095 20378 3327 4F9A
479 10345 25116 2869 621C
480| 30342 19669 7686 4CD5
481| 27866 14656 6CDA 3940
482| 9559 27151 2557 6A0F
483| 8808 28728 2268 7038
484 12744 25092 31c8 6204
485 11618 22601 2D62 5849
486 27162 2471 6A1A 09A7
487| 17899 25309 45EB 62DD
488| 29745 15358 7431 3BFE
489 | 31892 17739 7C94 454B
490| 23964 12643 5D9C 3163
491| 23562 32730 5C0A 7FDA
492 2964 19122 0B94 4AB2
493| 18208 16870 4720 41E6
494 15028 10787 3AB4 2A23
495| 21901 18400 558D 47E0
496 | 24566 20295 5FF6 4F47
497 18994 1937 4A32 0791
498| 13608 17963 3528 462B
499 27492 7438 6B64 1DOE
500| 11706 12938 2DBA 328a

.. . continued on next page
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68P09258A31-A PN Offset Programming Information

ﬂable B-1: PnMask I and PnMask Q Values for PilotPn
14-Chip Delay

Pilot | Q I Q

PN (Dec.) (Hex.)
501 14301 19272 37DD 4B48
502 23380 29989 5B54 7525
503 11338 8526 2C4A 214E
504 2995 18139 0BB3 46DB
505 23390 3247 5B5E 0CAF
506 14473 28919 3889 70F7
507 6530 7292 1982 1Cc7¢C
508 | 20452 20740 4FE4 5104
509 | 12226 27994 2FC2 6D5A
510 1058 2224 0422 08B0
5111 12026 6827 2EFA 1AAB
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FRU Optimization/ATP Test Matrix

Usage & Background

Periodic maintenance of a site may also may mandate re—optimization of
specific portions of the site. An outline of some basic guidelines is
included in the following tables.

NOTE

Re—optimization steps listed for any assembly detailed in the
tables below must be performed anytime an RF cable associated

with it is replaced.

BTS Frame
Table C-1: When RF Optimization is required on the BTS
Item Replaced Optimize:

C—CCP Shelf All sector TX and RX paths to all
Combined CDMA Channel Processor
(C-CCP) shelves.

Multicoupler/ The three or six affected sector RX paths for

Preselector Card the C—CCP shelf in the BTS frames.

BBX board RX and TX paths of the affected C-CCP
shelf / BBX board.

CIO Card All RX and TX paths of the affected

CDMA carrier.

Any LPA Module

The affected sector TX path.

LPA Backplane

The affected sector TX path.

LPA Filter

The affected sector TX path.

Ancillary Frame

Item Replaced

Optimize:

Directional Coupler

All affected sector RX and TX paths to all
BTS frame shelves.

Site filter

All affected RX sector paths in all shelves
in all BTS frames.

Any RFDS component
or TSU.

The RFDS calibration RX & TX paths
(MONFWD/GENFWD).

C-2 1X SC™ 4812T BTS Optimization/ATP
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FRU Optimization/ATP Test Matrix

Inter-frame Cabling

Optimization must be performed after the replacement of any RF cabling
between BTS frames.

Table C-2: When to Optimize Inter—frame Cabling

Item Replaced Optimize:
Ancillary frame to BTS The affected sector/antenna RX
frame (RX) cables paths.

BTS frame to ancillary frame | The affected sector/antenna TX paths.
(TX) cables

Detailed Optimization/ATP Test Matrix

able C-3 outlines in more detail the tests that would need to be
performed if one of the BTS components were to fail and be replaced. It
is also assumes that all modules are placed OOS—ROM via the LMF
until full redundancy of all applicable modules is implemented.

The following guidelines should also be noted when using this table.

NOTE

Not every procedure required to bring the site back on line is
indicated ijable C-3. It is meant to be used as a guideline
ONLY. The table assumes that the user is familiar enough with
the BTS Optimization/ATP procedure to understand which test
equipment set ups, calibrations, and BTS site preparation will be
required before performing the Table # procedures referenced.

Various passive BTS components (such as the TX and RX directional
couplers, Preselector 10, CIO; etc.) only call for a TX or RX calibration
audit to be performed in lieu of a full path calibration. If the RX or TX
path calibration audit fails, the entire RF path calibration will need to be
repeated. If the RF path calibration fails, further troubleshooting is
warranted.

Whenever any C—-CCP BACKPLANE is replaced, it is assumed that
only power to the C—CCP shelf being replaced is turned off via the
breaker supplying that shelf.

Whenever any DISTRIBUTION BACKPLANE is replaced it is assumed
that the power to the entire RFM frame is removed and the Preselector
I/O is replaced. The modem frame should be brought up as if it were a
new installation.

NOTE

If any significant change in signal level results from any
component being replaced in the RX or TX signal flow paths, it
would be identified by re—running the RX and TX calibration
audit command.

When the CIO is replaced, the C—CCP shelf remains powered up. The
BBX boards may need to be removed, then re—installed into their
original slots, and re~downloaded (code and BLO data). RX and TX
calibration audits should then be performed.

Oct 2003 1X SC™ 4812T BTS Optimization/ATP C-3




HoN

FRU Optimization/ATP Test Matrix
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Table C-3: SC 4812T BTS Optimization and ATP Test Matrix

o
5 & 2 &3
A 2 8 £ 2
3| 3 © m L s
o| © = ®
o| O =3 o ol =
S aaf |8 g g8z
Doc c S «| O g % m (o] c -g 5’, ($]
Thl 22238 35 & a @ 2l 8¢ s
8| 8| & = o I e | Sl w
o O (SRS Q| = (7] =
o 4e = = ol © x o - <« K| 3 [a]
# page Description G a8 & 2285488858 0YYy%52 &k
Initial Boards/Modules Install, o
Gable 2-1 |j-3 Prelimnary Operations, CDF o/ 0o/ 0/ 0 0 0 0 0 0 0 0 0 0 0 00 0 . o o0
Site Equipage; etc.
able 2-2 -6 | DC Power Pre-Test Physical o o
able 2-5 [3-14 | Inspect
Gable 2-7 Ij-lS Initial Power-up ) o e x °
able 3-11 3-34 | Ping the Processors o oo e ° °
able 3-13 3-38 | Download/Enable MGLIs ° ° °
able 3-13 3-38 | Download/Enable GLIs ° ° °
able 3-14 3-39 | Download CSMs ° ° ° °
able 3-14 3-39 | Download MCCs ° ° ° °
able 3-14 3-39 | Download BBXs o o °
able 3-16 [3-41 | Enable CSMs ° °
able 3-17 [3-42 | Enable MCCs ° °
GPS Initialization /
jable 3-20 |j_49 Verification * ° °
LFR Initialization /
jable 321 |j_53 Verification * *
able 3-22 r3-55 | HSO Initialization/Verification ° °
¢ Required

=+ Replace power converters one card at a time so that power to the C—CCP or LPA shelf is not lost. If power to

the C—CCP shelf is lost, all cards in the shelf must be downloaded again.
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Table C-3: SC 4812T BTS Optimization and ATP Test Matrix

Doc
Tbl
# page Description

Directional Coupler (RX)
Directional Coupler (TX)

RX Filter
LPA Trunking Backplane

MPC/EMPC

clo

C—-CCP Backplane
LFR/HSO

GPS

LPA

LPA Bandpass Filter
Power Supply Modules
Switch Card

RFDS

TX Cables
GLI

RX Cables
BBX
MCC
CSM

able 3-37 3-92 | TX Path Calibration *

able 3-38 3-94 | Download Offsets to BBX *

able 3-39 [3-96 | TX Path Calibration Audit *

RFDS Path Calibration "

jable 3-48 [3_107 Procedure (see Note ) m m B m OO m ERE| EI

+ RFDS Path Calibration should be performed at initial BTS installation AND after replacement of the RFDS FRU.
RFDS Path Calibration is NOT required for other FRU replacement but may be used as an additional fault isolation tool.

rHable 4-1 [4-9 | Spectral Purity TX Mask ATP o[ | | *
rfable 4-1 4-9 | Waveform Quality (tho) ATP * * S R
ﬁable 4-1 |j-9 Pilot Time Offset ATP * * B x| x| x| ok
Code Domain Power / Noise I N
Gable 41 |j_9 Floor EI EI EII Ij m m m m
ﬁable 4-1 |j-9 FER Test *

* Perform if necessary for additional fault isolation, repair assurance, or site certification.
1 Perform on all carrier and sector TX paths to the C—-CCP cage.

2 Perform on all carrier and sector RX paths to the C—-CCP cage.

3 Perform on all primary and redundant TX paths of the affected carrier.

4

Perform on the affected carrier and sector TX paths. (BBXR replacement affects all carrier and sector TX
paths.)

5 Perform on the affected carrier and sector RX paths. (BBXR replacement affects all carrier and sector RX
paths.)

6 Perform on all RF paths of the affected carrier and sector (RFDS replacement affects all carriers.)

7 Perform with redundant BBX for all sectors on all carriers.

8 Verify performance by performing on one sector of one carrier only.
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Notes
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BBX Gain Set Point vs. BTS Output
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BBX Gain Set Point vs. BTS Output Considerations

Usage & Background

able D-1 outlines the relationship between the fotal of all code domain
channel element gain settings (digital root sum of the squares) and the
BBX Gain Set Point between 33.0 dBm and 44.0 dBm. The resultant RF
output (as measured at the top of the BTS in dBm) is shown in the table.
The table assumes that the BBX Bay Level Offset (BLO) values have
been calculated.

As an illustration, consider a BBX keyed up to produce a CDMA carrier
with only the Pilot channel (no MCCs forward link enabled). Pilot gain
is set to 262. In this case, the BBX Gain Set Point is shown to correlate
exactly to the actual RF output anywhere in the 33 to 44 dBm output
range. (This is the level used to calibrate the BTS).

Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

HcH

dBm» 44 43 42 41 40 39 38 37 36 35 34 33
Gaine

541 - - - - - - - 43.3 423 413 403 393
533 - - - - - - - 432 422 412 402 39.2
525 - - - - - - 44 43 42 41 40 39

517 - - - - - - 439 429 419 409 399 389
509 - - - - - - 438 428 418 408 398 38.8
501 - - - - - - 436 426 416 406 39.6 38.6
493 - - - - - - 435 425 415 405 395 385
485 - - - - - - 434 424 414 404 394 384
477 - - - - - - 432 422 412 402 392 382
469 - - - - - - 431 421 411 401 39.1 381
461 - - - - - 439 429 419 409 399 389 37.9
453 - - - - - 438 428 418 408 39.8 388 37.8
445 - - - - - 436 426 416 406 396 386 37.6
437 - - - - - 434 424 414 404 394 384 374
429 - - - - - 433 423 413 403 393 383 373
421 - - - - - 431 421 411 401 391 38.1 37.1
413 - - - - 44 43 42 41 40 39 38 37

405 - - - - 438 428 418 408 398 388 37.8 36.8
397 - - - - 436 426 416 406 396 386 37.6 36.6
389 - - - - 434 424 414 404 394 384 374 364

... continued on next page

D-2 1X SC™ 4812T BTS Optimization/ATP Oct 2003
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Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)
dBm» 44 43 42 41 40 39 38 37 36 35 34 33
Gaine
381 - - - - 433 423 413 403 393 383 373 363
374 - - - - 431 421 411 401 391 381 37.1 36.1
366 - - - 439 429 419 409 399 389 379 369 359
358 - - - 43.7 427 417 407 39.7 387 377 36.7 357
350 - - - 435 425 415 405 395 385 375 365 355
342 - - - 433 423 413 403 393 383 373 36.3 353
334 - - - 431 4214 411 401 391 381 37.1 36.1 351
326 - - 439 429 419 409 399 389 379 369 359 349
318 - - 43.7 427 417 40.7 39.7 38.7 37.7 36.7 357 347
310 - - 435 425 415 405 395 385 375 365 355 345
302 - - 432 422 412 402 392 382 372 362 352 342
294 - 44 43 42 41 40 39 38 37 36 35 34
286 - 43.8 428 418 408 39.8 388 378 368 358 348 338
278 - 435 425 415 405 395 385 375 365 355 345 335
270 - 433 423 413 403 393 383 373 363 353 343 333
262 44 43 42 41 40 39 38 37 36 35 34 33
254 43.7 427 417 407 397 387 37.7 36.7 357 347 337 -
246 434 424 414 404 394 384 374 364 354 344 334 -
238 432 422 412 402 392 382 372 362 352 342 332 -
230 429 419 409 399 389 379 369 359 349 339 - -
222 426 416 406 396 386 376 36.6 356 346 33.6 - -
214 422 412 402 392 382 372 362 352 342 332 - -
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Notes
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Operating Frequency — North American PCS Bands

Introduction

Programming of each of the BTS BBX synthesizers is performed by the
BTS GLIs via the CHI bus. This programming data determines the
transmit and receive transceiver operating frequencies (channels) for

each BBX.

1900 MHz PCS Channels

fjigure E-1 shows the valid channels for the North American PCS
1900 MHz frequency spectrum. There are 10 CDMA wireline or
non—wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-1: North American PCS 1900 MHz Frequency Spectrum

CHANNEL
25

275

425

675

925

1175

FREQ (MHz)

RX X
1851.25 1931.25
1863.75 1943.75
1871.25 1951.25
1883.75 1963.75
1896.25 1976.25
1908.75 1988.75

... continued on next page
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Calculating 1900 MHz Center Frequencies

[Jable E-1 shows selected 1900 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

¢ TX =1930 + 0.05 * Channel#
Example: Channel 262
TX = 1930 + 0.05%262 = 1943.10 MHz
¢ RX=TX-80
Example: Channel 262
RX =1943.10 — 80 = 1863.10 MHz

Actual frequencies used depend on customer CDMA system frequency
plan.

Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard band on
both sides of the carrier.

Minimum frequency separation required between any CDMA carrier and
the nearest NAMPS/AMPS carrier is 900 kHz (center-to-center).

Table E-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number Transmit Frequency (MHz) Receive Frequency (MHz)
Decimal Hex Center Frequency Center Frequency
25 0019 1931.25 1851.25
50 0032 1932.50 1852.50
75 004B 1933.75 1853.75
100 0064 1935.00 1855.00
125 007D 1936.25 1856.25
150 0096 1937.50 1857.50
175 00AF 1938.75 1858.75
200 00C8 1940.00 1860.00
225 00E1 1941.25 1861.25
250 00FA 1942.50 1862.50
275 0113 1943.75 1863.75
300 012C 1945.00 1865.00
325 0145 1946.25 1866.25
350 015E 1947.50 1867.50
375 0177 1948.75 1868.75
400 0190 1950.00 1870.00
425 01A9 1951.25 1871.25
450 01C2 1952.50 1872.50
475 01DB 1953.75 1873.75
500 01F4 1955.00 1875.00
525 020D 1956.25 1876.25
550 0226 1957.50 1877.50
575 023F 1958.75 1878.75

... continued on next page
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[Table E-1: 1900 MHz TX and RX Frequency vs. Channel

Channel Number Transmit Frequency (MHz) Receive Frequency (MHz)
Decimal Hex Center Frequency Center Frequency
600 0258 1960.00 1880.00

625 0271 1961.25 1881.25

650 028A 1962.50 1882.50

675 02A3 1963.75 1883.75

700 02BC 1965.00 1885.00

725 02D5 1966.25 1886.25

750 02EE 1967.50 1887.50

775 0307 1968.75 1888.75

800 0320 1970.00 1890.00

825 0339 1971.25 1891.25

850 0352 1972.50 1892.50

875 036B 1973.75 1893.75

900 0384 1975.00 1895.00

925 039D 1976.25 1896.25

950 03B6 1977.50 1897.50

975 03CF 1978.75 1898.75
1000 0O3ES8 1980.00 1900.00
1025 0401 1981.25 1901.25
1050 041A 1982.50 1902.50
1075 0433 1983.75 1903.75
1100 044C 1985.00 1905.00
1125 0465 1986.25 1906.25
1150 047E 1987.50 1807.50
1175 0497 1988.75 1908.75
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800 MHz CDMA Channels

] igure E-2 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non—wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-2: North American Cellular Telephone System Frequency Spectrum
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Calculating 800 MHz Center Frequencies

[Jable E-2 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

® Channels 1-777
TX =870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03%262 = 877.86 MHz

¢ Channels 1013-1023
TX =870 + 0.03 * (Channel# — 1023)
Example: Channel 1015
TX =870 +0.03 *(1015 — 1023) = 869.76 MHz

e RX =TX-45 MHz
Example: Channel 262
RX = 877.86 —45 = 832.86 MHz

Table E-2: 800 MHz TX and RX Frequency vs. Channel
Channel Number Transmit Frequency (MHz) Receive Frequency (MHz)
Decimal Hex Center Frequency Center Frequency
1 0001 870.0300 825.0300
25 0019 870.7500 825.7500
50 0032 871.5000 826.5000

.. . continued on next page
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Table E-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number Transmit Frequency (MHz) Receive Frequency (MHz)
Decimal Hex Center Frequency Center Frequency
75 004B 872.2500 827.2500
100 0064 873.0000 828.0000
125 007D 873.7500 828.7500
150 0096 874.5000 829.5000
175 00AF 875.2500 830.2500
200 00C8 876.0000 831.0000
225 00E1 876.7500 831.7500
250 00FA 877.5000 832.5000
275 0113 878.2500 833.2500
300 012C 879.0000 834.0000
325 0145 879.7500 834.7500
350 015E 880.5000 835.5000
375 0177 881.2500 836.2500
400 0190 882.0000 837.0000
425 01A9 882.7500 837.7500
450 01C2 883.5000 838.5000
475 01DB 884.2500 839.2500
500 01F4 885.0000 840.0000
525 020D 885.7500 840.7500
550 0226 886.5000 841.5000
575 023F 887.2500 842.2500
600 0258 888.0000 843.0000
625 0271 888.7500 843.7500
650 028A 889.5000 844.5000
675 02A3 890.2500 845.2500
700 02BC 891.0000 846.0000
725 02D5 891.7500 846.7500
750 02EE 892.5000 847.5000
775 0307 893.2500 848.2500

NOTE
Channel numbers 778 through 1012 are not used.
1013 03F5 869.7000 824.7000
1023 03FF 870.0000 825.0000
E-6 1X SC™ 4812T BTS Optimization/ATP Oct 2003




68P09258A31-A Operating Frequency — Korean Bands

Operating Frequency — Korean Bands

1700 MHz PCS Channels

figure E-3 shows the valid channels for the 1700 MHz PCS frequency
spectrum. The CDMA channels are spaced in increments of 25 (25, 50,
75, ... 575) across the CDMA band.

Figure E-3: 1700 MHz PCS Frequency Spectrum

FREQ (MHz)

CHANNEL RX LS
25 1751.25 1841.25

575 1778.75 1868.75
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Calculating 1700 MHz Center Frequencies

Center frequency for channels may be calculated as follows:

Direction Formula Example
TX 1840 + (0.05 * Channel#) Channel: 1840 + (0.05 + 25) = 1841.25
RX 1750 + (0.05 * Channel#) Channel: 1750 + (0.05 + 25) = 1751.25

— Actual frequencies used depend on customer CDMA system

frequency plan.

— Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard
band on both sides of the carrier

— Minimum frequency separation required between any CDMA
carrier and the nearest NAMPS/AMPS carrier is 900 kHz (center to

center).

Table E-3: 1700 MHz TX and RX Frequency vs. Channel (Korean Bands)

Channel Number Transmit Frequency (MHz) Receive Frequency (MHz)
Decimal Hex Center Frequency Center Frequency
25 0019 1841.25 1751.25
50 0032 1842.50 1752.50
75 004B 1843.75 1753.75
100 0064 1845.00 1755.00
125 007D 1846.25 1756.25
150 0096 1847.50 1757.50
175 00AF 1848.75 1758.75
200 00C8 1850.00 1760.00
225 00E1 1851.25 1761.25
250 00FA 1852.50 1762.50
275 0113 1853.75 1763.75
300 012C 1855.00 1765.00
325 0145 1856.25 1766.25
350 015E 1857.50 1767.50
375 0177 1858.75 1768.75
400 0190 1860.00 1770.00
425 01A9 1861.25 1771.25
450 01C2 1862.50 1772.50
475 01DB 1863.75 1773.75
500 01F4 1865.00 1775.00
525 020D 1866.25 1776.25
550 0226 1867.50 1777.50
575 023F 1868.75 1778.75
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Test Equipment Preparation

Purpose
This appendix provides information on pre—testing set—up for the
following test equipment items (not required for the Cybertest test set):
e Agilent E7495A test equipment setup
¢ Agilent E4406A transmitter test set
* Agilent E4432B signal generator
¢ Advantest R3267 spectrum analyzer
¢ Advantest R3562 signal generator
* Agilent 8935 analyzer (formerly HP 8935)
e HP 8921 with PCS interface analyzer
¢ Advantest R3465 analyzer
* Motorola CyberTest
* HP 437 power meter
* Gigatronics 8541C power meter
¢ GPIB adapter

Pre—testing set—up information covered includes verification and setting
GPIB addresses, inter—unit cabling, connectivity testing, pre—test control
settings, and equipment calibration for items which are not calibrated
with the Calibrate Test Equipment function of the LMF.

The following procedures cover verification and changing GPIB
addresses for the various items of CDMA test equipment supported by
the LMF.

F-2 1X SC™ 4812T BTS Optimization/ATP Oct 2003



68P09258A31-A Test Equipment Preparation

Agilent R7495A Test Equipment Setup

This test equipment requires a warm-up period of at least 30 minutes
before BTS testing or calibration begins.

Using the Agilent E7495A with the LMF

The Agilent E7495A does not require the use of the 19MHz frequency
reference; if connected, it will be ignored. The Even Sec SYNC
connection is required.

The Agilent E7495A signal generator is only calibrated down to —80db.
In order to achieve accurate FER testing, be sure the RX setup includes
at least 40db of attenuation. This will ensure the signal generator will
output sufficient power to operate in the calibrated range.

Set the IP Address as described iqj"able F-1.

Table F-1: Set IP Address on Agilent E7495A test set

v~ Step Action

1 Use the System Button > Controls >IPAdmin to set an
IP address on the E7495A as 128.0.0.49, and Netmask to
255.255.255.128.

Connections

It is recommended that you use a hub with BNC and RJ-45 connections.
[Suggested models: Netgear model EN104 (4 port) or EN108 (8 port).
Do NOT use model numbers ending with “TP”; those have no BNC
connectors.]

The LMF will connect to the hub which in turn is connected to the BTS
and to the Agilent E7495A.

Agilent E7495A to Hub — This is an Ethernet cable, RI-45 to RJ-45.

LMF to Hub — Use one of the following cables to connect the LMF to
the Hub:
— Ethernet cable, RJ-45 to RJ—45 (be sure that the LAN card is set for
either AUTO or to use the RJ-45 only).
— Coax cable between LAN card and Hub. (Use a “T” on the hub and
connect a cable between the other end of the “T” and the BTS LAN
connection).

Hub to BTS - Use BNC “T” connector on the hub. [If your hub doesn’t
have BNC ports, use a BNC to UTP adapter.]
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Detecting Test Equipment

Check that no other equipment is connected to the LMF. Agilent
equipment must be connected to the LAN to detect it. Then perform the
procedures described iqj"able F-2.

Table F-2: Detecting Agilent E7495A Test Equipment

v~ Step Action
1 Click the Tools Menu.
2 Choose Options.
3 Check Agilent E7495A option in non—GPIB Test Equipment and enter its [P number.
4 Click Apply and wait a moment.
5 Click Dismiss.
Power Sensor Calibration
|j"able F-3 describes the E7495A Power Sensor Calibration.
Table F-3: E7495A Power Sensor Calibration
v~ Step Action
1 Display the power meter screen.

2 Zero the power meter. Make sure you are connected as shown iqjigure F-1.

Press the Zero softkey.
Press the Continue softkey.

3 Calibrate the power meter:

Press Ref CF.

Enter the reference cal factor, reading it off the label on the power sensor head.
Press Calibrate.

Connect the power sensor (seqijigure F-2).

Press Continue.

Press Cal Factor.

Enter the cal factor from the label on the power sensor head. Select a cal factor that’s within
the operating frequency of the base station.

F-4
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Figure F-1: Agilent E7495A Pre—Power Sensor Calibration connection
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Figure F-2: Agilent E7495A Power Sensor Calibration connection
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Cable Calibration

Follow the directions in the WinLMF program to calibrate cables.

— Calibrate the short cable (seqdfigure 3-15 on pagg3-64) and two 10
dB pads to get a base line and then calibrate the TX and RX setup.
Since you need at least 40 dB of loss when doing the FER test, the
setup for RX is the same as TX.

ATP Setup

TX Path Calibration setup is shown in Test Equipment Setup (see
figure 3-18 on pagq3-67).
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Verifying and Setting GPIB Address

Agilent E4406A Transmitter Tester GPIB Address

Refer tqfjigure F-3 and follow the procedure irrFable F-4 to verify and,
if necessary, change the Agilent E4406A GPIB address.

Figure F-3: Setting Agilent E4406A GPIB Address
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Table F-4: Verify and Change Agilent E4406A GPIB Address
Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.
— The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Config I/O softkey button to the right of the instrument screen.
— The softkey labels will change.
— The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 18, perform the following to change it:

3a | Press the GPIB Address softkey button. In the on—screen Active Function Area, GPIB Address will
be displayed followed by the current GPIB address.

3b | On front panel Data Entry keypad, enter the communications system analyzer GPIB address of 18.

— The GPIB Address label will change to Enter.

— Characters typed with the keypad will replace the current GPIB address in the Active Function
Area.

NOTE
To correct an entry, press Bk Sp key to delete one character at a time.
3c | Press the Enter softkey button or the keypad Enter key to set the new GPIB address.

— The Config I/O softkey labels will reappear.
— The new GPIB address will be displayed under the GPIB Address softkey label.
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Agilent E4432B Signal Generator GPIB Address

Refer tqjigure F-4 and follow the procedure irrfable F-5 to verify and,
if necessary, change the Agilent E4432B GPIB address.

Figure F-4: Setting Agilent E4432B GPIB Address
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Table F-5: Verify and Change Agilent E4432B GPIB Address
Step Action
1 In the MENUS section of the instrument front panel, press the Utility key.
— The softkey labels displayed on the right side of the instrument screen will change.
2 Press the GPIB/RS232 softkey button to the right of the instrument screen.
— The softkey labels will change.
— The current instrument GPIB address will be displayed below the GPIB Address softkey label.
3 If the current GPIB address is not set to 1, perform the following to change it:
3a | Press the GPIB Address softkey button.
— The GPIB Address label and current GPIB address will change to boldface.
— In the on—screen Active Entry Area, Address: will be displayed followed by the current GPIB
address.
3b | On the front panel Numeric keypad, enter the signal generator GPIB address of 1.
— The GPIB Address label will change to Enter.
— Characters typed on the keypad will replace the current GPIB address in the Active Entry display.
NOTE
To correct an entry, press the backspace key at the lower right of the keypad to delete one character at
a time.
3c | Press the Enter softkey button to set the new GPIB address.
— The new GPIB address will be displayed under the GPIB Address softkey label.
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Advantest R3267 Spectrum Analyzer GPIB Address

Refer tqjigure F-5 and perform the procedure iqj"able F-6 to verify
and, if necessary, change the Advantest R3267 spectrum analyzer GPIB
address.

Figure F-5: Setting Advantest R3267 GPIB Address
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Table F-6: Verify and Change Advantest R3267 GPIB Address
Step Action
1 If the REMOTE LED is lighted, press the LCL key.
— The LED extinguishes.
2 Press the CONFIG key.
— CONFIG softkey labels will appear in the softkey label display area of the instrument display.
— The current GPIB address will be displayed below the GPIB Address softkey label.
3 If the current GPIB address is not set to 18, perform the following to change it:
3a | Press the GPIB Address softkey. A GPIB Address entry window will open in the instrument display
showing the current GPIB address.
3b | Enter 18 on the keypad in the ENTRY section of the instrument front panel.
— Characters typed on the keypad will replace the address displayed in the GPIB Address entry
window.
NOTE
To correct an entry, press the BS (backspace) key at the lower right of the keypad to delete one
character at a time.
3c | Press the ENTR key to the lower right of the keypad to set the new GPIB address.
— The GPIB Address entry window closes.
— The new address is displayed in the bottom portion of the GPIB Address softkey label.
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Advantest R3562 Signal Generator GPIB Address

Set the GP-IB ADDRESS switch on the rear of the Advantest R3562
signal generator to address 1 as shown irfjigure F-6.

Figure F-6: Advantest R3562 GPIB Address Switch Setting
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Agilent 8935 Series E6380 (formerly HP 8935) Test Set GPIB Address

Refer tqfjigure F-7 and follow the procedure irrFable F-7 to verify and,
if necessary, change the Agilent 8935 GPIB address.

Figure F-7: Agilent 8935 Test Set
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NOTE This procedure assumes that the test equipment is set up and
ready for testing.
Table F-7: Verify and/or Change Agilent 8935 (formerly HP 8935) GPIB Address
Step Action
1 NOTE
The HP 1/O configuration MUST be set to Talk & Listen, or no device on the GPIB will be
accessible. (Consult test equipment OEM documentation for additional information as required.)
To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the Agilent 8935.
— The current HP-IB address is displayed at the top of the screen.
NOTE
HP-IB is the same as GPIB.
2 If the current GPIB address is not set to 18, perform the following to change it:
2a — Press Shift and Inst Config.
2b — Turn the Cursor Control knob to move the cursor to the HP-IB Adrs field.
2c — Press the Cursor Control knob to select the field.
2d — Turn the Cursor Control knob as required to change the address to 18.
2e — Press the Cursor Control knob to set the address.
3 Press Preset to return to normal operation.
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Hewlett Packard HP8921A and HP83236A/B GPIB Address

Refer tqjigure F-8 and follow the procedure irrfable F-8 to verify and,
if necessary, change the HP 8921A HP 83236A GPIB addresses.

Figure F-8: HP 8921A and HP 83236A/B
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NOTE This procedure assumes that the test equipment is set up and

ready for testing.

Table F-8: Verify and/or Change HP 8921A and HP 83236A GPIB Addresses

Step Action
1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP 8921A.
— The current HP-IB address is displayed at the top of the screen.

NOTE
HP-IB is the same as GPIB.

2 If the current HP-IB address is not set to 18, perform the following to change it:

2a — Turn the Cursor Control knob to move the cursor to More and press the knob to select the field.

2b — Turn the Cursor Control knob to move the cursor to I/O Config and press the knob to select the
field.

2c — Turn the Cursor Control knob to move the cursor to Adrs and press the knob to select the field.

2d — Turn the Cursor Control knob to change the HP-IB address to 18 and press the knob to set the
address.

2e — Press Shift and Preset to return to normal operation.

3 To set the HP 83236A (or B) PCS Interface GPIB address=19, set the DIP switches as follows:
- Al=1, A2=1, A3=0, A4=0, A5=1, HP-IB/Ser = 1
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Advantest R3465 Communications Test Set GPIB Address

Refer tqjigure F-9 and follow the procedure irrfable F-9 to verify and,
if necessary, change the GPIB address for the Advantest R3465.

Figure F-9: R3465 Communications Test Set
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NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-9: Verify and/or Change Advantest R3465 GPIB Address

Step Action
1 To verify that the GPIB address is set correctly, perform the following:
la — Press SHIFT then PRESET.
1b — Press LCL.
1c — Press the GPIB and Others CRT menu key to view the current address.

2 If the current GPIB address is not set to 18, perform the following to change it:

2a — Turn the vernier knob as required to select 18.
2b — Press the vernier knob to set the address.
3 To return to normal operation, press Shift and Preset.
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Motorola CyberTest GPIB Address

Follow the steps irJable F-10 to verify and, if necessary, change the
GPIB address on the Motorola CyberTest. Changing the GPIB address
requires the following items:

* Motorola CyberTest communications analyzer.
* Computer running Windows 3.1/Windows 95.
* Motorola CyberTAME software program “TAME”.
* Parallel printer port cable (shipped with CyberTest).

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-10: Verify and/or Change Motorola CyberTest GPIB Address

Step Action

1 On the LMF desktop, locate the CyberTAME icon. Double click on the icon to run the CyberTAME
application.

2 In the CyberTAME window taskbar, under Special, select IEEE.488.2.

3 CyberTAME software will query the CyberTest Analyzer for its current GPIB address. It then will
open the IEEE 488.2 dialog box. If the current GPIB address is not 18, perform the following
procedure to change it:

3a — Use the up or down increment arrows or double—click in the field and type the number to set the
address to 18.
3b — Click on the OK button.

— The new address will be written to the CyberTest through the parallel port and saved.

4 Verify that the address has been set by repeating stepg 4 andJ.
— The new address should now appear in the IEEE 488.2 dialog box Address field.
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HP 437 Power Meter GPIB Address

Refer tqdjigure F-10 and follow the steps irpJable F-11 to verify and, if
necessary, change the HP 437 GPIB address.

Figure F-10: HP 437 Power Meter
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1 1

REF FW00308
ENTER

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table F-11: Verify and/or Change HP 437 Power Meter GPIB Address

Step Action

1 Press Shift and PRESET.

2 Use the & arrow key to navigate to HP-IB ADRS and press ENTER.
The HP-IB address is displayed.

NOTE
HP-IB is the same as GPIB.

3 If the current GPIB address is not set to 13, perform the following to change it:
— Use the & @ arrow keys to change the HP-IB ADRS to 13.
— Press ENTER to set the address.

4 Press Shift and ENTER to return to a standard configuration.
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Gigatronics 8541C Power Meter GPIB Address

Refer tqjigure F-11 and follow the steps iqj"able F-12 to verify and, if
necessary, change the Gigatronics 8541C power meter GPIB address.

Figure F-11: Gigatronics 8541C Power Meter Detail
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—
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—
—
—
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GPIB E POWER
EsciE Loc <l \;l:l =
\- o
 —
MENU ENTER ARROW
KEYS REF FW00564
NOTE This procedure assumes that the test equipment is set up and

ready for testing.

Table F-12: Verify and/or Change Gigatronics 8541C Power Meter GPIB Address

Step Action
1 ! CAUTION

Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

Press MENU.

Use the w arrow key to select CONFIG MENU and press ENTER.
Use the w arrow key to select GPIB and press ENTER.

The current Mode and GPIB Address are displayed.

4 If the Mode is not set to 8541C, perform the following to change it:

Use the 4 ®  arrow keys as required to select MODE.
Use the w & arrow keys as required to set MODE to 8541C.

5 If the GPIB address is not set to 13, perform the following to change it:
Use the # arrow key to select ADDRESS.
Use the w & arrow keys as required to set the GPIB address to 13.

6 Press ENTER to return to normal operation.
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RS232 GPIB Interface Adapter

Be sure that the RS-232 GPIB interface adapter DIP switches are set as
shown irrfigure F-12.

Figure F-12: RS232 GPIB Interface Adapter
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Test Equipment Set-up

Purpose

This section covers other test equipment and peripherals not covered in
Chapter3. Procedures for the manual testing are covered here, along
with procedures to calibrate the TX and RX cables using the signal
generator and spectrum analyzer.

Equipment Warm up

NOTE Warm-up BTS equipment for a minimum of 60 minutes prior to
performing the BTS optimization procedure. This assures BTS
site stability and contributes to optimization accuracy. (Time
spent running initial power-up, hardware/
firmware audit, and BTS download counts as warm-up time.)

CAUTION If any piece of test equipment (i.e., test cable, RF adapter) has
been replaced, re-calibration must be performed. Failure to do so
could introduce measurement errors, resulting in incorrect
measurements and degradation to system performance.

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

Prerequisites

Prior to performing any of these procedures, all preparations for
preparing the LMF, updating LMF files, and any other pre-calibration
procedures, as stated in Chaptqj, must have been completed.
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HP8921A System Connectivity Test

Follow the steps ir¥able F-13 to verify that the connections between the
PCS Interface and the HP8921A are correct, and cables are intact. The
software also performs basic functionality checks of each instrument.

NOTE Disconnect other GPIB devices, especially system controllers,
from the system before running the connectivity software.

Table F-13: System Connectivity

Step Action
NOTE
— Perform this procedure after test equipment has been allowed to warm—up and stabilize for a
minimum of 60 minutes.
1 Insert HP 83236A Manual Control/System card into memory card slot.
2 Press the [PRESET] pushbutton.
3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.
4 Position the cursor at Select Procedure Location and select by pressing the cursor control knob.
In the Choices selection box, select Card.
5 Position the cursor at Select Procedure Filename and select by pressing the cursor control knob.
In the Choices selection box, select SYS_CONN.
6 Position the cursor at RUN TEST and select it.
The software will prompt you through the connectivity setup.
7 When the test is complete, position the cursor on STOP TEST and select it; OR press the [KS5]
pushbutton.
8 To return to the main menu, press the [KS] pushbutton.
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Manual Cable Calibration using HP8921 with HP PCS Interface (HP83236)
NOTE

This calibration method must be executed with great care. Some
losses are measured close to the minimum limit of the power
meter sensor (—30 dBm).

Prerequisites

Ensure the following prerequisites have been met before proceeding:

* Test equipment to be calibrated has been connected correctly for cable
calibration.

* Test equipment has been selected and calibrated.

Refer tqdjigure F-13 for location of the components on the PCS
Interface and Communications Test Set.
Test Equipment Set-up

Perform the procedure irﬂ" able F-14 to calibrate the test equipment
using the HP8921 Cellular Communications Analyzer equipped with the
HP83236 PCS Interface.

Table F-14: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

NOTE
Verify that GPIB controller is turned off.

Insert HP 83236A Manual Control System card into memory card slot (seqfigure F-13).

Press the Preset pushbutton.

Under Screen Controls, press the TESTS pushbutton to display the TESTS (Main Menu) screen.

AW =

Position the cursor at Select Procedure Location and select it. In the Choices selection box, select
CARD.

5 Position the cursor at Select Procedure Filename and select it. In the Choices selection box, select
MANUAL.

Position the cursor at RUN TEST and select it. HP must be in Control Mode Select YES.

If using HP 83236A: If using HP 83236B:
Set channel number=<chan#>: Set channel frequency:
— Position cursor at Channel — Position cursor at Frequency Band and press Enter.
Number and select it.

— Enter the chan# using the numeric
keypad; press [Enter] and the
screen will go blank. — Position the cursor to 83236 generator frequency and

enter actual RX frequency.

— Select User Defined Frequency.
— Go Back to Previous Menu.

— When the screen reappears, the
chan# will be displayed on the — Position the cursor to 83236 analyzer frequency and
channel number line. enter actual TX frequency.

8 Set RF Generator level:
— Position the cursor at RF Generator Level and select it.
— Enter —10 using the numeric keypad; press [Enter] and the screen will go blank.

— When the screen reappears, the value —10 dBm will be displayed on the RF Generator Level line.

... continued on next page
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Table F-14: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step

Action

Set the user fixed Attenuation Setting to 0 dBm:

— Position cursor at Analyzer Attenuation and select it
— Position cursor at User Fixed Atten Settings and select it.

— Enter 0 (zero) using the numeric keypad and press [Enter].

10

Select Back to Previous Menu.

11

Record the HP83236 Generator Frequency Level:

Record the HP83236B Generator Frequency Level:
— Position cursor at Show Frequency and Level Details and select it.
— Under HP83236 Frequencies and Levels, record the Generator Level.

— Under HP83236B Frequencies and Levels, record the Generator Frequency Level
(1850 — 1910 MHz for 1.9 GHz or 1750 — 1780 for 1.7 GHz).

— Position cursor at Prev Menu and select it.

12

Click on Pause for Manual Measurement.

13

Connect the power sensor directly to the RF OUT ONLY port of the PCS Interface.

14

On the HP8921A, under To Screen, select CDMA GEN.

15

Move the cursor to the Amplitude field and click on the Amplitude value.

16

Increase the Amplitude value until the power meter reads 0 dBm +0.2 dB.
NOTE

The Amplitude value can be increased coarsely until 0 dBM is reached; then fine tune the amplitude
by adjusting the Increment Set to 0.1 dBm and targeting in on 0 dBm.

17

Disconnect the power sensor from the RF OUT ONLY port of the PCS Interface.
NOTE

The Power Meter sensor’s lower limit is =30 dBm. Thus, only components having losses <30 dB
should be measured using this method. For further accuracy, always re-zero the power meter
before connecting the power sensor to the component being calibrated. After connecting the
power sensor to the component, record the calibrated loss immediately.

18

Disconnect all components in the test setup and calibrate each one separately by connecting each
component, one-at-a-time, between the RF OUT ONLY PORT and the power sensor (seqjigure F-13,
Setups A, B, or C). Record the calibrated loss value displayed on the power meter.

e Example: (A) Test Cable(s) = -1.4 dB

(B) 20 dB Attenuator = -20.1dB
(B) Directional Coupler = —29.8 dB

19

After all components are calibrated, reassemble all components together and calculate the total test
setup loss by adding up all the individual losses:

¢ Example: Total test setup loss = —1.4 —29.8 -20.1 = -51.3 dB.
This calculated value will be used in the next series of tests.

20

Under Screen Controls press the TESTS button to display the TESTS (Main Menu) screen.

21

Select Continue (K2).

22

Select RF Generator Level and set to —119 dBm.

... continued on next page
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Table F-14: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

23 Click on Pause for Manual Measurement.

24 | Verify the HP8921A Communication Analyzer/83203A CDMA interface setup is as follows (fields
not indicated remain at default):

* Verify the GPIB (HP-IB) address:

under To Screen, select More

select IO CONFIG

Set HP-IB Adrs to 18

set Mode to Talk&Lstn

¢ Verify the HP8921A is displaying frequency (instead of RF channel)

— Press the blue [SHIFT] button, then press the Screen Control [DUPLEX] button; this switches to
the CONFIG (CONFIGURE) screen.

— Use the cursor control to set RF Display to Freq

25 | Refer tqable 3-31 for assistance in manually setting the cable loss values into the LMF.
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Figure F-13: Calibrating Test Setup Components
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HP PCS Interface Test Equipment Setup for Manual Testing

Follow the procedure iqj"able F-15 to setup the HP PCS Interface Box
for manual testing.

Table F-15: HP PCS Interface Test Equipment Setup for Manual Testing

»~| Step Action

NOTE
Verify GPIB controller is turned off.

Insert HP83236B Manual Control/System card into the memory card slot.
2 Under Screen Controls, press the [TESTS] push-button to display the TESTS (Main Menu)

screen.

3 Position the cursor at Select Procedure Location and select. In the Choices selection box, select
CARD.

4 Position the cursor at Select Procedure Filename and select. In the Choices selection box, select
MANUAL.

Position the cursor at RUN TEST and select OR press the K1 push-button.

Set channel number=<chan#>:
— Position cursor at Channel Number and select.
— Enter the chan# using the numeric keypad and then press [Enter] (the screen will blank).
— When the screen reappears, the chan# will be displayed on the channel number line.

NOTE
If using a TMPC with Tower Top Amplifier (TTA) skip Ste7.
7 e Set RF Generator level= —119 dBm + Cal factor
Example: —119 dBm + 2 dB = -117 dBm
* Continue with Stegr§ (skip Steg§).

8 Set RF Generator level= —116 dBm + Cal factor.
Example: —116 dBm + 2 dB = -114 dBm

9 Set the user fixed Attenuation Setting to 0 dB:

— Position cursor at RF Generator Level and select.

— Position cursor at User Fixed Atten Settings and select.
— Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Select Quit, then select Yes.
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Calibrating Test Cable Setup using Advantest R3465

| NOTE Be sure the GPIB Interface is OFF for this procedure.

Perform the procedure irfable F-16 to calibrate the test cable setup
using the Advantest R3465. Advantest R3465 Manual Test setup and
calibration must be performed at both the TX and RX frequencies.

Table F-16: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action
NOTE
— This procedure can only be performed after test equipment has been allowed to warm—up and
stabilize for a minimum of 60 minutes.
1 Press the SHIFT and the PRESET keys located below the display.
2 Press the ADVANCE key in the MEASUREMENT area of the control panel.
3 Select the CDMA Sig CRT menu key.
4 Select the Setup CRT menu key.
5 Using the vernier knob and the cursor keys set the following parameters:
NOTE
Fields not listed remain at default.
Generator Mode: SIGNAL
Link: FORWARD
Level Unit: dBm
CalCorrection: ON
Level Offset: OFF
6 Select the return CRT menu key.
7 Press FREQ key in the ENTRY area.
8 Set the frequency to the desired value using the keypad entry keys.
9 Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.
10 | Verify that the Qutput CRT menu key is highlighting OFF; if not, press the Qutput key to toggle it
OFF.
11 Press the LEVEL key in the ENTRY area.
12 | Set the LEVEL to 0 dBm using the key pad entry keys.
13 | Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.
14 | Press the Output CRT menu key to toggle Output to ON.
15 | Record the power meter reading
16 | Disconnect the power meter sensor from the R3561L RF OUT jack.
. .. continued on next page
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Table F-16: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

NOTE

The Power Meter sensor lower limit is —30 dBm. Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re—zero the power meter before
connecting the power sensor to the component being calibrated. Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 | Disconnect all components in the the test setup and calibrate each one separately. Connect each
component one—at—a—time between the “RF OUT” port and the power sensor (seqjigure F-14,
“Setups A, B, and C”). Record the calibrated loss value displayed on the power meter for each
connection.

Example:  (A) 1st Test Cable = -0.5dB
(B) 2nd Test Cable = -14dB
(C) 20 dB Attenuator = -20.1dB
(D) 30 dB Directional Coupler = -29.8 dB

18 | Press the Output CRT menu key to toggle Output OFF.

19 | Calculate the total test setup loss by adding up all the individual losses:
Example: Total test setup loss = 0.5 + 1.4 + 20.1 + 29.8 = 51.8 dB
This calculated value will be used in the next series of tests.

20 | Press the FREQ key in the ENTRY area.

21 Using the keypad entry keys, set the test frequency to the RX frequency.

22 | Repeat stepg9 through39 for the RX frequency.

23 | Refer tqable 3-31 for assistance in manually setting the cable loss values into the LMF.
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Figure F-14: Cable Calibration using Advantest R3465
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Agilent E4406A Transmitter Tester Self-alignment (Calibration)

The Agilent E4406A requires pre—calibration actions or calibration
verification that are not supported by the LMF. Follow the procedure in

[Jable F-17 and refer tqfjigure F-15 to perform the Agilent E4406A
self-alignment (calibration).

Table F-17: Agilent E4406A Self—alignment (Calibration)

Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.
— The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Alignments softkey button to the right of the instrument screen.
— The softkey labels will change.

3 Press the Align All Now softkey button.
— All other instrument functions will be suspended during the alignment.
— The display will change to show progress and results of the alignments performed.

— The alignment will take less than one minute.

Figure F-15: Agilent E4406A Self-alignment
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Download ROM Code
Download ROM Code

ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to
OOS_ROM (blue) and remains OOS_ROM (blue). The same R-level
RAM code must then be downloaded to the device. This procedure
includes steps for both the ROM code download and the RAM code
download.

ROM code files cannot be selected automatically. The ROM code file
must be selected manually. Follow the procedure irrjable G-1 to
download ROM code.

Prerequisite
e ROM and RAM code files exist for the device to be downloaded.

CAUTION The R-level of the ROM code to be downloaded must be the
same as the R—level of the ROM code for other devices in the
BTS. Code must not be mixed in a BTS. This procedure should
only be used to upgrade replacement devices for a BTS and it
should not be used to upgrade all devices in a BTS. If a BTS is
to be upgraded from one R—level to another, the optimization
and ATP procedures must first be performed with the BTS in the
original configuration. The upgrade should then be done by the
CBSC.

Table G-1: Download ROM Code

Step Action

1 Click on the device to be downloaded.
NOTE
More than one device of the same type can be selected for download by either clicking on each one to
be downloaded or from the BTS menu bar Select pull-down menu, select the device item that applies.
Where: device = the type of device to be loaded (BBX, CSM, GLI, MCC)
Click on the Device menu.

3 Click on the Status menu item.
A status report window appears.

4 Make a note of the number in the HW Bin Type column.
NOTE
“HW Bin Type” is the Hardware Binary Type for the device. This code is used as the last four digits in
the filename of a device’s binary ROM code file. Using this part of the filename, the ROM code file
can be matched to the device in which it is to be loaded.

5 Click on the OK button to dismiss the status report window.
NOTE
ROM code is automatically selected for download from the <x>:\<1mf home
directory>\version folder>\<code folder> specified by the NextLoad property in
the bts—#.cdf file. To check the value of the NextLoad property, click on Util > Examine >
Display Nextload. A pop—up message will show the value of the NextLoad.

... continued on next page
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ETable G-1: Download ROM Code

Step Action
6 From the BTS menu bar Device pull-down menus, select Download > ROM.
— If the file matching the Hardware Binary Type of the device is found in the code folder, a status
report shows the result of the download. Proceed to Ste32.
— If a file selection window appears, select the ROM code file manually.
7 Double—click on the version folder that contains the desired ROM code file.
8 Double—click on the Code folder.
A list of ROM and RAM code files is displayed.
! CAUTION
A ROM code file having the correct hardware binary type (HW Bin Type) needs to be chosen. The
hardware binary type (last four digits in the file name) was determined in steg4. Unpredictable results
can happen and the device may be damaged (may have to be replaced) if a ROM code file with wrong
binary type is downloaded.
9 Choose a ROM code file having the correct hardware binary type (HW Bin Type).
The hardware binary type (last four digits in the file name) was determined in steg4.
10 | Click on the ROM code file that matches the device type and HW Bin Type (e.g., bbx_rom.bin.0604
for a BBX having a HW Bin Type of 0604).
The file should be highlighted.
11 Click on the Load button.
A status report window displays the result of the download.
NOTE
If the ROM load failed for some devices, load them individually by clicking on one device, perform
stepyf through1 for it, and repeat the process for each remaining device.
12 | Click on the Ok button to close the status report window.
13 | Click on the Util menu.
14 | Select the Tools menu item.
15 | Click on the Update NextLoad>CDMA menu item.
16 | Select the version number of the folder that was used for the ROM code download.
17 | Click on the Save button.
A pop—up message indicates that the CDF file has been updated.
18 | Click on the OK button to dismiss the pop—up message.
19 | Click on the device that was downloaded with ROM code.
20 | Click on the Device menu.
21 | Click on the Download Code menu item to download RAM code.
A status report window displays the result of the download.
NOTE
Data is automatically downloaded to GLI devices when the RAM code is downloaded. Use the
Download Data procedure to download data to other device types after they have been upgraded.
22 | Click on the Ok button to close the status report window.
The downloaded device should be OOS_RAM (yellow) unless it is a GLI in which case it should be
INS (green).
. .. continued on next page
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ETable G-1: Download ROM Code

Step Action

23 Click on the device that was downloaded.

24 Click on the Device menu.

25 | Click on the Status menu item.
Verify that the status report window displays the correct ROM and RAM version numbers.

26 | Click on the Ok button to close the status report window.

HoN
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Introduction

Purpose

This procedure is a guide to expanding your system with multiple
carriers while the system remains in service. This procedure also allows
you to perform on site maintenance (replace defective boards and
recalibrate) while the remainder of the site stays in service.

Motorola recommends that you perform this procedure during a
maintenance window.

This procedure cannot be performed on BTSs with 4—to—1 combiners.
The procedure can only be performed on one side of the BTS at one
time. That is, LPAs 1, 2,3, 7, 8, 9 (feed antennas 1, 2, 3) can be
calibrated while LPAs 6, 7, 8, 10, 11, 12 (feed antennas 4, 5, 6) remain
in service and vice versa.

Equipment Warm up

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

CAUTION If any piece of test equipment (i.e., test cable, RF adapter) has
been replaced, re-calibration must be performed. Failure to do so
could introduce measurement errors, causing incorrect
measurements and degradation to system performance.
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Power Delta Calibration

Powe

r Delta Calibration Introduction

The In—service calibration procedure has several differences from a
normal calibration procedure. One of these is the use of a spectrum
analyzer instead of a power meter to measure power. Power meters are
broadband measurement devices and cannot be used to measure power
during In—service Calibration since other carriers are operating. A
spectrum analyzer can be used because it measures power at a given
frequency. However, measuring power using a spectrum analyzer is less
accurate than using a power meter. Therefore, you must compensate for
the difference (delta) between the power meter and the spectrum
analyzer.

HP8921A Power Delta Calibration

Use the HP8921A Spectrum Analyzer to measure power during
In—Service Calibration for 800 MHz systems. After the offset value has
been calculated, add it to the TX cable loss value.

Follow the procedure irrFable H-1 to perform the HP8921A Power Delta
Calibration procedure.

NOTE This procedure requires two HP8921As.

Table H-1: HP8921A Power Delta Calibration Procedure

Step Action
NOTE
Perform this procedure after test equipment has been allowed to warm—up and stabilize for a minimum
of 60 minutes.
1 Connect a short RF cable between the HP§8921A Duplex Out port and the HP437B power sensor (see
figure H-1).
2 Set the HP8921A signal source as follows:
— Measure mode to CDMA Generator
— Frequency to the CDMA Calibration target frequency
— CW RF Path to IQ
— Output Port to Dupl
— Data Source to Random
— Amplitude to 0 dBm
3 Measure and record the power value reading on the HP437B Power Meter.
4 Record the Power Meter reading as result A
Turn off the source HP8921A signal output, and disconnect the HP437B.
NOTE
Leave the settings on the source HP8921A for convenience in the following steps.
6 Connect the short RF cable between the source HP§921A Duplex Out port and the measuring
HP8921A RF-IN port (seqfigure H-2).
... continued on next page
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ﬂable H-1: HP8921A Power Delta Calibration Procedure

Step Action
7 Ensure that the source HP8921A settings are the same as in Ster3.
8 Set the measuring HP8921A as follows:
— Measure mode to CDMA Anl
— Frequency to the CDMA calibration target frequency
— Input Attenuation to 0 dB
— Input port to RF-IN
— Gain to Auto
— Analyzer Direction to Fwd
9 Turn on the source HP8921A signal output.
10 | Measure and record the channel power reading on the measuring HP8921A as result
B
11 Turn off the source HP8921A signal output and disconnect the equipment.
12 | Compute the delta between HP437B and HP8921A using the following formula:

Delta=A-B
Example: Delta = —0.70 dBm — (-1.25 dBm) = 0.55 dBm
Example: Delta = 0.26 dBm — 0.55 dBm = -0.29 dBm
These examples are included to show the mathematics and do not represent actual readings.

NOTE

Add this delta value to the TX Cable Loss value during In—Service Calibration (see Ster# in
[Jable H-5).

Figure H-1: Delta Calibration Setup — HP8921A to HP437B
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Figure H-2: Delta Calibration Setup — HP8921A to HP§921A
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Advantest R3465 Power Delta Calibration

Follow the procedure irﬂable H-2 to perform the Advantest R3465
Power Delta Calibration procedure.

Table H-2: Advantest Power Delta Calibration Procedure

Step Action
NOTE

Perform this procedure after test equipment has been allowed to warm—up and stabilize for a minimum
of 60 minutes.

On the Advantest R3465:
1 Press the SHIFT and the PRESET keys located below the CRT display.

Press the ADVANCE key in the Measurement area of the control panel.
Press the CDMA Sig CRT menu key.

Press the FREQ key in the Entry area of the control panel.

Set the frequency to the desired value using the keypad entry keys.

Press the LEVEL key in the Entry area of the control panel.

Set the LEVEL to 0 dBm using the keypad entry keys.
Verify the Mod CRT menu key is highlighting OFF, if not press the Mod key to toggle it OFF.

9 Verify the Output CRT menu key is highlighting OFF. If not, press the Output key to toggle it OFF.
On the HP 437 Power Meter:

10 | Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE

For best accuracy, always re—zero the power meter before connecting the power sensor to the
component being calibrated.

11 Connect the RF cable from the R3561L. CDMA Test Source Unit RF OUT port to the power sensor
(seqfigure H-3).
12 | Press the Output CRT menu key to toggle the Output to ON.

0 N NN R W

B

... continued on next page
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ﬂable H-2: Advantest Power Delta Calibration Procedure

Step Action
13 | Record the Power Meter reading as result A
14 | Press the Output CRT menu key to toggle the Output to OFF.
15 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the Spectrum
Analyzer INPUT Port (seqfjigure H-4).
16 | Press the Output CRT menu key to change the Output to ON.
17 | Press the CW key in the Measurement area of the control panel.
18 | Press the LEVEL key in the Entry area of the control panel.
19 | Set the REF LEVEL to 10 dBm using the keypad entry keys.
20 | Press the dB/div CRT menu key.
21 | Press the 10 dB/div CRT menu key.
22 | Press the FREQ key in Entry area of the control panel.
23 Set the frequency to the desired value using the keypad entry keys.
24 | Press the more 1/2 CRT menu key.
25 | Press the Preselector CRT menu key to highlight 3.0G.
26 | Press the FORMAT key in the Display Control area of the control panel.
27 | Press the TRACE CRT menu key.
28 | Press the AVG A CRT menu key.
29 | Set AVG to 20 using keypad entry keys.
30 | Press the return CRT menu key.
31 Press the SPAN key in the Entry area of the control panel.
32 | Press the Zero Span CRT menu key.
33 | Press the BW key in the Entry area of the control panel.
34 | Press the RBW CRT menu key to highlight MNL.
35 | Set RBW to 30 kHz using keypad entry keys.
36 | Press the VBW CRT menu key to highlight MNL.
37 | Set VBW to 1 MHz using keypad entry keys.
38 | Press the Marker ON key in the Display Control area of the control panel.
39 | Record the Marker Level reading as result B
... continued on next page
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ﬂable H-2: Advantest Power Delta Calibration Procedure

Step

Action

40

Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus

the Advantest measurement.

Delta=A-B

Example: Delta = —0.70 dBm — (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm — 0.55 dBm = -0.29 dBm
These examples are included to show the mathematics and do not represent actual readings.
NOTE

Add this delta value to the TX Cable Loss value during In—Service Calibration (see Ster# in
[Jable H-5).

Figure H-3: Delta Calibration Setup — R3561L to HP437B
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HP8935 Power Delta Calibration

Follow the procedure irﬂable H-3 to perform the HP8935 Power Delta
Calibration procedure.

Table H-3: HP8935 Power Delta Calibration Procedure

Step Action
NOTE
Perform this procedure after test equipment has been allowed to warm—up and stabilize for a minimum
of 60 minutes.
1 Connect a short RF cable between the HP8935 Duplex Out port and the HP437B power sensor (see

figure H-5).

2 Set the HP8935 signal source as follows:
— Measure mode to CDMA Gen
— Frequency to the CDMA Calibration target frequency
— CW RF Path to IQ
— Output Port to Dupl
— Data Source to Random
— Amplitude to 0 dBm
3 Measure and record the power value reading on the HP437B Power Meter.
4 Record the Power Meter reading as result A
5 Turn off the source HP8935 signal output, and disconnect the HP437B.
NOTE
Leave the settings on the source HP8935 for convenience in the following steps.
6 Connect the short RF cable between the source HP8935 Duplex Out port and the RF-IN/OUT port
(seqfigure H-0).
7 Ensure that the source HP8935 settings are the same as in Steqj.
8 Set the measuring HP8935 as follows:
— Measure mode to CDMA Anl
— Frequency to the CDMA calibration target frequency
— Input Attenuation to 0 dB
— Input port to RF-IN
— Gain to Auto
— Anl Dir to Fwd
9 Turn on the source HP8935 signal output.
10 | Set the Chn Pwr Cal to Calibrate and select to calibrate.
11 Measure and record the channel power reading on the measuring HP8935 as result
B
12 | Turn off the source HP8935 signal output and disconnect the equipment.
. .. continued on next page
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ﬂable H-3: HP8935 Power Delta Calibration Procedure

Step Action

13 | Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta=A-B
Example: Delta = —0.70 dBm — (-1.25 dBm) = 0.55 dBm
Example: Delta = 0.26 dBm — 0.55 dBm = -0.29 dBm
These examples are included to show the mathematics and do not represent actual readings.

NOTE

Add this delta value to the TX Cable Loss value during In—Service Calibration (see Ster# in
[Jable H-5).

Figure H-5: Delta Calibration Setup — HP8935 to HP437B
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Figure H-6: Delta Calibration Setup — HP8935 to HP8935
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Agilent E4406A Power Delta Calibration

The Agilent E4406A transmitter tester and E4432B signal generator test
equipment combination can be used for ISC of IS-2000 CDMA 1X as
well as IS-95A/B operation modes. The power delta calibration is
performed on the E4406A, but the E4432B is required to generate the
reference signal used to calculate the power delta offset. After the offset
value has been calculated, add it to the TX cable loss value in the LMF.

Follow the procedure irrFable H-4 to perform the Agilent E4406A
Power Delta Calibration procedure.

Table H-4: Agilent E4406A Power Delta Calibration Procedure

Step

Action

NOTE

Perform this procedure after test equipment has been allowed to warm—up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of the Optimization/Calibration chapter in the SC 4812T
Optimization/ATP manual.

Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE

For best accuracy, always re—zero the power meter before connecting the power sensor to the
component being calibrated.

Connect a short RF cable from the E4432B RF QOUTPUT connector the HP437 power meter power
sensor (seqfigure H-7).

Set the E4432B signal generator as follows:
— Press Preset to exit any modes for which the signal generator is configured.

— Press Frequency and enter the frequency of the channel to be calibrated using the numeric
keypad.

— Using the soft keys to the right of the screen, select the frequency range to be measured (for
example, MHz).

— Press Amplitude and, using the numeric keypad, set signal amplitude to 0 (zero).
— Using the soft keys, set the measurement type to dBm.

On the E4432B, press RF On/Off to toggle the RF output to RF ON.
— Note that the RF On/Off status in the screen display changes.

Measure and record the value reading on the HP437 power meter as result A

On the E4432B, press RF On/Off to toggle the RF output to RF OFF.
— Note that the RF On/Off status in the screen display changes.

Disconnect the short RF cable from the HP437 power meter power sensor, and connect it to the
RF INPUT connector on the E4406A transmitter tester (seqfigure H-8).

... continued on next page
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able H-4: Agilent E4406A Power Delta Calibration Procedure
g

Step Action
NOTE
Do not change the frequency and amplitude settings on the E4432B when performing the following
steps.

8 Set the E44006A as follows:

— Press Preset to exit any modes for which the transmitter tester is configured.

— Press MODE and, using the soft keys to the right of the screen, select cdmaOne.

— Press MEASURE and, using the soft keys, select spectrum.

— Press Frequency and, using the soft keys, select Center Frequency.

— Using the numeric keypad. enter the frequency of the channel to be calibrated.

— Using the soft keys, select the frequency range to be measured (for example, MHz).
— Press Input/Output and, using the soft keys, select Input Atten.

— Using the numeric keypad, set Input Atten to 0 (zero) and, using the soft keys, select dB.
— Using the soft keys, select External Atten and then select Mobile.

— Using the numeric keypad, set Mobile to 0 (zero) and, using the soft keys, select dB.
— Using the soft keys, select Base.

— Using the numeric keypad, set Base to 0 (zero) and, using the soft keys, select dB.

— Press MEASURE and, using the soft keys, select Channel Power.

9 On the E4432B signal generator, press RF On/Off to toggle the RF output to RF ON.
— Note that the RF On/Off status in the screen display changes.

10 | Read the measured Channel Power from the E4406A screen display and record it as
result B

11 On the E4432B, press RF On/Off to toggle the RF output to RF OFF.
— Note that the RF On/Off status in the screen display changes.

12 | Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Agilent measurement.

Delta=A-B
Example: Delta = —0.70 dBm — (-1.25 dBm) = 0.55 dBm
Example: Delta = 0.26 dBm — 0.55 dBm = -0.29 dBm
These examples are included to show the mathematics and do not represent actual readings.

NOTE

Add this delta value to the TX Cable Loss value during In—Service Calibration (see steg4 in
[Jable H-5).
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Figure H-7: Delta Calibration Setup — Agilent E4432B to HP437
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In—Service Calibration

In—Service Calibration

CAUTION

This feature does NOT have fault tolerance at this time. The
system has no safe—guards to stop you from doing something
that will take the BTS out of service. If possible, perform this
procedure during a maintenance window.

Follow the procedures in this section precisely, otherwise the
entire BTS will most likely go OUT OF SERVICE.

At the CBSC, only perform operations on expansion hardware
when it is in the OOS_MANUAL state.

The operator must be trained in the LMF operation prior to
performing this procedure.

Prerequisites

Expansion hardware has been added in the CBSC database, and the
CDF file has been generated.

The expansion devices have been inserted into the C—CCP cage and
are in the OOS_MANUAL state at the CBSC.

The site specific cdf (with the expansion hardware) and cal files have
been loaded onto the LMF.

The LMF has the same code and dds files as the CBSC to download.

CAUTION

Do not download code or data to any cards other than those you
are working on. Downloading code or data to other cards will
take the site OUT OF SERVICE.

The code file version numbers must match the version numbers
on the other cards in the frame. If the numbers do not match, the
site may go OUT OF SERVICE.

The BTS—#.cdf, CBSC—#.cdf, and CAL files for this BTS must
have come from the CBSC.

Test equipment has been configured perfjigure H-9 anqigure H-10.

An RFDS (or at a minimum a directional coupler), whose loss is
already known, must be in line to perform the in—service calibration.

Test equipment has been calibrated after 1 hour warm up.

A short RF cable and two BNC-N adapters are available to perform
Cable Calibration.

The Power Delta Calibration has been performed (seqFable H-1,

[Jable H-2, oyjable H-3).
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Figure H-9: Optimization/ATP Test Setup Using RFDS
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Figure H-10: IS-95 A/B/C Optimization/ATP Test Setup Using RFDS
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Follow the procedure irrJable H-5 to perform the In—Service
Calibration.

Table H-5: In—Service Calibration

Step

Action

NOTE

Perform this procedure after test equipment has been allowed to warm—up and stabilize for a minimum
of 60 minutes.

Set up the LMF for In—-Service Calibration:
— Start the LMF by double—clicking the LMF icon on the Windows desktop.
— Click Tools>Options from the menu bar at the login screen.

— Check the applicable spectrum analyzer check box and the signal generator check box on the Test
Equipment tab.
Ensure that the GPIB address is 18 for the CDMA analyzer and 1 for the signal generator.

— Uncheck any other other equipment that is selected.

— Click the Apply button.

— Select the BTS Options tab in the LMF Option window.

— Check the In-Service Calibration check box.

— Click the Apply button.

— Click the Dismiss button to close the LMF Option window.

Login to the target BTS:
— Select the target BTS icon.
— Click the Login button at the login screen.

Measure the Cable Loss using the Cable Calibration function:
Click Util>Cable Calibration from the menu bar at the main window.

Set the desired channel(s) and select TX and RX CABLE CAL at the cable calibration pop up
window.

Click the OK button to perform cable calibration.

Follow the on—screen instructions to complete the cable loss measurement.
NOTE

— The measured value is input automatically to the cable loss file.

— To view the cable loss file, click Util>Examine>Cable Loss>TX or RX.

Add the spectrum analyzer power delta to the Cable Loss.

— To view the cable loss file, click Util>Examine>Cable Loss>TX or RX.

— Add the value computed irrFable H-1rFable H-2, orJable H-3 to the TX Cable Loss.
NOTE

Be sure to include the sign of the value. The following examples are included to show the mathematics
and do not represent actual readings:

Example: 5.65 dBm + 0.55 dBm = 6.20 dBm
Example: 5.65 dBm + (-0.29 dBm) = 5.36 dBm
Example: -5.65 dBm + 0.55 dBm = -5.10 dBm
Example: =5.65 dBm + (-0.29 dBm) = -5.94 dBm

... continued on next page
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ﬂable H-5: In-Service Calibration

Step Action

5 Input the Coupler Loss for the TX and RX tests:
— Click Util>Edit>Coupler Loss>TX or RX from the menu bar at the main window.

— Input the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

— Click the Save button.
— Click the Dismiss button to close the window.
— To view the coupler loss file, click Util>Examine>Coupler Loss>TX or RX.

6 Have the CBSC operator put the redundant BBX OOS_MANUAL.

! CAUTION

Be sure to download OOS devices only. Loading in—service devices takes them OUT OF SERVICE
and can result in dropped calls.

The code file version numbers must match the version numbers on the other cards in the frame. If the
numbers do not match, the site may go OUT OF SERVICE.

NOTE
Be sure to include the redundant BBX in stepg g, and§-

7 Download code and data to the target devices:
— Click Tools>Update NextLoad>CDMA to set the code version that will be downloaded.

— Select the BTS(s) you need, check the appropriate code version in the pop up window, and click
the Save button to close.

— Select the target BBX(s) on the C—CCP cage picture.

— Click Device>Download>Code/Data to start downloading code.
— Select the target BBX(s) on the C—CCP cage picture.

— Click Device>Download>Data to start downloading data.

. .. continued on next page
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ﬂable H-5: In-Service Calibration

Step

Action

! CAUTION
Perform the In—service Calibration procedure on OOS devices only.
Select the desired test:
— Select the target BBX(s) on the C—-CCP cage picture.
— Click Tests>[desired test] from the menu bar at the main window.
— Select the target carrier and confirm the channel number in the pop up window.
— Leave the Verify BLO check box checked.
— From the Test Pattern pick list, select a test pattern.
— Click the OK button to start calibration.

— Follow the on—screen instructions, except, do not connect to the BTS antenna port, connect to the
directional coupler (fwd) port associated with the on screen prompt antenna port.

NOTE
¢ Selecting Pilot (default) performs tests using a pilot signal only.

¢ Selecting Standard performs tests using pilot, synch, paging and six traffic channels. This requires
an MCC to be selected.

¢ Selecting CDFPilot performs tests using a pilot signal, however, the gain for the channel elements
is specified in the CDF file.

¢ Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the gain
for the channel elements is specified in the CDF file.

Save the result and download the BLO data to the target BBX(s):

— Click the Save Result button on the result screen.
The window closes automatically.

10

Logout from the BTS and close the LMF session:
— Click BTS>Logout to close the BTS connection.
— Close the LMF window.

11

Restore the new “bts—*.cal” file to the CBSC.

12

Enable the target device(s) from the CBSC.

H-18
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Transmit & Receive Antenna VSWR

Purpose

The following procedures will verify that the Voltage Standing Wave
Ratio (VSWR) of all antennas and associated feed lines fall within
acceptable limits. The tests will be performed on all antennas in a
sequential manner (i.e., ANT 1, then ANT 2) until all antennas/feedlines
have been verified.

These procedures should be performed periodically by measuring each
respective antenna’s VSWR (reflected power) to verify that the antenna
system is within acceptable limits. This will ensure continued peak
system performance.

The antenna VSWR will be calculated at the CDMA carrier frequency
assigned to each antenna. Record and verify that they meet the test
specification of less than or equal to 1.5:1.

NOTE

Motorola recommends that the installer be familiar with the
following procedure in its entirety before beginning the actual
procedure. Ensure that the entire site is currently not in service.

This test is used to test RX antennas by substituting RX
frequencies for TX frequencies.

Test equipment

Study the site engineering documents and perform the following tests
only after first verifying that the RF cabling configuration required to
interconnect the BTS frames and antennas meet requirements called out
in the BTS Installation Manual.

The following pieces of test equipment will be required to perform this
test:

e LMF
* Directional coupler

e Communications test set

WARNING Prior to performing antenna tests, insure that no CDMA BBX

channels are keyed. Failure to do so could result in personal
injury or serious equipment damage.
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Equipment Setup — HP Test Set

Follow the procedure irrJable I-1 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table I-1: VSWR Measurement Procedure — HP Test Set

Step Action HP TEST SET
1 If you have not already done so, refer to the procedure irrfable 3-5 on pagq3-17 to set up test
equipment & interface the LMF computer to the BTS.
2 For manual VSWR testing, using external directional coupler, refer tqdfigure I-1 (1700/1900 MHz)
orfjigure I-2 (800 MHz).
— Connect the communications test set RF OUT ONLY port to the INPUT port of the directional
coupler.
— Connect the RF IN/OUT port of the communication test set to the reverse (RVS) port on the
directional coupler. Terminate the forward port with a 50 ohm load.
— Install the antenna feed line to the output port on the directional coupler.
NOTE
Manual Communications Analyzer test setup (fields not indicated remain at default):
¢ Set screen to RF GEN.
— For 1900 MHz systems, set the RF Gen Freq to center frequency of actual CDMA carrier
between 1930-1990 MHz for TX and 1850-1910 MHz for RX. For 800 MHz systems, set the
RF Gen Freq to center frequency of actual CDMA carrier between 869-894 MHz for TX and
824-849 MHz for RX. For 1700 MHz systems, set the RF Gen Freq to center frequency of
actual CDMA carrier between 1840—-1870 MHz for TX and 1750-1780 MHz for RX.
— Set Amplitude to =30 dBm.
— Set Output Port to RF OUT.
— Set AFGenl & AFGen2 to OFF.
3 Remove the antenna feed line and install an “RF short” onto the directional coupler output port.
NOTE
Set—up communication test set as follows (fields not indicated remain at default):
* Set screen to SPEC ANL.
— Under Controls, set input port to ANT.
— Set Ref Level to —40 dBm.
— Under Controls, select Main, select Auxiliary.
— Under Controls, select AVG. Set Avg = 20.
4 — Record the reference level on the communications analyzer and Note as Pg for reference.
— Replace the short with the antenna feedline. Record the reference level on the communications
analyzer and Note for as Py reference.
— Record the difference of the two readings in dB.
... continued on next page
Oct 2003
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Table I-1: VSWR Measurement Procedure — HP Test Set
Step Action HP TEST SET
5 Calculate the VSWR per the equation shown to the right.
Where: KL
Rr@B) = Pa@Bm) — PgdBm) 1+ 10
PA = Power reflected from antenna VSWR = RL
Ps = Power reflected from short 1-10
A calculated value of —13.98 dB equates to VSWR of better than 1.5:1.

6 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in—line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

7 Repeat stepg3 througl for all remaining TX sectors/antennas.

8 Repeat stepg3 througl4 for all remaining RX sectors/antennas.

Figure I-1: Manual VSWR Test Setup Using HP8921 Test Set (1700/1900 MHz)
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Figure I-2: Manual VSWR Test Setup Using HP8921 Test Set (800 MHz)
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Equipment Setup — Advantest Test Set

Follow the steps iqj"able I-2 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table I-2: VSWR Measurement Procedure — Advantest Test Set

1 If you have not already done so, refer to the procedure irpfable 3-5 on pagq3-17 to set up test
equipment and interface the LMF computer to the BTS.
2 For manual VSWR testing using external directional coupler, refer tqijigure I-3.
— Connect the communications test set RF OUT port to the input port of the directional coupler.
— Connect the INPUT port of the communication test set to the forward port on the directional
coupler. Terminate the forward port with a 50 Ohm load.
— Connect the RF short to the directional coupler output port.
. .. continued on next page
Oct 2003
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ﬂable I-2: VSWR Measurement Procedure — Advantest Test Set

Step

Action ADVANTEST

Preform the following to instruct the calibrated test set to generate a CDMA RF carrier (RVL call)
with all zero longcode at the assigned RX frequency at —10 dBm:

* Push the ADVANCE Measurement key.
* Push the CDMA Sig CRT menu key.
* Push the FREQ Entry key:

— For 1900 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
1930-1990 MHz for TX and 1850-1910 MHz for RX.

— For 800 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
869-894 MHz for TX and 824-849 MHz for RX.

— For 1700 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
1840-1870 MHz for TX and 1750-1780 MHz for RX.

* Push the LEVEL Entry key; set to 0 dBm (by entering 0 and pushing the —dBm key).
® Verify that ON is active in the Output CRT menu key.
* Verify that OFF is active in the Mod CRT menu key.
* Push the CW Measurement key.
* Push the FREQ Entry key.
— Push the more 1/2 CRT menu key.
— Set Preselect CRT menu key to 3.0G.
* Push the Transient Measurement key.
— Push the Tx Power CRT menu key.
— Push the LEVEL entry key (set to 7 dBm by entering 7 and pushing the the dBm key).

— Set Avg Times CRT menu key to ON. Set to 20 (by entering 20 and pushing the Hz ENTER
key).
* Push the REPEAT Start key to take the measurement.

Record the Burst Power display on the communications analyzer and Note as Pg for reference.

Install the antenna feedline to the output port of the directional coupler.

* Push the Auto Level Set CRT menu key.
¢ Push the REPEAT Start key to take the measurement.

Record the Burst Power on the communications analyzer and Note as P level for reference.
Record the difference of the two readings in dBm.

Calculate the VSWR per the equation shown to the right.

Where: &

Rp@B) = Pa@Bm) — Pg(dBm) 1+10
Pa = Power reflected from antenna VSWR = A
Ps = Power reflected from short 1-102

A calculated value of —13.98 dB equates to VSWR of better than 1.5:1.

. continued on next page
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ﬂable I-2: VSWR Measurement Procedure — Advantest Test Set

Step Action ADVANTEST

If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in—line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement

information.
10 Repeat steps 2 through 9 for all remaining TX sectors/antennas.

11 Repeat steps 2 through 9 for all remaining RX sectors/antennas.

Figure I-3: Manual VSWR Test Setup Using Advantest R3465
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BTS Router Initial Configuration

Overview

This appendix contains information and operations related to loading an
MWR 1941 BTS router with the minimum standard (canned)
configuration necessary for network communications. Once the router is
communicating on the network, the full, site-specific, operational
configuration can be downloaded to the router over the network. This
appendix includes sections on:

¢ Terminal Setup

* Downloading canned BTS router configuration files

* Veritying IOS canned version of CF memory card

* Replacing installed BTS router CF memory card IOS version
® Verify and upgrade rommon version

¢ Recovery from BTS router boot to rommon

* Entering or changing router FE interface IP address

* Preparation for site turn—over

J-2 1X SC™ 4812T BTS Optimization/ATP Oct 2003
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Terminal Setup

General
This section provides the procedures to configure and save a terminal
session for communicating with the MWR 1941 BTS router. Terminal
settings are the same as those used for BTS card and module
Man-Machine Interface (MMI) communication sessions. The procedures
are for a Pentium® processor—based computer operating with either
Windows 98 Second Edition (SE) or Windows 2000.
Using the LMF computer
LMF computer platforms can be used for communicating with the
routers, and the MMI terminal connection created for BTS card/module
optimization actions will operate with the BTS routers. See the
“Establishing a BTS Router Communication Session” section of this
appendix for additional interface hardware required for BTS router
communication.
Terminal Settings
Follow the procedure irrfable J-1 to create a named HyperTerminal
connection for BTS router interface and generate a Windows desktop
shortcut for it.

NOTE There are differences between Windows 2000 and Windows 98 in
the menus and screens used for creating a HyperTerminal
connection. In the following procedure, items applicable to:

* Windows 2000 will be identified with Win2000
* Windows 98 will be identified with Win98
Table J-1: Establish HyperTerminal Connection
Step Action
1 From the Windows Start menu, select Programs > Accessories
2 Perform one of the following:
* For Win2000, select Hyperterminal and then click on HyperTerminal
* For Win98, select Communications, double click the Hyperterminal folder, and then double click
on the Hypertrm.exe icon in the window which opens.
NOTE
* If a Location Information Window appears, enter the required information, then click on the
Close button. (This is required the first time a HyperTerminal connection is configured, even if a
modem is not to be used.)
* If a You need to install a modem..... message appears, click on NO.
3 When the Connection Description box opens:
— Type a name for the connection being defined (for example, BTSRTR Session, MMI) in the
Name: window,
— Highlight any icon preferred for the named connection in the Icon: chooser window, and
— Click OK.
... continued on next page
Oct 2003
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[Table J-1: Establish HyperTerminal Connection

Step Action

4 From the Connect using: pick list in the Connect To box displayed, select the RS—232 port to be
used for the connection (e.g., COM1 or COM2 — Win2000 or Direct to Com 1 or Direct to Com 2 —
Win98), and click OK.

5 In the Port Settings tab of the COM# Properties window displayed, configure the RS—232 port
settings as follows:
* Bits per second: 9600
¢ Data bits: 8
¢ Parity: None
¢ Stop bits: 1
* Flow control: None

6 Click OK.

7 With the HyperTerminal window still open and the connection running, select:
File > Properties

8 Click the Settings tab, click the arrow in the Emulation window, and select VT100 from the
dropdown list.

9 Click the ASCII Setup button, uncheck all boxes in the ASCII Setup window which appears, and
click OK.

10 | Click OK for the connection Properties box.

11 Save the defined connection by selecting:
File > Save

12 | Close the HyperTerminal window by selecting:
File > Exit

13 Click the Yes button to disconnect when prompted.

14 | Perform one of the following:
* If the Hyperterminal folder window is still open (Win98), proceed to steg 36, or
* From the Windows Start menu, select Programs > Accessories

15 Perform one of the following:
* For Win2000, select Hyperterminal and release any pressed mouse buttons.
* For Win98, select Communications and double click the Hyperterminal folder.

16 | Highlight the newly—created connection icon by moving the cursor over it (Win2000) or clicking on it
(Win98).

17 | Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

18 | From the popup menu displayed, select Create Shortcut(s) Here.

. .. continued on next page
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[Table J-1: Establish HyperTerminal Connection

Step Action

19 | If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.
NOTE

The shortcut icon can now be double—clicked to open a BTS router or BTS card/module MMI
HyperTerminal session without the need to negotiate multiple menu levels.

BTS Router Serial Communication

For those procedures which require serial communication with BTS
routers, follow the procedures irpable J-2 to initiate the communication
session. This procedure calls out the LMF computer platform, but any
VT100-equivalent terminal or computer equipped with terminal
emulation software and a hardware serial connector may be used.

Required Items

The following items are required to perform the verification:

¢ [ MF computer platform or equivalent (see this manual for
requirements)

¢ Eight—conductor (four—pair, unshielded twisted pair is acceptable)
rollover cable, two 8—contact modular plugs (seqjigure J-1 for cable
wiring requirements)

¢ Adapter, DB-9 plug—to—8—contact modular plug, Global Computer
Supplies C4717 or equivalent (seqfigure J-2 for adapter wiring
requirements)

Figure J-1: Wiring Diagram, BTS Router Communication Rollover Cable

8—contact 8—contact
Modular Modular
Plug Plug
8-contact Plug 1 8
Contact Numbering

(Insertion End) 2 7

87654321 3 6
[T

4 5

= 5 4

\ 6 3

Locking
Clip 7 2
8 1
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Figure J-2: Wiring Diagram, DB-9 Plug—to—8—contact Modular Plug Adapter

8—contact
DB-9 Modular
Receptacle Receptacle
1 NC
Adapter Adapter
DB-9 Receptacle 2 6 8—contact Receptacle
Socket Numbering Contact Numbering
(Mating Side) 3 3 (Mating Side)
5 4321 4 2 12345678
O OO0 O
OO0 O
L,
9 876 6 7
7 1
8 8
9 NC
Table J-2: Establishing BTS Router Serial Communication
Step Action
1 If it has not been done, start the computer and allow it to complete boot—up.

2 If a named HyperTerminal connection for BTS router serial communication or BTS card/module MMI
communication has not been created on the LMF computer, create one as described irrFable J-1 in the
“Terminal Set—up” section of this appendix.

3 Connect the computer to the BTS router as shown irﬂigure J-3.

4 Start the named HyperTerminal connection for BTS router communication sessions by double clicking
on its Windows desktop shortcut.

NOTE

If a Windows desktop shortcut was not created for the communication session, access the connection
from the Windows Start menu by selecting:

Programs > Accessories > Hyperterminal > HyperTerminal > <Named HyperTerminal
Connection (for example, BTSRTR)>

5 Once the connection window opens, establish communication with the BTS router by pressing the
computer Enter key until the prompt identified in the applicable procedure is obtained.

-
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Figure J-3: LMF Computer Connections to BTS Router
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Downloading Minimum Canned BTS Router Configuration Files

Downloading Overview

After they are generated on the OMC-R, the BTS router canned
configuration files must be transferred to another computer platform
from which they can be installed into the BTS routers. A number of
procedures may be used to move the canned configuration files from the
OMC-R to a platform from which they can be loaded into the routers.
Some alternatives are:

1. If a floppy diskette drive is available at the OMC-R, such as the one
for UNO workstations, the configuration files can be transferred to
an LMF computer or similar machine using the CDF file transfer
procedure in the Preparing the LMF section of this manual.
Directories identified irjable J-3 must be used rather than those in
the CDF file transfer procedure.

2. If a Windows—based server connection is available in the operator’s
network and it can provide an FTP or telnet connection to the
OMC-R, files may be transferred by either the FTP or telnet
methods.

3. If a dial-up connection is available for accessing the OMC-R, an
FTP or telnet session may be possible to transfer files to the
computer used to load the CF memory cards.

The procedure provided in this section covers FTP transfer using a
Windows-based server in the operator’s network. Coordinate with the
local network administrator to determine the method and procedure to
use on a specific network.

Prerequisites

The following must be obtained from the local network administrator
before performing the canned configuration file FTP procedure in
[Jable J-3:

¢ User ID and password to log onto the OMC-R

* Name of the sub—directory where the specific BTS router group
canned configuration files to be downloaded were created

FTP File Transfer from the OMC-R

This procedure uses the Windows—based LMF computer platform to
download BTS router canned configuration files from the OMC-R.
Follow the procedure irrFable J-3.

Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step Action

1 If it has not been done, create a directory on the LMF computer where the BTS router canned
configuration files will be stored.

2 If it has not been done, obtain the OMC-R logon user ID and password from the local network
administrator.

... continued on next page

-

J-8 1X SC™ 4812T BTS Optimization/ATP Oct 2003



68P09258A31-A Downloading Minimum Canned BTS Router Configuration Files

[Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step

Action

Connect the LMF computer to the local network and log on.

NOTE

This procedure uses the command line FTP client supplied with Windows 98, Second Edition (Win98
SE) and Windows 2000 (Win2K); however, any commercially available FTP client application can be
used. Follow the manufacturer’s instructions for operation of an alternative application.

Open a command line (MS DOS) window by clicking on Start > Programs > Command Prompt.

When the command line window opens, change to the directory where the canned configuration files
will be stored on the LMF computer by entering:

cd pathname
Where pathname = the path to the required directory.
A response similar to the following will be displayed:

C:\> cd Can_Cfg
C:\Can_Cfg>

Check the contents of the directory by entering the following:
dir
A response similar to the following will be displayed:

C:\Can_Cfg>dir
Volume in drive C is MAIN
Volume Serial Number is F2AA—-1721

Directory of C:\Can_Cfg>

08/22/2002 03:46p <DIR>
08/22/2002 03:46p <DIR> .
08/22/2002 03:46p 2,223 btsrtr_canned.blue
08/22/2002 03:47p 2,223 btsrtr_canned.red
2 File(s) 4,644 bytes
2 Dir(s) 2,556,045,312 bytes free

C:\Can_Cfg>

If either or both of the following files are found in the directory, delete them or move them to another
directory:

® btsrtr_config.blue

® btsrtr_config.red

Begin the FTP session by entering the following:

ftp hostname
Where hostname = the OMC-R hostname or IP address.
A response similar to the following will be displayed:
C:\Can_Cfg> ftp OMCR-1
C:\Can_Cfg>
Connected to OMCR-1.

220 OMCR—1 FTP server (SunOS 5.6) ready.
User (OMCR—1:(none)):

. .. continued on next page
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Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step

Action

Enter the User ID and password when prompted, pressing the Enter key after each. A response
similar to the following will be displayed:

User (OMCR—1:(none)): scadm

331 Password required for scadm.
Password:

230 User scadm logged in.

ftp>

10

Change to the directory where the BTS router canned configuration file sub—directories are created and
verify the present working directory by entering the following, pressing the Enter key after each:

cd /home/scadm/btsrtr_canned_configs
pwd
A response similar to the following will be displayed:

ftp> cd /home/scadm/btsrtr_canned configs

240 CWD command successful.

ftp> pwd

245 "/home/scadm/btsrtr_canned_configs” is current directory.

11

Enter the Is command to list the contents of the directory and be sure the specific canned configuration
directory name provided by the administrator exists. A response similar to the following will be
displayed:

ftp> 1s

200 PORT command successful.

150 ASCII data connection for /bin/ls (10.182.29.117,80) (0 bytes).
Mon_Jul 2 01:55:07_CDT 2002

Wed _Jul 24 09:35:41 CDT 2002

Tue_Aug 04_10:35:22_CDT_2002

226 ASCII Transfer complete.

ftp: 30 bytes received in 0.02Seconds 1.50Kbytes/sec.

ftp>

NOTE

Directory names where canned configuration files are located will consist of the
weekday_month_day_time_year when the canned configuration files were created on the OMC—R.

12

Change to the directory specified for the BTS router group to be configured and list the directory
contents by entering the following, pressing the Enter key after each command:

cd weekday_month_day_time_year
Is
A response similar to the following will be displayed:

ftp> cd Wed_Jul 24 09:35:41_CDT 2002

250 CWD command successful.

ftp> 1s

200 PORT command successful.

150 ASCII data connection for /bin/ls (10.182.29.117,80) (0 bytes).
btsrtr canned.blue

btsrtr_ canned.red

226 ASCII Transfer complete.

ftp: 39 bytes received in 0.05Seconds 0.78Kbytes/sec.

ftp>

... continued on next page
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[Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step Action

13 Change to the binary transfer mode and, if desired, turn on hash mark printing for transfer progress by
entering the following, pressing the Enter key after each command:

bin

hash
A response similar to the following will be displayed:

ftp> bin

200 Type set to I.

ftp> hash

Hash mark printing On ftp: (2048 bytes/hash mark)
ftp>

NOTE

With Win98 SE, turning on hash mark printing can slow down file transfer in certain circumstances,
but the canned configuration files are quite small (approximately 2.5 KB) so there should be little
noticeable effect.

14 | Download the BTS router canned configuration files to the LMF computer by performing the following:

14a — Enter the following to download the first canned configuration file:
get btsrtr_canned.blue
A response similar to the following will be displayed:

ftp> get btsrtr canned.blue

200 PORT command successful.

150 Binary data connection for btsrtr canned.blue (10.182.29.117,80) (2223 bytes).
#

226 Binary Transfer complete.

ftp: 2223 bytes received in 0.59Seconds 3.76Kbytes/sec.

ftp>

14b — Enter the following to download the second BTS router canned configuration file:
get btsrir_canned.red
A response similar to the following will be displayed:

ftp> get btsrtr_canned.red

200 PORT command successful.

150 Binary data connection for btsrtr canned.red (10.182.29.117,80) (2223 bytes).
#

226 Binary Transfer complete.

ftp: 2223 bytes received in 0.59Seconds 3.76Kbytes/sec.

ftp>

... continued on next page
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Table J-3: BTS Router Canned Configuration File FTP Transfer from the OMC-R

Step Action
15 | Before terminating the FTP session, open Windows Explorer and view the contents of the directory
where the canned configuration files are to be stored to be sure the files are present. Perform the
following:
15a — Click Start > Programs > Windows Explorer.
15b — In the left-hand pane of Windows Explorer, perform one of the following depending on the LMF
computer operating system:
— Win98 SE: If necessary, expand the directory display for the drive where the canned configu-
ration file storage directory is located by clicking on the + next to the drive icon.
— Win2K: Expand the user profile and directory display for the drive where the canned configu-
ration file storage directory is located by clicking on the + next to each icon, respectively.
15¢ — Expand any sub—directories as required to display the directory folder where the canned
configuration files are to be stored.
15d — Click on the directory folder icon where the canned configuration files are to be stored.
15¢ — In the right~hand pane, verify that the files btsrtr canned.blue and btsrtr_canned.red
appear.
15f — If the files appear, proceed to ste36.
15¢ — If the files do not appear, repeat steg 4, its sub—steps, ste}5 and its sub—steps.
16 | Close Windows Explorer, and, in the command line window, enter the bye command to terminate the
FTP session. A response similar to the following will be displayed:
ftp> bye
221 Goodbye.
C:\Can_Cfg>
17 | Close the command line window by entering the exit command.
18 | BTS router canned configuration files are now ready for transfer to a BTS router.
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Verifying I0S Canned Version of the CF Memory Card

Overview

This section covers the procedures and commands required to verify the
IOS version loaded on BTS router CF memory cards and copy standard
canned configuration files to the routers. Because of the set—up required
and the length of some of the procedures, Motorola recommends
performing the actions covered in this section at a central location to
prepare the BTS routers for installation prior to the site visit.

I0S Version Verification and File Sequence Position

Version verification — The 10S version loaded on the BTS router CF
memory card should be verified as the version required for operation on
the network where the routers will be installed. If the loaded 10S version
is not correct, it can be replaced with a different version. There are
several methods available to accomplish version verification. These
depend on the equipment and software applications the user selects to
use in installing the canned configuration files in the BTS routers.
Appropriate verification procedures are included in each of the two
canned configuration installation methods covered in this section.
Methods to change the loaded IOS version are provided in the Change
BTS Router I0S Version section of this appendix and are referenced at
the appropriate places in the canned configuration installation methods.

File sequence position — During initialization, the MWR 1941 router
will first search the startup—config file for a boot system command
line telling it in what directory and file to find the boot loader. If this line
is not found, the router will default to attempting to boot from the first
file in its flash memory. Flash memory for the MWR 1941 is the CF
memory card (software identifier slot0:). The canned configuration files
used for BTS router installation do not contain a boot system command
line because of the need to maintain flexibility for IOS version changes.
Because of this, it is critical that the IOS file is the first file listed on the
CF memory card. The canned configuration installation procedures
contain steps to assure that this is the case, and, if it is not, provide
guidance to correct the condition. It is important to remember that, if the
router boots and displays a rommon 1 > prompt, the IOS file is
missing, out of sequence, has a corrupted flash memory image or the
startup—config file contains a boot system line which specifies a
missing or incorrect IOS pathname/filename.

Canned Configuration File Installation

Filename and installation location requirements — The canned
configuration files for the BTS routers must be copied to the CF memory
card. The filename of the file on the CF memory card must be
canned—config. Canned configuration file location and filename
requirements are a result of Mobile Wireless Center (MWC) actions
during the process of switching a BTS from packet to circuit mode. In
this process, the MWC will query the BTS routers’ slotO: directory for a
file named canned—config. A missing or mis—named file will cause
problems with execution of the mode—switching process.
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Installation Methods — The startup—config configuration file used
by the BTS router during initialization is stored in NVRAM. This is a
memory device internal to the router and is separate from the CF
memory card. To install the canned configuration file so the router will
use it during boot—up, the file must be copied into the
startup—config file in NVRAM. There are two methods available to
accomplish this:

1. Using a tftp server application to copy the canned configuration file
from the Windows—based LMF computer to the CF memory card
installed in a router, and then copying it to the startup—config
file in the router’s NVRAM

2. Using a CF memory card reader to copy the canned configuration
file to a CF memory card, and then, once the CF memory card is
installed in the router, using a HyperTerminal communication
session to copy the file from the CF memory card to the
startup—config file in the router’s NVRAM

Comparison of methods — Preparation for using the tftp server
application method is extensive and requires setting up simultaneous
serial and FE communication sessions with the router. This method
offers the advantage of being able to verify 10S file sequence position
immediately and supporting direct file transfers between the router and
LMF computer without removing the CF memory card. As an
alternative, using a CF memory card reader to copy the canned
configuration file to a CF memory card, and from there to the
startup—config file requires very little set—up. With this method, the
IOS file sequence position can only be verified once the CF memory
card is installed in the router, and any file transfers between the router
and LMF computer require physically moving the CF memory card
between the router and card reader.

Procedures to use each method — Using the tftp server application to
copy the canned configuration file to a CF memory card is covered in the
Method 1 subsection. Performing the transfer process with a card reader
is covered in the Method 2 subsection. The applicable procedures for
verifying the loaded IOS version and file sequence position are included
in each method.

File operations using a CF memory card reader — Only file transfers
should be performed using the CF memory card reader. CF memory card
formatting should be performed in a BTS router using a HyperTerminal
connection. Attempting to format a CF memory card from a
Windows—based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a
Windows—based computer. Only format CF memory cards in a
BTS router.
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Method 1: Using a TFTP Server to Load to CF Memory Card

Required Equipment and Software

The following items are required to perform this procedure:

* A Windows-based computer which meets the requirements of the
LMF computer platform as specified in this manual.

* One of the following operating systems for the Windows—based
computer:

— Windows 2000
— Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

* One of the following for the Windows—based computer:
— Internal 10/100baseT Network Interface Card (NIC)
— PCMCIA 10/100baseT NIC

* (Cable, Ethernet crossover, Category SE or better, unshielded twisted
pair, two 8—contact modular plugs, in one of the following lengths, as
determined necessary:

— 0.3 m (11.8 in) (Motorola pn 3088643C07)
— 0.6 m (23.6 in)(Motorola pn 3088643C13)
— 1.0 m (39.4 in) (Motorola pn 3088643C15)
— 2.1 m (84 in) (Motorola pn 3088643C08)

— 3.0 m (120 in) (Motorola pn 3088643C09)

* Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

* DB-9 plug—to—8—contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

* A tftp server software application (refer to the Setting Up the TFTP
Server — Procedure in Cellular System Administration — CDMA
OnLine Documentation) such as:

— Cisco tftp server
— PumpKIN tftp server
— Any other equivalent tftp server application

* A copy of the MWR 1941 router 10S version required for the network
where the routers are to be installed (contact the network administrator
or the Motorola account team for information on obtaining the
required MWR 1941 IOS version)

* A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Materials

The following material is required to perform this method:

* Marking material to identify the BTS router and CF memory card with
the installed configuration (blue or red) J
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Required Publications

The following publications are required to perform procedures in this
section:

* this manual
* Cellular System Administration — CDMA OnLine Documentation

* MWRI1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78—13983-01

Preparation for Canned Configuration File TFTP
Transfer to CF Memory Card

Preparation for a canned configuration file tftp transfer consists of the
following activities:

1. Setting the LMF computer NIC IP address

2. Creating a directory (folder) on the LMF computer to be used for all
tftp file transfers

3. Installing the tftp server application on the LMF computer, and
setting the tftp server application root directory to the directory
created in 2, above

4. Connecting the LMF computer to the BTS router for both
HyperTerminal (serial) and Ethernet communication

5. BTS router power—up and initial configuration for Ethernet
communication

The following procedures are used to accomplish all of these preparatory
actions.

Set LMF computer NIC TCP/IP address and create the default
TFTP directory — Follow the procedure irjable J-4 to set the NIC IP
address.

NOTE

IMPORTANT! If the IP address for the LAN connection on an
LMF computer is being changed to support tftp downloads to a
BTS router, the BTS 10base—2 LAN IP address and subnet mask
for the NIC must be restored before the LMF can log into a BTS
to perform an optimization or ATP.

NOTE

There are differences between Windows 2000 and Windows 98 in
the menus and screens used for setting or changing a NIC
connection. In the following procedure, items applicable

to: Windows 2000 will be identified with Win2000Windows 98
will be identified with Win98
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Table J-4: Set LMF Computer NIC IP Address and Create a Default TFTP Directory

Step

Action

Start the computer.

Login and allow the computer to boot to the desktop.

Depending on the installed operating system, from the Windows Start menu, select one of the
following:

* Win2000: Settings > Network and Dial-up Connections
* Win98: Settings > Control Panel and double—click Network.

Perform one of the following as applicable for the installed operating system:

* For Win2000, in the list of displayed connections, locate the Local Area Network connection for the
NIC to be used for BTS router Ethernet communication.

* For Win98, in the Configuration tab of the Network dialog box, locate the TCP/IP connection for
the installed NIC.

— If TCP/IP does not appear in the displayed list of installed network components, refer to the
operating system documentation and install TCP/IP.

Perform one of the following as applicable for the installed operating system:

* For Win2000, highlight the connection for the NIC and right click the highlighted connection, and
select Properties from the pop—up menu.

* For Win98:
— Highlight the TCP/IP NIC connection in the displayed list of installed network components.
— Click the Properties button.

— Skip to stef§.

For Win2000 , in the Local Area Connection Properties dialog box which appears, if Internet
Protocol (TCP/IP) is not showing in the Components checked are used by this connection: listbox,
refer to the operating system documentation and install TCP/IP.

For Win2000, if the checkbox next to the Internet Protocol (TCP/IP) entry is not checked, click in the
box to check it.

Perform one of the following:

* Win2000: Highlight the Internet Protocol (TCP/IP) entry, and click on the Properties button below
the Components checked are used by this connection: listbox.

* Win98: From the tabs displayed in the TCP/IP Properties dialog box which opens, select the IP
Address tab if it is not at the front.

. .. continued on next page
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[Table J-4: Set LMF Computer NIC IP Address and Create a Default TFTP Directory

Step Action
9 In the Internet Protocol (TCP/IP) Properties dialog box which appears (Win2000) or the IP Address
tab of the TCP/IP Properties dialog box (Win98), perform the following:
9a — If a black dot is not showing in the the radio button circle next to Use the following IP address:
(Win2000) or Specify an IP address (Win98), click on the radio button.
— A black dot will appear in the circle.
9b — If using an LMF computer, record the IP address and subnet mask used for LMF-BTS
communication so they can be re—entered when tftp transfer activities for the BTS router are
completed.
9¢ — Enter 100.100.100.1 in the IP address: box.
9d — Enter 255.255.255.252 in the Subnet mask: box.
10 | Click the OK button for the Internet Protocol (TCP/IP) Properties dialog box (Win2000) or the
TCP/IP Properties box (Win98).
11 | Click the OK button for the Local Area Connection Properties box (Win2000) or the Network box
(Win98).
12 In Win98, click File > Close to close the Control Panel window.
13 | Click Start > Programs > Windows Explorer to open Windows Explorer.
14 | If the default tftp directory will be the same directory in which the files downloaded from the OMC-R
are stored, proceed to steHjZ.
15 | In the left-hand pane of Windows Explorer, locate the icon for the drive where the default tftp
directory is to be created.
16 | Highlight the drive icon and click Files > New > Folder.
17 | While observing the new folder icon in the right—hand pane, type the name for the folder (for example,
tftp_files), and press the Enter key.
18 | In Windows Explorer, locate the directory where the canned configuration files downloaded from the
OMC-R are stored.
19 | In the left-hand pane, highlight the directory where the files are stored.
20 | Scroll the left—hand pane until the newly—created default tftp directory is visible.
21 In the right—hand pane, highlight the canned configuration files and drag them to the default tftp
directory.
22 | In the left—hand pane, click on the default tftp directory, and verity that the canned configuration files
appear in the right—hand pane.
23 | Load a copy of the required BTS router IOS version into the default tftp directory using FTP, internet
download, or media such as a Zip disk (file size is over 7 MB).
24 | Click Files > Close to close Windows Explorer.
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Install and configure tftp server application

To obtain, install, and configure the Cisco or PumpKIN tftp software
applications, refer to the Setting Up the TFTP Server — Procedure in
Cellular System Administration — CDMA OnLine Documentation For
other tftp server applications, install and configure the application
according to the manufacturer’s instructions.

NOTE Important: When entering the name of the tftp server root
directory while configuring the tftp server application, be sure to
use the name of the directory identified iqj“able J-4, steq:]l4, or
created irlj"able J-4, steq:]ﬂ, above.

Connect the LMF computer to the BTS router

Connect the LMF computer to the BTS router by following the
procedure irﬂable J-5 and referring tqjigure J-4..

Figure J-4: LMF Computer TFTP Connections to BTS Router
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Table J-5: Connecting the LMF Computer to the BTS Router for TFTP File Transfer

Step Action

1 If the BTS router has not been connected to a power source, be sure the +27 Vdc power source is not
on, and connect it to the router.

2 Connect the LMF computer to the BTS router as shown iy igure J-4, referring to the list of required
equipment in this section as required.

3 If the LMF computer has not been started, turn it on, login, and allow it to boot to the desktop.

4 Refer to the procedure iqj"able J-2 of this appendix, and start a HyperTerminal communication session
for the BTS router.

5 Start the tftp server application as specified for the software (refer to the Setting Up the TFTP Server —
Procedure in Cellular System Administration — CDMA OnLine Documentation or the manufacturer’s
instructions).

BTS router power—up and initial configuration for
Ethernet communication
Follow the procedure irrJable J-6 to apply power to the router and set
an initial configuration for Ethernet communication.
* The required version of the IOS is loaded on the CF memory card
* The CF memory card is installed in the BTS router
Table J-6: BTS Router Power—up and Initial Ethernet Configuration
Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1

Be sure a CF memory card loaded with the Cisco IOS is installed in the BTS router (refer to the BTS Router
Card and Module Replacement section of the 1X SC 4812T BTS FRU Guide 68P09258A64 for instructions
to access the CF memory card slot).

* IMPORTANT

In this step do not touch the computer keyboard until the router completes the boot process. The router
will buffer any keystrokes made during the boot process and interpret them as commands to be
executed immediately following boot completion.

Apply power to the router and allow it to complete boot—up.

If a message similar to the following, is displayed, press the Enter key and proceed to stegJ:

Press RETURN to get started!

... continued on next page
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Table J-6: BTS Router Power—up and Initial Ethernet Configuration

Step

Action

If a message similar to the following, is displayed type no and press the Enter key:

Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system

Would you like to enter basic management setup? [yes/no]:

A response similar to the following will be displayed:

Would you like to enter basic management setup? [yes/no]: no
Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(20020127:101239
Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Sun 27—Jan—02 06:08 by walrobin

Router>

At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:
enable

A response similar to the following will be displayed:

Router>enable
Router#

At the Router# privileged EXEC mode prompt, enter the following to access the configure submode:
configure terminal

A response similar to the following will be displayed:

Router#conf t

Enter configuration commands, one per line. End with CNTL/Z.

Router (config)#

The router is now in the global configuration mode and ready to accept configuration changes entered
from the keyboard.

... continued on next page
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Table J-6: BTS Router Power—up and Initial Ethernet Configuration

Step Action

7 At the global configuration mode prompt, type each of the following commands, pressing the Enter
key after each command:

hostname btsrtri
interface fa0/0

ip address 100.100.100.2 255.255.255.252
speed 100
duplex full

no shutdown

line con 0
exec—timeout 0 0
no login

line vty 0 4

no login

Responses similar to the following will be displayed:

Router (config)#hostname BTSRTR1
BTSRTR1 (config)#interface £a0/0
BTSRTR1 (config—if)#ip address 100.100.100.2 255.255.255.252
BTSRTR1 (config—if)#speed 100

BTSRTR1 (config—if)#duplex full
BTSRTR1 (config—if)#no shutdown
BTSRTR1 (config—if)#line con 0

BTSRTR1 (config—line)#exec—timeout 0 0
BTSRTR1 (config—line)#no login

BTSRTR1 (config—line)#line vty 0 4
BTSRTR1 (config—line)#no login

BTSRTR1 (config—line)#

8 Once the correct parameters have been set, return to the privileged EXEC mode prompt by holding
down the Ctrl key and pressing z (Ctrl+z). A response similar to the following will be displayed:

BTSRTR1 (config—line)# "z
01:11:27: %SYS—5—CONFIG I: Configured from console by console
BTSRTR1#

NOTE

Entering exit twice, pressing the Enter key after each entry, will also complete the configuration
process and return the router to the privileged EXEC mode.

9 Verify port FE 0 (fa0/0) is configured with the correct IP address by entering the following:
show ip interface brief

A response similar to the following will be displayed:

BTSRTR1#sh ip int br

Interface IP Address OK? Method Status Protocol
FastEthernet0/0 100.100.100.2YES manual up up
Serial0:0 unassigned YES unset administratively down down
FastEthernet0/1 unassigned YES unset administratively down down
Seriall:0 unassigned YES unset administratively down down
BTSRTR1#

10 | The router is now configured for Ethernet communication on FE 0, and the canned configuration file
can be transferred by tftp. Proceed tqjable J-7.
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Verifying 10S Version and Canned Configuration File
TFTP Transfer to the BTS Router

Prerequisites — The following is required prior to performing this
procedure:

* A copy of the required MWR 1941 router 10S version file is installed
in the default tftp directory (transfer the file to the LMF computer
using FTP, internet download, or media such as a Zip disk; file size is
approximately 7-8 MB)

I0S verification and canned configuration file transfer — Follow the
procedure irrJable J-7 to verify the loaded IOS version and transfer the
canned configuration files from the LMF computer to the BTS router CF
memory card.

NOTE IMPORTANT: MWR 1941 routers must be loaded with IOS
version mwr1900—i—mz.122-8.MC2d.bin or later. This router
model will not function properly with earlier IOS versions.

NOTE This procedure does not cover all aspects of BTS router
operation and programming. Before performing this procedure,
review BTS router initialization, operation, and programming
information and procedures in MWR1941 Wireless Mobile Edge
Router Software Configuration Guide; part number
78—13983-01. Have this publication available for reference
while performing this procedure.

Table J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step

Action

CAUTION

If personal firewall and/or intrusion detection software such as Black ICE is running on the LMF computer,
shut it down before performing this procedure. If this is not done, the tftp transfer process will not operate.

1

On the LMF computer, if it has not been done, start the tftp server according to the manufacturer’s
directions (refer to the Setting Up the TFTP Server — Procedure in the Cellular System Administration
— CDMA OnlLine Documentation).

* IMPORTANT

MWR 1941 routers must be loaded with I0S version mwr1900—i—-mz.122-8.MC2d.bin or later. This
router model will not function properly with earlier IOS versions.

If a HyperTerminal communication session with the BTS router is not running, start one following the
procedure irffable J-2.

In the HyperTerminal window, the router must be in the privileged EXEC mode, as indicated by a
number sign at the end of the prompt:

BTSRTR1#

Be sure the Ethernet crossover cable is connected between the LMF computer NIC port and the BTS
router FE 0 port (seqigure J-4).

... continued on next page
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[Fable J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action
5 Begin verification that the CF memory card contains the correct version of the Cisco IOS by entering
the following:
dir slot0:

A response similar to the following will be displayed:

BTSRTR1#dir slotO0:
Directory of slot0:/

1 —rw— 7051976 Mar 01 1993 00:11:34 mwrl941-i—mz.122—8.MC2a.bin

31932416 bytes total (24879104 bytes free)
BTSRTR1#

NOTE

1. The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the ¢d command. Determine the present working directory by entering pwd.
If the present working directory has been changed, enter the command cd slot0: to return to the
default setting.

2. If slot0: is included in the command, be sure to include the colon (:) after slot0 when typing the
command.

3. The IOS filename will be similar to the following:
mwr1941-i-mz.122-8.MC2a.bin

. .. continued on next page
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[Fable J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step

Action

Direct the router to show the version information by entering the following:
show version

A response similar to the following will be displayed:

BTSRTR1#sh ver

Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE
SOFTWARE (fcl)

TAC Support: http://www.cisco.com/tac

Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Mon 05—Aug—02 11:07 by nmasa

Image text—base: 0x60008940, data—base: 0x60B54000

ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose—wilma 109], DEVELOPMENT
SOFTWARE

ROM: 1941 Software (MWR1941-I-M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fcl)

Router uptime is 1 minute
System returned to ROM by power—on
System image file is ”slot0:mwrl941—i—mz.122—8.MC2a.bin”

cisco mwrl941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS

R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.

X.25 software, Version 3.0.0.

Primary Rate ISDN software, Version 1.1.

Toaster processor tmc is running.

2 FastEthernet/IEEE 802.3 interface(s)

2 Serial network interface(s)

2 Channelized T1/PRI port(s)

DRAM configuration is 64 bits wide with parity disabled.

55K bytes of non—volatile configuration memory.

31360K bytes of ATA Slot0 CompactFlash (Read/Write)

Configuration register is 0x101

BTSRTR1#

Compare the I0S filename returned in steg S and the second line of the version information in steg§.
Note the correspondence between the filename and 10S version information.

If the IOS filename from the CF memory card returned in stepq is different than the filename of the
required IOS version loaded in the LMF computer default tftp directory, perform the procedure in
[Jable J-13 to load the required version, and then return to ster§, below.

. .. continued on next page
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[Fable J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action
CAUTION
The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.
9 If the IOS version is correct and there is more than one file loaded on the CF memory card, be sure the
1OS file is the first file listed in the directory content display. If it is not, perform the following:
9a — Backup all files on the CF memory card to the LMF computer default tftp directory by performing
stepg ] througl30 ofJable J-13.
9b — Perform stepg35 through39 ofJable J-13, as applicable.
9c — Type the following to delete a possible boot system line in the startup—config file, pressing the
Enter key after the command and at each prompt to confirm the filename and deletion operation:
del nvram:startup—config
A response similar to the following will be displayed:
BTSRTR1#del nvram:startup—config
Delete filename [startup—config]?
Delete nvram:startup—config? [confirm]
[OK]
BTSRTR1#
NOTE
Be sure to include the colon (:) after nvram when typing the command.
9d — Verify the startup—config file size has been reduced to a minimum by entering the following:
dir nvram:
A response similar to the following will be displayed:
Router#dir nvram:
Directory of nvram:/
53 —rw— 5 <no date> startup—config
54 5 <no date> private—config
57336 bytes total (57274 bytes free)
BTSRTR1#
10 | At the privileged EXEC mode prompt, enter the following:
copy tftp:btsrtr_canned.color slot0:canned—config
Where color = blue or red, as applicable.
A response similar to the following will be displayed:
BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config
Address or name of remote host []?
. .. continued on next page
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[Fable J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step

Action

11

At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:
100.100.100.1

A response similar to the following will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config

Address or name of remote host []? 100.100.100.1
Destination filename [canned—config]?

12

At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config

Address or name of remote host []? 100.100.100.1

Destination filename [canned—config]?

Loading btsrtr canned.blue from 100.100.100.1 (via Ethernet0/0): !
[OK — 2457/4096 bytes]

2457 bytes copied in 84.724 secs (29 bytes/sec)
BTSRTR1#

13

Verify that the canned configuration file is saved on the CF memory card by entering dir command. A
response similar to the following will be displayed:

Directory of slot0:/

1 —rw— 7051976 Mar 01 1993 00:11:34 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2457 Mar 01 1993 00:14:48 canned-config

31932416 bytes total (24877983 bytes free)
BTSRTR1#

14

To allow the BTS router to boot using the canned configuration, enter the following:
copy canned-config startup—config

A response similar to the following will be displayed:

BTSRTR1#copy canned—config start
Destination filename [startup—config]?

15

When prompted for the destination file name, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy canned—config start
Destination filename [startup—config]?
2457 bytes copied in 3.52 secs
BTSRTR1#

16

Display and note the file size of startup—config by entering the following:
dir nvram:

A response similar to the following will be displayed:
Directory of nvram:/

26 —rw— 2457 <no date> startup—config
27 5 <no date> private—config

29688 bytes total (24774 bytes free)
BTSRTR1#

. .. continued on next page
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[Fable J-7: Transfer Canned Configuration Files to the BTS Router Using a TFTP Server

Step Action

17 | Scroll the HyperTerminal window back to the slot0: directory display obtained in ste 33, above.

18 | Compare the file size of startup—config to the canned configuration file to verify the copy operation.
File sizes should be the same.

19 | If desired, the contents of the startup—config file may be verified against the file listings at the end of
this appendix for the blue or red canned configuration, as applicable, by entering the following:

show startup—config
NOTE
Pressing the space bar at the MORE prompt will scroll another screen—full of data. Pressing the Enter
key will scroll the screen one line at a time.

20 | Verify the router will boot properly on the IOS and revised startup—config files by entering the
following:

reload
A response similar to the following will be displayed:
BTSRTR1#reload
System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

21 If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

22 | When prompted to proceed with reload, press the Enter key to continue the reload operation.

23 | Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations. If the router boots to the rommon prompt, proceed to the Recovery from BTS Router
Boot to rommon section of this appendix.

24 | Using the tagging materials, tag the router to clearly identify the installed configuration (blue
(BTSRTR1) or red (BTSRTR?2)).

25 | Remove the CF memory from the router following the procedure in the 1X SC 4812T BTS FRU Guide
, mark the installed configuration (blue or red) on the card label, and install the card in the router
following the procedure in the FRU Guide.

26 | If an additional router must have the canned configuration installed, perform the following:

26a — Disconnect the cabling from the BTS router.

26b — Remove power from the router and disconnect it from the power supply.

26¢ — Repeat the procedures iqj"able J-5(Fable J-6, and this table ﬂable J-7) using the additional router.

27 | If no additional routers must be configured, perform stepg36a and36b.

28 | On the LMF computer, shut down the tftp server application and exit the HyperTerminal session.

29 | If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask
back to those for LMF-BTS communication recorded iqj"able J-4, steﬂﬁb.

CAUTION
If the BTS 10base—2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.
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Method 2: Using a CF Memory Card Reader to Load CF Memory Card

Required Equipment and Software

The following items are required to perform this procedure:

* A Windows-based computer which meets the requirements of the
LMF computer platform as specified in this manual.

* One of the following operating systems for the Windows—based
computer:

— Windows 2000
— Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

* Compact Flash memory card reader device and software driver for the
operating system installed on the LMF computer

CAUTION Card readers for other non—volatile, solid—state memory devices
such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

* Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

* DB-9 plug—to—8—contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

* A copy of the MWR 1941 router 10S version required for the network
where the routers are to be installed (contact the network administrator
and the Motorola account team for information on obtaining the
required MWR 1941 IOS version)

* A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Materials

The following material is required to perform this method:

* Tagging and marking material to identify the BTS router and CF
memory card with the installed configuration (blue or red)

Required Publications

The following publications are required to perform procedures in this
section:

* Cellular System Administration — CDMA OnLine Documentation

* MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78—13983-01

File Operations Using a CF Memory Card Reader

Only file transfers should be performed using the CF memory card
reader. CF memory card formatting should be performed in a BTS router J
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using a HyperTerminal connection. Attempting to format a CF memory
card from a Windows—based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a

Windows—based computer. Only format CF memory cards in a
BTS router.

Verifying 10S Version and Loading BTS Router Canned
Configuration File to CF Memory Card Using a CF
Memory Card Reader

The process of transferring a canned configuration file to a BTS router
using a CF memory card reader consists of the following activities:

1. Transfer the canned configuration file to the router’s CF memory
card using a CF memory card reader

2. Copy the file from the CF memory card to the router’s
startup—config file

The following procedures are used to accomplish these actions.

Prerequisites

The following is required prior to performing this procedure:

* A copy of the required MWR 1941 router 10S version file is installed
in the default tftp directory (transfer the file to the LMF computer
using FTP, internet download, or media such as a Zip disk; file size is
approximately 7-8 MB)

Verifying 10S version and transferring canned
configuration file to the router’s CF memory card

NOTE

IMPORTANT: MWR 1941 routers must be loaded with IOS
version mwr1900—i—mz.122-8.MC2d.bin or later. This router
model will not function properly with earlier IOS versions.

Transfer canned configuration files from the LMF computer to a BTS
router CF memory card by following the procedure irrable J-8.

Table J-8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step

Action

* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 If it has not been done, install a CF memory card loaded with the IOS in the BTS router by following the

procedure in the 1X SC 4812T BTS FRU Guide .

* IMPORTANT

MWR 1941 routers must be loaded with I0S version mwr1900—i—-mz.122-8.MC2d.bin or later. This
router model will not function properly with earlier IOS versions.

... continued on next page
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Fable J -8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step

Action

2

Connect the LMF computer to the BTS router and start a HyperTerminal communication session with
the router by following the procedure irjable J-2.

If it has not been done, be sure the +27 Vdc power supply output is OFF, and connect the BTS router
to the +27 Vdc power supply.

* IMPORTANT

In this step do not touch the computer keyboard until the router completes the boot process. The router
will buffer any keystrokes made during the boot process and interpret them as commands to be
executed immediately following boot completion.

Apply power to the router and allow it to complete boot—up.

If a message similar to the following, is displayed, press the Enter key and proceed to steg7:

Press RETURN to get started!

If a message similar to the following, is displayed type no and press the Enter key:

Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system

Would you like to enter basic management setup? [yes/no]:

A response similar to the following will be displayed:

Would you like to enter basic management setup? [yes/no]: no

Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(20020127:101239
Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Sun 27—Jan—02 06:08 by walrobin

Router>

CAUTION

Use only a card reader specifically designed for CF memory cards to perform this procedure. Card
readers for other non—volatile, solid—state memory devices such as Smart Media cards will not work
with the CF memory cards used in the MWR 1941 routers.

If it has not been done, follow the CF memory card reader manufacturer’s instructions to load the CF
memory card driver application for the operating system being used onto the LMF computer.

Connect the CF memory card reader to the LMF computer following the card reader manufacturer’s
instructions.

Remove the CF memory card from the BTS router by following the procedure in the
1X SC 4812T BTS FRU Guide

10

Insert the CF memory card into the card reader as specified by the card reader manufacturer’s
instructions.

11

On the LMF computer, click Start > Programs > Windows Explorer to open Windows Explorer.

... continued on next page
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Fable J -8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step Action
12 | NOTE
The CF memory card reader will appear as a disk drive in Windows Explorer with a disk drive letter
and icon.

Scroll the left—hand pane of Windows Explorer to locate the icon for the CF memory card.

13 | Verify that the CF memory card contains the required version of the IOS by performing the following:

13a — In the left-hand pane of WindowsExplorer, highlight the CF memory card icon.
13b — In the right-hand pane, note the IOS filename loaded on the card, and record it.
NOTE

The IOS filename will be similar to mwr1941-i-mz.122-8.MC2a.bin.

14 | Scroll the left-hand pane of Windows Explorer to locate the icon for the directory where the canned
configuration files downloaded from the OMC-R and required IOS version are stored.

15 | In the left-hand pane, highlight the directory where the files are stored.

16 | In the the right—hand pane, locate the filename of the required IOS version and compare it to the
filename recorded in stepl:]pb, above.

17 | If filenames are different, proceed tqjable J-11 to replace the IOS on the CF memory card and return
to steqj& below.

18 | In the right—hand pane, highlight the canned configuration file to be transferred to the CF memory
card and drag it to the CF memory card disk drive icon.

19 | Verify the canned configuration file has been copied to the CF memory card by clicking on the CF
memory card disk drive icon in the left-—hand pane, and verifying that the canned configuration file
appears in the in the right—hand pane.

NOTE

Do not be concerned if the canned configuration file appears before the 10S file in the file sequence
displayed by Windows Explorer. The position of the 10S file in the sequence of files on the CF
memory card can not be verified until the CF memory card is installed in the BTS router.

20 | With the CF memory card disk drive icon still selected, change the name of the canned configuration
file on the card to canned—config by doing the following:

20a — In the right~hand pane of Windows Explorer, click on the canned configuration filename.
— The filename will be highlighted.
20b — Wait approximately two seconds, and then click on the canned configuration file filename again.
— A hair-line rectangle will appear around the highlighted filename.
20c — After the rectangle appears around the highlighted filename, type the following:
canned-—config
20d — Press the Enter key or click on the canned configuration file icon.

— The rectangle around the canned configuration filename will disappear and the filename will
remain highlighted.

21 Click Files > Close to close Windows Explorer.

... continued on next page
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[Table J -8: Transfer Canned Configuration File to CF Memory Card with CF Memory Card Reader

Step Action

22 | Remove the CF memory card with the IOS version and canned configuration file from the card reader,
and mark the card label with the canned configuration (blue or red) copied to it.

23 | Install the CF memory card in the BTS router by following the procedure in the 1X SC 4812T BTS
FRU Guide .

24 | Proceed tqJable J-9 to copy the canned configuration from the CF memory card to the BTS router’s
startup—configfile

Copy Canned Configuration File from the CF Memory
Card to the BTS Router’s Startup Configuration and
verify 10S file sequence

To allow the BTS router to automatically boot using the canned
configuration, the configuration must be copied to the the router’s
startup—config file in NVRAM. Follow the procedure iqj"able J-9 to
accomplish this.

Table J-9: Copy Canned Configuration File to BTS Router Startup
Configuration and Verify 10S File Position

Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 If it has not been done, install the CF memory card with the canned configuration and required I0S
version in the BTS router by following the procedure in the 1X SC 4812T BTS FRU Guide .

2 At this point, the router should be powered up and displaying the Router> prompt in the
HyperTerminal window of the LMF computer communication session. If it is not, perform stepg

througlr§ of Jable J-8.
3 At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:

enable
A response similar to the following will be displayed:

Router>enable
Router#

... continued on next page
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[Table J -9: Copy Canned Configuration File to BTS Router Startup
Configuration and Verify I0S File Position

Step Action

4 NOTE

The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the ed command. Determine the present working directory by entering pwd. If
the present working directory has been changed, enter the command cd slotO: to return to the default

setting.

Display the directory listing of the CF memory card by entering the following:
dir
A response similar to the following will be displayed:

Router#dir slotO0:
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned-config

31932416 bytes total (24885606 bytes free)
Router#

5 Be sure the [0S file is the first file listed in the directory content display. If it is not, perform the
procedure ir‘j"able J-12, and then return to steqj, below.

6 Copy the canned configuration to the BTS router’s startup configuration file by entering the following:
copy slot0:canned—config startup—config

A response similar to the following will be displayed:

Router#copy slot0:canned—config start
Destination filename [startup—config]?

7 When prompted for the destination file name, press the Enter key. A response similar to the following
will be displayed:

Router#copy slot0:canned—config start
Destination filename [startup—config]?
2218 bytes copied in 3.52 secs
Routerl#

8 Check the file size of the startup—config to verify the copy operation by entering the following:
dir nvram:
A response similar to the following will be displayed:

Directory of nvram:/

26 —rw— 2218 <no date> startup—config
27 5 <no date> private—config

29688 bytes total (25247 bytes free)
Router#

NOTE

Be sure to include the colon (:) after nvram when typing the command.

... continued on next page
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[Table J -9: Copy Canned Configuration File to BTS Router Startup
Configuration and Verify I0S File Position

Step Action

9 If desired, the contents of the startup—config file may be verified against the file listings at the end of
this appendix for the blue or red canned configuration, as applicable, by entering the following:

show startup—config
NOTE

Pressing the space bar at the MORE prompt will scroll another screen—full of data. Pressing the Enter
key will scroll the screen one line at a time.

10 | Verify the router will boot properly on the I0S and revised startup—config files by entering the
following:

reload

A response similar to the following will be displayed:
Router#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

11 If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

12 | When prompted to proceed with reload, press the Enter key to continue the reload operation.

13 | Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations. If the router boots to the rommon prompt, proceed to the Recovery from BTS Router
Boot to rommon section of this appendix.

14 | Using the tagging materials, tag the router to clearly identify the installed configuration (blue
(BTSRTR1) or red (BTSRTR2)).

15 | If an additional router must have the canned configuration installed, perform the following:

15a — Disconnect the cabling for the HyperTerminal communications session from the BTS router, and
minimize the HyperTerminal window on the LMF computer.

15b — Remove power from the router and disconnect it from the power supply.

15¢ — Repeat the procedures irrJable J-8 and this table ﬂable J-9) using the additional router.

16 | If no additional routers must be configured, perform stepg35a an¢55b.

17 | On the LMF computer, exit the HyperTerminal session.
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Replacing Installed BTS Router CF Memory Card I0S Version

Background

BTS routers are supplied with CF memory cards pre—loaded with a
version of the IOS. Prior to installing the routers in a BTS, the loaded
I0S version should be verified as being the one required for the network.
It is critical to also verify that the 10S file is the first file on the CF
memory card. If another file precedes the 10S file, the BTS router will
not boot properly and will not function in the network.

Equipment and Software Required for Verification Methods

The following items are required to perform this procedure:

A Windows—based computer which meets the requirements of the
LMF computer platform as specified in Chapter 3 of this manual:

One of the following operating systems for the Windows—based
computer:

— Windows 2000
— Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION

BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

DB-9 plug—to—8—contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

A copy of the MWR 1941 router 10S version required for the network
where the routers are to be installed

NOTE

Contact the network administrator or the Motorola Account
Team for assistance in determining and obtaining a copy of the
required IOS version.

Required Publications

The MWR 1941 will accept a voltage from —60 Vdc to + 60 Vdc
during configuration and file operations

The following publication is required to perform procedures in this
section:

MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78—13983-01
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Method 1: Replacement of Installed Router CF Card I0S Data

Description
This procedure covers using an LMF computer equipped with a tftp
server application to perform the following activities:

1. Verify the IOS version loaded on a CF memory card and running on
a BTS router

Replace the IOS version installed in a BTS router

Ensure the 10S file is the first file on the CF memory card

Additional required equipment/software
For this method, the following software application is required in
addition to the common items required for both methods:

* (Cable, Ethernet crossover, Category SE or better, unshielded twisted
pair, two 8—contact modular plugs, in one of the following lengths, as
determined necessary:

— 0.3 m (11.8 in) (Motorola pn 3088643C07)
— 0.6 m (23.6 in)(Motorola pn 3088643C13)
— 1.0 m (39.4 in) (Motorola pn 3088643C15)
— 2.1 m (84 in) (Motorola pn 3088643C08)

— 3.0 m (120 in) (Motorola pn 3088643C09)

* A tftp server software application (refer to the Setting Up the TFTP
Server — Procedure in Cellular System Administration — CDMA
OnLine Documentation) such as:

— Cisco tftp server
— PumpKIN tftp server

— Any other equivalent tftp server application

Prerequisites

The following are required prior to performing this procedure:

® The LMF computer and BTS router have been prepared for tftp file
transfer and are operating as they would be after performing the
procedures iqj"able J-4Fable J-5rFable J-6, and stepg through§ of
[Jable J-7

* A copy of the required 10S version is loaded into the tftp default
directory of the LMF computer

Replacing installed 10S version and verifying file
sequence position

Follow the procedure irﬂable J-10 to replace the installed IOS version
using the tftp server application, and ensure the 10S file is first in the
stored file sequence on the CF memory card. J
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Table J-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

-

Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures iqj"able J-4Fable J-5rFable J-6, and stepg
througl§ of Jable J-7. If necessary, perform these procedures now.

2 | NOTE

The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the ed command. Determine the present working
directory by entering pwd. If the present working directory has been changed, enter the command cd
slot0: to return to the default setting.

Identify the filename of the currently loaded IOS which must be replaced by entering dir command. A
response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1 —rw— 7051844 Sep 23 2002 07:15:08 mwrl941-i—mz.07022002.bin
2 —rw— 2212 Mar 01 1993 00:11:00 canned—config

31932416 bytes total (24878360 bytes free)
BTSRTR1#

3 Begin to backup the currently installed version of the router’s IOS to the LMF computer’s default tftp
directory by entering the following:

copy old 10S filename tftp:

Where old_IOS_filename = the filename of the IOS currently loaded on the BTS router CF memory
card.

A response similar to the following will be displayed:

BTSRTR1#copy mwrl1941—i—mz.07022002.bin tftp:
Address or name of remote host []?

4 At the remote host prompt, enter the following:
100.100.100.1
A response similar to the following will be displayed:

Address or name of remote host []? 100.100.100.1
Destination filename [mwr1941—i-mz.07022002.bin]?

... continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step

Action

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename.

A response similar to the following will be displayed if the default filename is selected:

Address or name of remote host []? 100.100.100.1
Destination filename [mwr1941—i—-mz.07022002.bin]?

7051844 bytes copied in 109.92 secs (64697 bytes/sec)
BTSRTR1#

If additional files are stored on the CF memory card, begin backing them up to the LMF computer’s
default tftp directory by entering the following:

copy additional_filename tftp:

Where additional_filename = the filename of an additional file loaded on the BTS router CF memory
card.

A response similar to the following will be displayed:

BTSRTR1#copy canned—config tftp:
Address or name of remote host [100.100.100.1]?

If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer.

A response similar to the following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]?
Source filename [canned—config]?

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename.

A response similar to the following will be displayed if the default filename is selected:

Source filename [canned—config]?
Destination filename [canned—config]?

... continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step Action

9 If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:
Destination filename [canned—config]?
!
[OK — 2212/4096 bytes]
2212 bytes copied in 0.152 secs
BTSRTR1#

10 | If more files are stored on the CF memory card, repeat stepg througi§ until all files have been
backed up to the LMF computer.

11 Delete all files from the CF memory card by entering the following command:

format slotO:

A response similar to the following will be displayed:
BTSRTR1#format slotO0:
Format operation may take a while. Continue? [confirm]

12 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:
Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”. Continue? [confirm]

13 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:
Format operation will destroy all data in ”slot0:”. Continue? [confirm]
Format: Drive communication & lst Sector Write OK...
Writing Monlib
=] =T o o o =
Monlib write complete
Format: All system sectors written. OK...
Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720
Format: Operation completed successfully.
Format of slot0 complete
BTSRTR1#

14 | Verify all files have been deleted from the CF memory card by entering the dir command. A response
similar to the following will be displayed:
Directory of slot0:/
No files in directory
31932416 bytes total (31932416 bytes free)
BTSRTR1#

. .. continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step

Action

15

Begin to copy the required version of the IOS from the LMF computer to the BTS router by entering the
following:

copy tftp:new IOS filename slotO:
Where new_IOS _filename = the filename of the required IOS for the BTS router.
A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwrl941—i—mz.122—8.MC2a.bin slotO:
Address or name of remote host [100.100.100.1]?

16

If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]?
Source filename [mwrl941—i—mz.122—-8.MC2a.bin]?

17

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Source filename [mwrl941—i—mz.122—-8.MC2a.bin]?
Destination filename [mwrl194l1—i-mz.122—-8.MC2a.bin]?

18

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is not
correct, enter the correct filename. A response similar to the following will be displayed if the default
filename is selected:

Destination filename [mwrl194l1—i-mz.122—-8.MC2a.bin]?
Accessing tftp://100.100.100.1/mwrl941—i—mz.122—8.MC2a.bin...
Loading mwrl941—i—mz.122—8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading mwrl941—i—mz.122—8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0):
!

1
[OK — 7051976/14103552 bytes]

7051976 bytes copied in 145.108 secs (48634 bytes/sec)
BTSRTR1#

. .. continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step Action

19 | Display the CF memory card directory to verify that the new 10S file is there by entering the dir
command. A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:25:36 mwrl941—i—mz.122—8.MC2a.bin

31932416 bytes total (24880440 bytes free)
BTSRTR1#

20 | If any additional files previously stored on the CF memory card are to be copied to the card, perform
the following:

copy tftp:filename slotO:
Where filename = the filename of the file to be copied to the CF memory card
A response similar to the following will be displayed:

BTSRTR1#copy tftp:canned—config slotO:
Address or name of remote host [100.100.100.1]?

21 | If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default IP address is selected:

Address or name of remote host [100.100.100.1]?
Destination filename [canned—config]?

22 | If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Destination filename [canned—config]?

Accessing tftp://100.100.100.1/canned—config...

Loading basic _config from 100.100.100.1 (via FastEthernet0/0): !
[OK — 2212/4096 bytes]

2212 bytes copied in 0.152 secs
BTSRTR1#

23 | After the additional file is copied to the CF memory card, display the CF memory card directory by
entering the dir command. A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Mar 01 1993 00:09:06 canned—config

24 | The IOS file must be the first file listed for the BTS router to boot properly. If it is, proceed to ster39.

... continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step Action

CAUTION

The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

25 | If another file is listed before the 10S file, delete the file by performing stepgj1 through3 and
display the directory of the CF memory card as described in ste33 to be sure the file is deleted.

26 | Copy the file from the LMF computer to the CF memory card again by performing stepg 30 through

3.

27 | If the file is again listed before the IOS file in the CF memory card directory display, format the CF
memory card by performing stepg 31 througl34 of this table.

28 | Copy the I0S file and any other required file to the formatted CF memory card by performing stepg 35
througl34.

29 | If additional files are to be transferred to the CF memory card, perform stepg 40 througl34 for each
one.

30 | After making sure the 10S file is the first file on the CF memory card, restart the BTS router with the
new IOS version by entering the following:

reload

A response similar to the following will be displayed:
BTSRTR1#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

31 If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

32 | When prompted to proceed with reload, press the Enter key to continue the reload operation.

33 | Once the router has completed rebooting, change to the privileged EXEC mode and confirm the
booted IOS version is correct by entering the following:

show version

A response similar to the following partial example will be displayed:
BTSRTR1#sh ver
Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941—-I-M), Version 12.2(8)MC2a, EARLY DEPLOYMENT RELEASE
SOFTWARE (fcl)

BTSRTR1#

34 | Verify the version number displayed in the second line of the version information is the correct I0OS
version.

35 If this procedure was entered from steplﬁ oﬁable J-7, return tqj"able J-7, steqﬁ.

... continued on next page
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Table J-10: Using a TFTP Server Application for Replacing Loaded
IOS Version and Verifying File Sequence Position

Step Action
36 | If no other BTS router file operations or configuration actions are required, perform the following:
36a — Remove power from the router and disconnect it from the power supply.
36b — Disconnect all other cabling from the BTS router.
36¢ — On the LMF computer, exit the HyperTerminal communications session.
37 | If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask

back to those for LMF-BTS communication recorded iqj"able J-4, steﬂﬁb.

CAUTION

If the BTS 10base—2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.

Method 2: Using a CF Memory Card Reader for Replacement of Installed 10S
Version and Changing File Sequence Position

This subsection contains the file replacement and file sequence
manipulation procedures to use when transferring files with a CF
memory card reader.

Replace 10S Version Installed on the CF Memory Card

Description — This procedure covers using an LMF computer equipped
with a CF memory card reader to perform the following activities:

1. Verify the IOS version loaded on a CF memory card and running on
a BTS router

2. Replace the IOS version installed in a BTS router
3. Ensure the 10S file is the first file on the CF memory card

Additional required equipment/software — For this method, the
following equipment item and associated software is required in addition
to the common items required for both methods:

* Compact Flash memory card reader device and software driver for the
operating system installed on the LMF computer

CAUTION Card readers for other non—volatile, solid—state memory devices
such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

Prerequisites — The following are required prior to performing this
procedure:

® The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures in stepg througl§ of Jable J-8

* A copy of the required 10S version is loaded into the desired directory
of the LMF computer
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File operations using a CF memory card reader — Only file transfers
should be performed using the CF memory card reader. CF memory card
formatting should be performed in a BTS router using a HyperTerminal
connection. Attempting to format a CF memory card from a
Windows-based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a
Windows—based computer. Only format CF memory cards in a
BTS router.

Replacing installed IOS version — Follow the procedure irJable J-11
to replace the installed IOS version using a CF memory card reader and
to ensure the 10S file is first in the stored file sequence on the CF
memory card.

Table J-11: Using a CF Memory Card Reader for Replacing
Loaded IOS Version and Verifying File Sequence Position

Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures in stepg ] througl7 of Jable J-8. If necessary,
perform these procedures now.

2 With the CF memory card in the CF memory card reader and the card reader icon highlighted in the
left—hand pane of Windows Explorer, perform the following to delete the 10S file from the card:

2a — In the right-hand pane of Windows Explorer, highlight the IOS file to be removed.
2b — Right—click and select Delete from the popup menu.
3 CAUTION

When performing the following step and its associated substeps, files should be moved to and from
the CF memory card one by one to reduce the potential for disrupting the the CF memory card file
sequence. Do not attempt to move multiple files by highlighting and dragging and dropping all of
them at one time.

If there are more files on the CF memory card which must be retained, perform the following:

3a — Scroll the left-hand pane of Windows Explorer to locate the LMF computer directory where the
required IOS version and canned configuration files are stored.

3b — In the right-hand pane, highlight the additional file on the CF memory card which is to be
retained.

3c — While holding down the Ctrl key on the LMF computer, drag and drop the highlighted file into
the directory in the left-hand pane where the required IOS and canned config files are stored.

3d — If additional files loaded on the CF memory card must be retained, repeat stepg3b anqjc for each
file until all files have been moved from the CF memory card to the directory on the LMF
computer.

... continued on next page
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Table J-11: Using a CF Memory Card Reader for Replacing
Loaded IOS Version and Verifying File Sequence Position

Step Action

4 When all files on the CF memory card have been deleted or moved, as applicable, highlight the
directory in the left-hand pane where the required I0S version and canned configuration files are
stored.

5 Verify that all files from the CF memory card which must be retained were moved to the directory by
checking the filenames in the right—hand pane.

6 Scroll the left—hand pane of Windows Explorer to locate the CF memory card reader icon.

7 In the right—hand pane, highlight the icon for the required version of the 10S.

8 Drag and drop the 10S icon to the CF memory card reader icon to copy it to the CF memory card.

9 If an additional file in the LMF computer directory must be moved to the CF memory card, perform
the following:

9a — In the right—hand pane, highlight one additional file which is to be moved to the CF memory card.

9b — While holding down the Ctrl key on the LMF computer, drag and drop the highlighted file into

the CF memory card reader directory in the left—-hand pane.
9c — If additional files in the directory must be placed on the CF memory card, repeat stepg9a ang9b

for each file until all files have been moved one at a time from the LMF computer to the CF
memory card.

10 | In the left-hand pane, highlight the CF memory card reader icon.

11 | Verify that all required files were moved to the CF memory card by checking the filenames in the
right-hand pane.

12 | Scroll the left-hand pane of Windows Explorer to locate the LMF computer directory where the
required IOS version and canned configuration files are stored.

13 | Highlight the directory in the left—hand pane.

14 If this procedure was entered from step|j7 oﬁable J-8, return tqj"able J-8, steqj&

15 | If no other file transfer activities between the LMF computer and CF memory card are required at this
time, click Files > Close to close Windows Explorer.

16 | Remove the CF memory card from the card reader and install it in the BTS router by following the
procedure in the 1X SC 4812T BTS FRU Guide .

17 | At this point, the router should be powered up and displaying the user EXEC prompt in the
HyperTerminal window of the LMF computer communication session. If it is not, perform stepg

througlr§ of Jable J-8.

18 | At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC mode:
enable

A response similar to the following will be displayed:

Router>enable
Router#

... continued on next page
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Table J-11: Using a CF Memory Card Reader for Replacing
Loaded IOS Version and Verifying File Sequence Position

Step Action

NOTE

The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the ed command. Determine the present working
directory by entering pwd. If the present working directory has been changed, enter the command cd
slot0: to return to the default setting.

19 | Display the directory listing of the CF memory card by entering the following:
dir
A response similar to the following will be displayed:

Router#dir slotO0:
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24885606 bytes free)
Router#

CAUTION

The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

20 | Be sure the IOS file is the first file listed in the directory content display. If it is not, perform the
procedure ir‘j"able J-12, and then return to steqjl, below.

21 | Verify the router will boot properly on the IOS and revised startup—config files by entering the
following:

reload

A response similar to the following will be displayed:
Router#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

22 | If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

23 | When prompted to proceed with reload, press the Enter key to continue the reload operation.

24 | Verify the router reboots without displaying the rommon 1 > prompt or error messages related to port
configurations.

25 | If no other BTS router file operations or configuration actions are required, perform the following:

25a — Remove power from the router and disconnect it from the power supply.
25b — Disconnect all cabling from the BTS router.
25¢ — On the LMF computer, exit the HyperTerminal communications session.
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Change CF Memory Card File Sequence to Place I0S File First on the Card

This procedure covers using an LMF computer equipped with a CF
memory card reader to perform the following activities:

1. Change the sequence of files on a CF memory card to place the IOS
version file first

2. Formatting the CF memory card, if necessary, to achieve the
required file sequence positioning of the IOS version file

Prerequisites

The following are required prior to performing this procedure:

® The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures irrfable J-8 and stepg throughj of
[Jable J-9

* Copies of the required IOS version and canned configuration files are
loaded into the desired directory of the LMF computer

Optional equipment/software
If they are available, the following items may be used to change the CF
memory card file sequence once the card is installed in the BTS router:

* (Cable, Ethernet crossover, Category SE or better, unshielded twisted
pair, two 8—contact modular plugs, in one of the following lengths, as
determined necessary:

— 0.3 m (11.8 in) (Motorola pn 3088643C07)
— 0.6 m (23.6 in)(Motorola pn 3088643C13)
— 1.0 m (39.4 in) (Motorola pn 3088643C15)
— 2.1 m (84 in) (Motorola pn 3088643C08)

— 3.0 m (120 in) (Motorola pn 3088643C09)

* A tftp server software application (refer to the Setting Up the TFTP
Server — Procedure in Cellular System Administration — CDMA
OnLine Documentation) such as:

— Cisco tftp server
— PumpKIN tftp server
— Any other equivalent tftp server application

Changing CF memory card file sequence

Follow the procedure ifable J-12 to place the installed IOS version file
first in the stored file sequence on the CF memory card.

J-48

1X SC™ 4812T BTS Optimization/ATP Oct 2003



68P09258A31-A Replacing Installed BTS Router CF Memory Card 10S Version

Table J-12: Use CF Memory Card Reader to Place IOS File
First in CF Memory Card File Sequence

Step

Action

CAUTION

The file sequence on the CF memory card can not be verified with application programs which place the listed
file names in alphabetical order (for example, certain Unix telnet applications, Unix directory listing
commands, and Windows file managers such as Windows Explorer). This procedure is intended for use only
with applications, such as HyperTerminal, which do not list directory contents alphabetically.

This procedure assumes that the LMF computer and BTS router have been prepared for CF memory
card reader file transfer and are operating as they would be after performing the procedures in

[Jable J-8 and stepg | through of Fable J-9. If necessary, perform these procedures now.

NOTE

The IOS present working directory defaults to the CF memory card (slot0:) directory unless the
present working directory has been changed using the ed command. Determine the present working
directory by entering pwd. If the present working directory has been changed, enter the command cd
slot0: to return to the default setting.

With the CF memory card still installed in the router, display a CF memory card directory listing if
one is not showing by entering the dir command. A response similar to the following will be
displayed:

Router#dir slotO0:
Directory of slot0:/

2 —rw— 2212 Mar 01 1993 00:14:48 canned—config
1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin

31932416 bytes total (24878228 bytes free)
Router#

Verify that the IOS file is not the first file on the CF memory card.

If a tftp server application is not available on the LMF computer, skip to steg33.

If a tftp server is available on the LMF computer, connect the Ethernet crossover cable as shown in

ﬂigure J-4.

If it has not been done, configure the LMF computer NIC as directed irpfable J-4.

... continued on next page

Oct 2003

1X SC™ 4812T BTS Optimization/ATP J-49




Replacing Installed BTS Router CF Memory Card 10S Version 68P09258A31-A

Table J-12: Use CF Memory Card Reader to Place 10S File
First in CF Memory Card File Sequence

Step Action
7 Configure FE port FE 0 (fa0/0) by performing the following:
7a — At the Router> user EXEC mode prompt, enter the following to access the privileged EXEC
mode:
enable

A response similar to the following will be displayed:

Router>enable
Router#

7b — At the Router# privileged EXEC mode prompt, enter the following to access the configure
submode:

configure terminal

A response similar to the following will be displayed:

Router#conf t
Enter configuration commands, one per line. End with CNTL/Z.
Router (config)#

7c — At the global configuration mode prompt, type each of the following commands, pressing the
Enter key after each command:

hostname btsrtri
interface fa0/0

ip address 100.100.100.2 255.255.255.252
speed 100
duplex full

no shutdown

line con 0
exec—timeout 0 0
no login

line vty 0 4

no login

Responses similar to the following will be displayed:

Router (config)#hostname BTSRTR1
BTSRTR1 (config)#interface £a0/0
BTSRTR1 (config—if)#ip address 100.100.100.2 255.255.255.252
BTSRTR1 (config—if)#speed 100

BTSRTR1 (config—if)#duplex full
BTSRTR1 (config—if)#no shutdown
BTSRTR1 (config—if)#line con 0

BTSRTR1 (config—line)#exec—timeout 0 0
BTSRTR1 (config—line)#no login

BTSRTR1 (config—line)#line vty 0 4
BTSRTR1 (config—line)#no login

BTSRTR1 (config—line)#

7d — Once the correct parameters have been set, return to the privileged EXEC mode prompt by
holding down the Ctrl key and pressing z (Ctrl+z). A response similar to the following will be
displayed:

BTSRTR1 (config—line)# "z
01:11:27: %SYS—5—CONFIG I: Configured from console by console
BTSRTR1#

... continued on next page
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Table J-12: Use CF Memory Card Reader to Place 10S File
First in CF Memory Card File Sequence

Step Action

7e — Verify port FE 0 (fa0/0) is configured with the correct IP address by entering the following:
show ip interface brief

A response similar to the following will be displayed:

BTSRTR1#sh ip int br

Interface IP Address OK? Method Status Protocol
FastEthernet0/0 100.100.100.2YES manual up up
Serial0:0 unassigned YES unset administratively down down
FastEthernet0/1 unassigned YES unset administratively down down
Seriall:0 unassigned YES unset administratively down down
BTSRTR1#

8 Be sure the required 10S file and canned configuration file for the BTS router are located in the tftp
server root directory (refer tqFable J-4, steg34 or steg 97, as applicable)

9 Delete files from the CF memory card by entering the del filename command. A response similar to
the following will be displayed:

Router#del canned—config
Delete filename [canned—config]?

10 | If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Delete filename [canned—config]?
Delete slot0O:canned—config? [confirm]

11 | Press the Enter key to confirm the deletion.
A response similar to the following will be displayed if the default filename is selected:
Delete filename [canned—config]?

Delete slot0O:canned—config? [confirm]
Router#

12 | Confirm the file deletion by entering the dir command. A response similar to the following will be
displayed:

Router#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin

31932416 bytes total (24887818 bytes free)
Router#

13 Repeat stequ througlE]I2 for each file until a/l files have been deleted from the CF memory card.

. .. continued on next page
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Table J-12: Use CF Memory Card Reader to Place 10S File
First in CF Memory Card File Sequence

Step

Action

14

Use the tftp server to copy the 10S file from the LMF computer to the CF memory card by enteringthe fol-
lowing:

copy tftp:/OS filename slot0:

Where I0S_filenamer = required 10S version filename in the LMF computer tftp server root
directory.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwrl941—i—mz.122—8.MC2a.bin slotO:
Address or name of remote host []?

15

At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:
100.100.100.1

A response similar to the following will be displayed:

BTSRTR1#copy tftp:mwrl941—i—mz.122—8.MC2a.bin slotO:

Address or name of remote host []? 100.100.100.1
Destination filename [mwrl194l1—i-mz.122-8.MC2a.bin]?

16

At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:mwrl941—i—mz.122—8.MC2a.bin slotO:

Address or name of remote host []? 100.100.100.1

Destination filename [mwrl194l1—i-mz.122—-8.MC2a.bin]?

Accessing tftp://100.100.100.1/mwrl941—i—mz.122—8.MC2a.bin...

Loading mwrl941—i—mz.122—8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading mwrl941—i—mz.122—8.MC2a.bin from 100.100.100.1 (via FastEthernet0/0):

1
[OK — 7051976/14103552 bytes]

7051976 bytes copied in 145.108 secs (48634 bytes/sec)

... continued on next page
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Table J-12: Use CF Memory Card Reader to Place 10S File
First in CF Memory Card File Sequence

Step Action

17 | Display the directory of the CF memory card to confirm the IOS file transfer by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin

31932416 bytes total (248880440 bytes free)
Router#

18 | Copy the canned configuration file to the CF memory card by entering the following:
copy tftp:btsrtr_canned.color slot0:canned—-config

Where color = blue or red, as applicable.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config
Address or name of remote host [100.100.100.1]?

19 | If the default IP address for the LMF computer displayed in the prompt is correct, press the Enter key
to accept it. If it is missing or not correct, enter the correct IP address.

A response similar to the following will be displayed if the default filename is accepted:
Destination filename [canned—config]?

2212 bytes copied in 0.208 secs
Router#

20 | At the prompt for the destination filename, press the Enter key. A response similar to the following
will be displayed:

BTSRTR1#copy tftp:btsrtr_canned.blue slot0:canned—config

Address or name of remote host []? 100.100.100.1

Destination filename [canned—config]?

Loading btsrtr canned.blue from 100.100.100.1 (via Ethernet0/0): !
[OK — 2457/4096 bytes]

2457 bytes copied in 84.724 secs (29 bytes/sec)
BTSRTR1#

21 | Determine if the IOS file is now the first file displayed in the directory listing by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

1 —rw— 7051976 Mar 01 1993 00:14:48 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Sep 23 2002 07:24:18 canned—config

31932416 bytes total (24878228 bytes free)
Router#

22 If the 10S file is the first file displayed, as shown in steqjl, above, proceed to steHjO.

. .. continued on next page
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Table J-12: Use CF Memory Card Reader to Place 10S File
First in CF Memory Card File Sequence

Step Action

23 | If the IOS is not the first file displayed, as shown in ste3, above, format the CF memory card by
entering the following:

format slotO:

A response similar to the following will be displayed:

BTSRTR1#format slotO:
Format operation may take a while. Continue? [confirm]

24 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”. Continue? [confirm]

25 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation will destroy all data in ”slot0:”. Continue? [confirm]
Format: Drive communication & lst Sector Write OK...

Writing Monlib

SECLO S e e ceoceccscccosscescssssoscssssosssescssassosscssssosocscsascsosscssasssse

Monlib write complete

Format: All system sectors written. OK...

Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720

Format: Operation completed successfully.

Format of slot0 complete
BTSRTR1#

26 | If a tftp server is available on the LMF computer, repeat stepg}4 through32 to transfer the IOS and
canned configuration files to the CF memory card.

27 | Once the format operation is completed, remove the CF memory card from the router following the
procedure in the 1X SC 4812T BTS FRU Guide , insert it in the card reader connected to the LMF
computer, and copy the 10S file to the card by performing ster% and stepg ) througl 31 of Fable J-11,
as required.

28 | Remove the CF memory card from the card reader and install it in the router following the procedure
in the BTS FRU Guide.

29 | Be sure that the I0OS file is now the first file displayed in the directory listing by entering the dir
command. A response similar to the following will be displayed:

Router#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2a.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24885606 bytes free)
Router#

30 If this procedure was entered from steqj oﬁable J-9, return tqj"able J-9, steqj.

... continued on next page
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Table J-12: Use CF Memory Card Reader to Place 10S File
First in CF Memory Card File Sequence

Step Action

31 If this procedure was entered from steHjO ofj"able J-11, return tqj"able J-11, steqjl.

32 | If no other BTS router file operations or configuration actions are required, perform the following:
32a — Remove power from the router and disconnect it from the power supply.
32b — Disconnect all cabling from the BTS router.
32c — On the LMF computer, exit the HyperTerminal communications session.

33

If a tftp server was used in this procedure and no additional tftp transfer activities will be performed,
change the NIC IP address and subnet mask back to those for LMF-BTS communication recorded in

|j"able J-4, steﬂjb.
CAUTION
If the BTS 10base—2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,

the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.
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Verify and Upgrade rommon Version

Introduction

BTS routers are supplied pre—loaded with a version of the ROM monitor
(rommon) low—level operating system. Along with the 10S version, the
loaded rommon version should be verified as being the one required for
the network. Procedures in this section are used to verify the loaded
rommon version, and, if necessary, change it to the required version.
Methods are provided for using either a tftp server or CF memory card
reader to transfer the required rommon version to a BTS router’s CF
memory card.

Equipment and Software Required for Verification

The following items are required to perform rommon verification:

* A Windows-based computer which meets the requirements of the
LMF computer platform as specified in this manual.

* One of the following operating systems for the Windows—based
computer:

— Windows 2000
— Windows 98 Second Edition (SE) using the FAT32 file system

CAUTION BTS router CF memory cards loaded using computers equipped
with Windows 98 versions earlier than Windows 98 SE and using
the FAT16 file system will not operate properly, resulting in a
complete site outage.

* Cable, rollover, as described in the Establishing a BTS Router
Communication Session section of this Appendix

* DB-9 plug—to—8—contact modular plug adapter as described in the
Establishing a BTS Router Communication Session section of this
Appendix

¢ A copy of the MWR 1941 router rommon version required for the
network where the routers are to be installed

NOTE Contact the network administrator or the Motorola Account
Team for assistance in determining and obtaining a copy of the
required rommon version.

* A +27 Vdc power supply to power the BTS router during
configuration file operations

Required Publications

The following publication is required to perform procedures in this
section:

* MWR1941 Wireless Mobile Edge Router Software Configuration
Guide; part number 78—13983-01
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Method 1: In—Router Verification and Replacement of Installed rommon
Version

Description

This procedure covers using an LMF computer equipped with a tftp
server application to perform the following activities:

1. Verify the rommon version loaded and running on a BTS router

2. Replace the rommon version installed in a BTS router

Additional required equipment/software
For this method, the following equipment and software application is
required in addition to the common items required for both methods:

* (Cable, Ethernet crossover, Category SE or better, unshielded twisted
pair, two 8—contact modular plugs, in one of the following lengths, as
determined necessary:

— 0.3 m (11.8 in) (Motorola pn 3088643C07)
— 0.6 m (23.6 in)(Motorola pn 3088643C13)
— 1.0 m (39.4 in) (Motorola pn 3088643C15)
— 2.1 m (84 in) (Motorola pn 3088643C08)

— 3.0 m (120 in) (Motorola pn 3088643C09)

* A tftp server software application (refer to the Setting Up the TFTP
Server — Procedure in Cellular System Administration — CDMA
OnLine Documentation) such as:

— Cisco tftp server
— PumpKIN tftp server
— Any other equivalent tftp server application

Prerequisites

The following are required prior to performing this procedure:

* The LMF computer and BTS router have been prepared for tftp file
transfer and are operating as they would be after performing the
procedures iqj"able J-4Fable J-5rFable J-6, and stepg through§ of

[Jable J-7

* A copy of the required rommon version is loaded into the tftp default
directory of the LMF computer
Verifying and replacing installed rommon version

Follow the procedure irﬂ" able J-13 to verify and, if necessary, replace
the installed rommon version using the tftp server application.
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action

* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures iqj"able J-4Fable J-5rFable J-6, and stepg
througl# of Jable J-7. If necessary, perform these procedures now.

2 Determine the currently installed rommon version by entering the following at the router privileged
EXEC mode prompt:

show version

A response similar to the following will be displayed:

BTSRTR1#sh ver

Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)

TAC Support: http://www.cisco.com/tac

Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Mon 05—Aug—02 11:07 by nmasa

Image text—base: 0x60008940, data—base: 0x60B54000

ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose—wilma 109], DEVELOPMENT
SOFTWARE

ROM: 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fc3)

Router uptime is 1 minute
System returned to ROM by power—on
System image file is ”slot0:mwrl941—i—mz.122—8.MC2b.bin”

cisco mwrl941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS

R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.

X.25 software, Version 3.0.0.

Primary Rate ISDN software, Version 1.1.

Toaster processor tmc is running.

2 FastEthernet/IEEE 802.3 interface(s)

2 Serial network interface(s)

2 Channelized T1/PRI port(s)

DRAM configuration is 64 bits wide with parity disabled.

55K bytes of non—volatile configuration memory.

31360K bytes of ATA Slot0 CompactFlash (Read/Write)

Configuration register is 0x101

BTSRTR1#

3 To determine the currently installed rommon version, examine the ROM: System Bootstrap line in the
response.

. .. continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

Compare the installed rommon version information with the filename of the rommon version required
for the network.

NOTE

1. Rommon filename format is similar to the following:
MWR1941_RM2.srec.122-8r.MC3.bin

2. The rommon filename reflects the version number of the software (122-8r.MC3).

If the installed version is the one required for the network skip to steg36.

If the installed rommon version is not the one required for the network, backup the current BTS router
configuration to the LMF computer by entering the following:

copy nvram:startup—config tftp
A response similar to the following will be displayed:

BTSRTR1#copy nvram:start tftp
Address or name of remote host []?

NOTE

Be sure to include the colon (:) after nvram when typing the command.

At the prompt for the remote host address or name, enter the IP address of the LMF computer NIC:
100.100.100.1
A response similar to the following will be displayed:

BTSRTR1#copy copy nvram:start tftp
Address or name of remote host []? 100.100.100.1
Source filename [startup—config]?

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Source filename [startup—config]?
Destination filename [startup—config]?

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:

Destination filename [startup—config]?
!

[OK — 2212/4096 bytes]

2212 bytes copied in 0.152 secs
BTSRTR1#

... continued on next page

Oct 2003

1X SC™ 4812T BTS Optimization/ATP J-59




-

Verify and Upgrade rommon Version 68P09258A31-A

Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

10

NOTE

The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the ed command. Determine the present working directory by entering pwd. If
the present working directory has been changed, enter the command cd slot0: to return to the default

setting.

Determine the amount of memory available (bytes free) on the CF memory card by entering the dir
command. A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2b.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24885606 bytes free)
Router#

11

Be sure there is at least 1 MB (1048580) of free memory.
NOTE

A rommon version file requires approximately 0.7 MB.

12

Begin to copy the required version of the rommon file from the LMF computer to the BTS router by entering
the following:

copy tftp:new_rommon_filename slot0:
Where new_rommon_filename = the filename of the required rommon version for the BTS router.

A response similar to the following will be displayed:

BTSRTR1#copy tftp:MWR1941 RM2.srec.122—8r.MC3.bin slotO0:
Address or name of remote host [100.100.100.1]?

13

If the default IP address displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct IP address for the LMF computer. A response similar to the
following will be displayed if the default filename is selected:

Address or name of remote host [100.100.100.1]?
Source filename [MWR1941 RM2.srec.122—8r.MC3.bin]?

14

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be

displayed if the default filename is selected:

Source filename [MWR1941 RM2.srec.122—8r.MC3.bin]?

Destination filename [MWR1941 RM2.srec.122—8r.MC3.bin]?

... continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step Action
15 | If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is not
correct, enter the correct filename. A response similar to the following will be displayed if the default
filename is selected:
Destination filename [MWR1941 RM2.srec.122—8r.MC3.bin]?
Accessing tftp://100.100.100.1/MWR1941 RM2.srec.122—-8r.MC3.bin...
Loading MWR1941 RM2.srec.122—8r.MC3.bin from 100.100.100.1 (via FastEthernet0/0): !!!!
Loading MWR1941 RM2.srec.122—8r.MC3.bin from 100.100.100.1 (via FastEthernet0/0):
NN N N N NN N N N N NN RN RN RN RSN SR RN R R RN SR NN BRI
NN RN SN RN R RN R R RN SR NN R
[OK — 614306/14103552 bytes]
614306 bytes copied in 13.059 secs (48634 bytes/sec)
BTSRTR1#
16 | Display the CF memory card directory to verify that the new rommon version file is there by entering
the dir command. A response similar to the following will be displayed:
BTSRTR1#dir
Directory of slot0:/
1 —rw— 7051976 Sep 23 2002 07:25:36 mwrl941—i—mz.122—8.MC2b.bin
2 —rw— 2212 Mar 01 1993 00:09:06 canned—config
3 —rw— 614306 Dec 13 2002 14:59:36 MWR1941 RM2.srec.122—8r.MC3.bin
31932416 bytes total (24263922 bytes free)
BTSRTR1#
17 | Replace the existing rommon version with the new one copied to the CF memory card by entering the
following:
upgrade rom—monitor file slot0:MWR1941_RM2.srec.122-8r.MC3
A response similar to the following will be displayed:
BTSRTR1#This command will reload the router. Continue?[yes/no]
18 | When prompted to continue, enter yes and press the Enter key. A response similar to the following
will be displayed:
BTSRTR1#This command will reload the router. Continue?[yes/no] yes
ROMMON image upgrade in progress
Erasing boot flash
eeeeeeeceeceeceeeceeceeceeeceeceeceeceeeceeceeceeeceeceeceeceeeceeceeceeeceeceeceeeeeeeee
Programming boot flash pppp
Now reloading
19 | When the router has completed initialization, change to the router privileged EXEC mode by entering
the following:
enable
A response similar to the following will be displayed:
BTSRTR1>enable
BTSRTR1#
... continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

20

Verify the router has initialized with the new rommon version by entering the following:
show version

A response similar to the following partial response will be displayed:

BTSRTR1#sh ver

Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)

TAC Support: http://www.cisco.com/tac

Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Mon 05—Aug—02 11:07 by nmasa

Image text—base: 0x60008940, data—base: 0x60B54000

ROM: System Bootstrap, Version 12.2(8r)MC3 RELEASE SOFTWARE (fcl)

21

Compare the version displayed in the response ROM: System Bootstrap line to the filename of the
new rommon version file copied to the CF memory card.

22

If the router successfully rebooted with the new rommon version, the rommon file can be deleted from
the CF memory card by entering the following:

delete slot0:new_rommon_filename

Where new_rommon_filename = the filename of the required rommon version copied to the CF
memory card in stepg 2 througl35, above.

A response similar to the following will be displayed:

BTSRTR1#del slot0:MWR1941 RM2.srec.122—8r.MC3.bin
Delete filename [MWR1941 RM2.srec.122—8r.MC3.bin]?

23

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed if the default filename is selected:

Delete filename [MWR1941 RM2.srec.122—8r.MC3.bin]?
Delete slot0:MWR1941 RM2.srec.122—8r.MC3.bin? [confirm]

24

Press the Enter key to confirm the deletion. A response similar to the following will be displayed if
the default filename is selected:

Delete filename [MWR1941 RM2.srec.122—8r.MC3.bin]?
Delete slot0:MWR1941 RM2.srec.122—8r.MC3.bin? [confirm]
BTSRTR1#

25

CAUTION

In this step, do not delete the I0S and canned—config files from the CF memory card. The BTS router
must have these files on the card to properly boot or switch between packet and circuit mode.

If additional unnecessary files, such as a backup of the startup—configfile, are also on the CF
memory card, delete them by repeating stepg 42 througl34 for each file.

26
26a
26b
26c¢

If no other BTS router file operations or configuration actions are required, perform the following:
— Remove power from the router and disconnect it from the power supply.
— Disconnect all cabling from the BTS router.

— On the LMF computer, exit the HyperTerminal communications session.

... continued on next page
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Table J-13: Verify and Replace Installed rommon Version Using a tftp Server

Step

Action

CAUTION

27 | If no additional tftp transfer activities will be performed, change the NIC IP address and subnet mask
back to those for LMF-BTS communication recorded iqj"able J-4, steﬂﬁb.

If the BTS 10base—2 LAN IP address and subnet mask for the LMF computer’s NIC are not restored,
the LMF can not log into a BTS when attempting to perform a BTS optimization or ATP.

Method 2: Verification and Replacement of Installed rommon Version Using

a CF Memory Card Reader

Description

This procedure covers using an LMF computer equipped with a CF
memory card reader to perform the following activities:

1. Verify the rommon version loaded and running on a BTS router
2. Replace the rommon version installed in a BTS router

Additional required equipment/software
For this method, the following equipment item and associated software
is required in addition to the common items required for both methods:

* CF memory card reader device and software driver for the operating
system installed on the LMF computer

CAUTION Card readers for other non—volatile, solid—state memory devices

such as Smart Media cards will not work with the CF memory
cards used in the MWR 1941 routers. Do not attempt to use a
card reader intended for another type of memory device.

Prerequisites

The following are required prior to performing this procedure:

® The LMF computer and BTS router have been prepared for CF
memory card reader file transfer and are operating as they would be
after performing the procedures in stepg througl§ of Jable J-8

* A copy of the required rommon version is loaded into the desired
directory of the LMF computer

File operations using a CF memory card reader

Only file transfers should be performed using the CF memory card
reader. CF memory card formatting should be performed in a BTS router
using a HyperTerminal connection. Attempting to format a CF memory
card from a Windows—based computer using a card reader could result in
unpredictable BTS router operation.

CAUTION Do not format BTS router CF memory cards using a

Windows—based computer. Only format CF memory cards in a
BTS router.

Oct 2003 1X SC™ 4812T BTS Optimization/ATP J-63




Verify and Upgrade rommon Version 68P09258A31-A

Verifying and replacing installed rommon version

Follow the procedure irrJable J-14 to verify and, if necessary replace the
installed rommon version using a CF memory card reader.

Table J-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step Action

* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer and BTS router are configured, connected, and operating
as they would be after performing the procedures in stepg througly§ of Jable J-8. If necessary,
perform these procedures now.

2 Determine the currently installed rommon version by entering the following at the router privileged
EXEC mode prompt:

show version

A response similar to the following will be displayed:

BTSRTR1#sh ver

Cisco Internetwork Operating System Software

I0S (tm) 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE
SOFTWARE (fc3)

TAC Support: http://www.cisco.com/tac

Copyright (c) 1986—2002 by cisco Systems, Inc.

Compiled Mon 05—Aug—02 11:07 by nmasa

Image text—base: 0x60008940, data—base: 0x60B54000

ROM: System Bootstrap, Version 12.2(20020113:235343) [sbose—wilma 109], DEVELOPMENT
SOFTWARE

ROM: 1941 Software (MWR1941-I-M), Version 12.2(8)MC2b, EARLY DEPLOYMENT RELEASE SOFT-
WARE (fc3)

Router uptime is 1 minute
System returned to ROM by power—on
System image file is ”slot0:mwrl941—i—mz.122—8.MC2b.bin”

cisco mwrl941 (R7000) processor (revision 0.1) with 121856K/18432K bytes of memory.
Processor board ID JMX0611K5TS

R7000 CPU at 240Mhz, Implementation 39, Rev 3.3, 256KB L2 Cache
Bridging software.

X.25 software, Version 3.0.0.

Primary Rate ISDN software, Version 1.1.

Toaster processor tmc is running.

2 FastEthernet/IEEE 802.3 interface(s)

2 Serial network interface(s)

2 Channelized T1/PRI port(s)

DRAM configuration is 64 bits wide with parity disabled.

55K bytes of non—volatile configuration memory.

31360K bytes of ATA Slot0 CompactFlash (Read/Write)

Configuration register is 0x101

BTSRTR1#

3 To determine the currently installed rommon version, examine the ROM: System Bootstrap line in
the response.

... continued on next page
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[Table J-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step

Action

Compare the installed rommon version information with the filename of the rommon version required
for the network.

NOTE

1. Rommon filename format is similar to the following:
MWR1941_RM2.srec.122-8r.MC3.bin
2. The rommon filename reflects the version number of the software (122-8r.MC3).

If the installed version is the one required for the network skip to steg35.

NOTE

The IOS defaults to the CF memory card (slot0:) directory unless the present working directory has
been changed using the ed command. Determine the present working directory by entering pwd. If
the present working directory has been changed, enter the command cd slotO: to return to the default
setting.

If the installed rommon version is not the one required for the network, determine the amount of
memory available (bytes free) on the CF memory card by entering the following:

dir
A response similar to the following will be displayed:

BTSRTR1#dir
Directory of slot0:/

1 —rw— 7051976 Sep 23 2002 07:24:18 mwrl941—i—mz.122—8.MC2b.bin
2 —rw— 2212 Mar 01 1993 00:14:48 canned—config

31932416 bytes total (24885606 bytes free)
Router#

Be sure there is at least 1 MB (1048580) of free memory.
NOTE

A rommon version file requires approximately 0.7 MB, and space must also be available for a backup
of the router’s startup—config file.

Create a backup of the current BTS router configuration on the CF memory card by entering the
following:

copy nvram:startup—config slot:0

A response similar to the following will be displayed:

BTSRTR1#copy nvram:startup—config slotO0:
Destination filename [startup—config]?

If the default filename displayed in the prompt is correct, press the Enter key to accept it. If it is
missing or not correct, enter the correct filename. A response similar to the following will be
displayed:

Destination filename [startup—config]?
2212 bytes copied in 4.96 secs (553 bytes/sec)
BTSRTR1#

10

Remove the CF memory card from the router by following the procedure in the 1X SC 4812T BTS
FRU Guide .

... continued on next page
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[Table J-14: Verify and Replace Installed rommon Version Using a CF Memory Card Reader

Step Action

11 Insert the CF memory card into the card reader as specified by the card reader manufacturer’s
instructions.

12 | On the LMF computer, click Start > Programs > Windows Explorer to open Windows Explorer.

13 | NOTE
The CF memory card reader will appear as a disk drive in Windows Explorer with a disk drive letter
and icon.

Scroll the left—hand pane of Windows Explorer to locate the icon for the CF memory card.

14 | In the left-hand pane of WindowsExplorer, highlight the CF memory card icon.

15 | In the right~hand pane, verify the files displayed in stefq, above, appear.

16 | Scroll the left-hand pane of Windows Explorer to locate the icon for the directory where the required
rommon version file is stored.

17 | In the right—hand pane, highlight the startup—config file on the CF memory card, note its file size,
and drag it to the icon for the directory where the required rommon version file is stored.

NOTE

After highlighting the startup—config file in the right-hand pane, it may be necessary to scroll the
left—hand pane to see the directory icon where the required rommon version file is stored before
dragging the file.

18 | In the left-hand pane, highlight the directory where the required rommon version file is stored.

19 | In the right-hand pane, verify the startup—con£ig file is in the directory and the file size is the
same as the original on the CF memory card.

20 | In the right—hand pane, highlight the required rommon version file to be transferred to the CF memory
card and drag it to the CF memory card disk drive icon.

NOTE
After highlighting the rommon version file in the right—hand pane, it may be necessary to scroll the
left—hand pane to see the CF memory card disk drive icon before dragging the file.

21 | Verify the rommon version file has been copied to the CF memory card by clicking on the CF memory
card disk drive icon in the left-—hand pane, and being sure that the rommon version file appears in the
in the right—hand pane.

22 | Click Files > Close to close Windows Explorer.

23 | Remove the CF memory card with the rommon version file from the card reader.

24 | Install the CF memory card in the BTS router by following the procedure in the 1X SC 4812T BTS
FRU Guide .

25 | Proceed to Replace installed rommon version, below.
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Recovery From BTS Router Boot to rommon

Introduction

ROM monitor boot conditions

Under certain circumstances the BTS router will initialize with the ROM
monitor (rommon) operating system rather than the IOS. These
circumstances include:

* [OS file is missing from the CF memory card
¢ [OS file is not the first file on the CF memory card
* [OS file image on the CF memory card is corrupted

 Startup—config file contains an outdated boot system line specifying
an IOS file which has been replaced with an updated version

 Startup—config file contains boot system line with typographical
error(s) in the IOS filename

Description

Router operation on rommon is signalled by the display of the rommon
# > prompt, where # is a number which increments each time a
command is issued. Rommon is a low—level operating system which
provides limited capabilities for router testing and troubleshooting
operations, but does not support any operations on files beyond viewing
directory contents or booting from a specified file. As a result, files can
not be copied or deleted when the router is operating on rommon.

Recovery methods

Two recovery methods are included in this section. The first is the
simplest and requires that a valid, uncorrupted IOS version is installed
on the CF memory card. The second method requires additional
equipment and must be used in instances such as when an 10S file is not
installed on the CF memory card or the installed IOS image is corrupted.

Simple Recovery from Boot to rommon

Requirements

Unless it is certain, that the IOS image on the CF memory card is
corrupted, this method should always be the first attempted to recover
the router from a rommon initialization. This method does not require
any additional equipment beyond the items necessary to load canned
configuration files into the BTS router. To be effective, this method does
require that a valid, uncorrupted IOS image file is installed on the
router’s CF memory card.

Recovery

Follow the procedure iqj"able J-15 to attempt a simple recovery from a
BTS router rommon initialization. J
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Table J-15: Simple Recovery from BTS Router rommon Boot

Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 This procedure assumes the LMF computer is set up and connected to the BTS router with an active
HyperTerminal communication session. If it is not, follow the procedure iqj“able J-2 to establish a
HyperTerminal communication session.

2 With the rommon 1 > prompt displayed in the HyperTerminal window, enter the following to identify
the 10S file on the CF memory card:

dir slot0:
A response similar to the following will be displayed:

rommon 1 > dir slotO:

program load complete, entry point: 0x80008000, size: 0xb2a0

Directory of slot0:

2 2212 —rw— canned—config

3 7051976 —rw— mwrl941—i—mz.122—8.MC2a.bin

rommon 2 >

... continued on next page
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Table J-15: Simple Recovery from BTS Router rommon Boot

Step Action

3 Note the IOS filename, and enter the following to begin recovery to an IOS boot:
boot slot0:/0S _filename
Where [0S _filename = the filename of the I0S noted in ste3, above.

A successful 10S re-boot operation will result in display of a response which begins and ends similar
to the following:

rommon 2 > boot slotO:mwrl941—i—mz.122—8.MC2a.bin

program load complete, entry point: 0x80008000, size: 0xb2a0

program load complete, entry point: 0x80008000, size: 0x6b99ac
Self decompressing the image :
HHAHHHHHHHHHHHHAAHHAHAAAAAAAAAAAAAAAAAAAAAAAA AR [OK ]
Smart Init is enabled
smart init is sizing iomem
ID MEMORY_REQ TYPE
00031A 0X005F3C00 MWR1941 Mainboard
0X000F3BB0 public buffer pools
0X00211000 public particle pools

TOTAL: 0X008F87B0

Press RETURN to get started!

4 If the router successfully reboots with the 10S, proceed to steqj.

5 If the router does not reboot with the IOS, perform the following:

S5a — Scroll the HyperTerminal display down until the directory display from stef3, above, is visible.

5b — Compare the 10S filename from the directory display with the filename entered in performing step
3, above.

5c — If the filename was typed incorrectly, repeat ster 3, using care to type the filename correctly.

6 If the router does not reboot with the I0S after typing the filename correctly, proceed tqable J-16 and
perform the extended recovery procedure.

. .. continued on next page
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Table J-15: Simple Recovery from BTS Router rommon Boot

Step Action

CAUTION

The file sequence on the CF memory card can not be verified with application programs which place
the listed file names in alphabetical order (for example, certain Unix telnet applications, Unix
directory listing commands, and Windows file managers such as Windows Explorer). This portion of
the procedure is intended for use only with applications, such as HyperTerminal, which do not list
directory contents alphabetically.

7 After a successful reboot with 10S, perform the following to correct the cause of the boot to rommon:

7a — Enter the dir slot0: command to display the CF memory card directory, and, if the IOS file is

not the first file listed, perform the procedure irﬂable J-10, stepg35 through32, orfable J-12, as
applicable, to correct the situation.

7b — If the IOS file is the first file, enter the following command to display the contents of the
startup—config file:

show startup—config

A response which begins similar to the following will be displayed:

BTSRTR1#sh start
Using 1589 out of 57336 bytes
!

version 12.2

service timestamps debug uptime
service timestamps log uptime
no service password—encryption
!

hostname BTSRTR1
1

boot system slot0O:mwrl1941—i—-m=z.07132002.bin

no logging console
!

username cisco password 0 cisco
!

redundancy
mode y—cable

standalone
!

Tc — If the file listing contains a “boot system” line, examine it for the correct IOS filename.

7d — If the boot system slot0O: filename is incorrect, enter the following, using care to type the filename
correctly:
boot system slot0:/0S_filename
Where [0S _filename = the filename of the I0S noted in steg3, above.
7e — Replace the boot system line in the startup—config file with the line entered in steg7d, above, by
entering the following:
copy runing—config startup—config

... continued on next page
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Table J-15: Simple Recovery from BTS Router rommon Boot

Step Action

7f — Verify the correct IOS filename is now included in the listing by entering the following:
show startup—config

A response which begins similar to the following will be displayed:

BTSRTR1#sh start
Using 1589 out of 57336 bytes
!
version 12.2
service timestamps debug uptime
service timestamps log uptime
no service password—encryption
!
hostname BTSRTR1
!
boot system slot0O:mwrl941—i—mz.122—8.MC2a.bin
no logging console
!
username cisco password 0 cisco
!
redundancy

mode y—cable

standalone
!

g — If the filename is correctly written, enter the following to determine if the router will reboot to
IOS:

reload

A response similar to the following will be displayed:
BTSRTR1#reload

System configuration has been modified. Save? [yes/no]: n
Proceed with reload? [confirm]

8 If prompted to save a modified configuration, enter n for “no,” and press the Enter key.

9 When prompted to proceed with reload, press the Enter key to continue the reload operation.

10 | After a successful reboot with 10S, proceed with other BTS router activities or remove power from the
router and disconnect it

11 If the router still will not successfully boot with IOS, proceed tqable J-16 and perform the extended
recovery procedure.

Extended Recovery from Boot to rommon

Requirements

If rommon boot recovery attempts fail using the simple recovery
method, this method must be used to reboot a BTS router which has
initialized with rommon. This method requires additional equipment
beyond the items necessary to load canned configuration files into the
BTS router. Extended recovery requires formatting the CF memory card
from the rommon—initialized router and reloading the reformatted CF
memory card with the required IOS version.
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Additional equipment required

An additional, formatted, 32 MB CF memory card with the required
version of the IOS installed is required in addition to the equipment and
software required for BTS router canned configuration installation. This
card may be:

* A spare CF memory card which is loaded with the required IOS
version

* A CF memory card from an additional BTS router which is loaded
with the required 10S version

Recovery

Follow the procedure irrJable J-15 to perform an extended recovery
from a BTS router rommon initialization.

Table J-16: Extended Recovery from BTS Router rommon Boot

Step Action
1 This procedure assumes the BTS router is powered and operating on rommon with the LMF computer
set up and connected to the router with an active HyperTerminal communication session. If it is not,
follow the procedure irpFable J-2 to establish a HyperTerminal communication session.
2 Remove the CF memory card from the BTS router following the procedure in the 1X SC 4812T BTS
FRU Guide .
3 Install the additional CF memory card in the router following the procedure in the BTS FRU Guide.
4 Enter the following to obtain the filename of the IOS version loaded on the CF memory card:
dir slot0:
A response similar to the following will be displayed:
rommon 1 > dir slotO:
program load complete, entry point: 0x80008000, size: 0xb2a0
Directory of slot0:
1 7051976 —rw— mwrl941—i—mz.122—8.MC2a.bin
rommon 2 >
5 Note the exact filename displayed for the IOS version.
... continued on next page
J-72 1X SC™ 4812T BTS Optimization/ATP Oct 2003




68P09258A31-A Recovery From BTS Router Boot to rommon

[Table J-16: Extended Recovery from BTS Router rommon Boot

Step Action
6 Enter the following to initialize the router with the IOS on the additional CF memory card:
boot slot0:/0S _filename
Where [0S _filename = the filename of the I0S noted in stegj, above.
A successful 10S re-boot operation will result in display of a response which begins and ends similar
to the following:
rommon 2 > boot slot0:mwrl941—i—-mz.122-8.MC2a.bin
program load complete, entry point: 0x80008000, size: 0xb2a0
program load complete, entry point: 0x80008000, size: 0x6b99ac
Self decompressing the image :
HHAHHHHHHHHHHHHAAHHAHAAAAAAAAAAAAAAAAAAAAAAAA AR [OK ]
Smart Init is enabled
smart init is sizing iomem
ID MEMORY_REQ TYPE
00031A 0X005F3C00 MWR1941 Mainboard
0X000F3BB0 public buffer pools
0X00211000 public particle pools
TOTAL: 0X008F87B0
—— System Configuration Dialog —
Would you like to enter the initial configuration dialog? [yes/no]: n
7 If the router prompts with a question to enter the initial dialog as shown in stefr§), above, type no and
press the Enter key to obtain the user EXEC mode prompt.
8 If the router prompts with Press RETURN to get started!, press the Enter key to obtain the user
EXEC mode prompt.
9 At the user EXEC mode prompt, enter the following to access the privileged EXEC mode:
enable
A response similar to the following will be displayed:
Router> enable
Router#
10 | Remove the additional CF memory card from the BTS router following the procedure in the 71X SC
4812T BTS FRU Guide .
11 | Install the original CF memory card in the router following the procedure in the BTS FRU Guide.
... continued on next page
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[Table J-16: Extended Recovery from BTS Router rommon Boot

Step Action

12 | Format the original CF memory card by entering the following:
format slotO:

A response similar to the following will be displayed:

Router#format slotO:
Format operation may take a while. Continue? [confirm]

13 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation may take a while. Continue? [confirm]
Format operation will destroy all data in ”slot0:”. Continue? [confirm]

14 | Press the Enter key to continue the format operation. A response similar to the following will be
displayed:

Format operation will destroy all data in ”slot0:”. Continue? [confirm]
Format: Drive communication & lst Sector Write OK...
Writing Monlib

Monlib write complete

Format: All system sectors written. OK...

Format: Total sectors in formatted partition: 62560
Format: Total bytes in formatted partition: 32030720

Format: Operation completed successfully.

Format of slot0 complete
Router#

15 | Copy the required IOS version to the formatted original CF memory card by performing one of the
following:

¢ Use the LMF computer and a tftp server following the procedure irJable J-10
¢ Use the LMF computer and a CF memory card reader following the procedure irﬂ" able J-11

16 | If applicable, perform IOS initialization troubleshooting as described irrFable J-15, stepgq through=0.
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Entering or Changing Router FE Interface IP Address

It may be necessary to enter or change the IP addresses and/or operating
parameters for BTS router FE interfaces FE 0 and FE1 without making
other changes in the router configuration files. Procedures in this section
cover these operations.

Prerequisites

The following must be accomplished before entering or changing BTS
router FE port IP addresses and/or operating parameters:

¢ The user has read and understands the content of MWR1941 Wireless
Mobile Edge Router Software Configuration Guide; part number
78—13983-01

* BTS routers must have the required version of the IOS saved on their
installed CF memory card

* BTS routers must have power applied, be operating without alarms
other than span alarms, and have completed boot—up to the user EXEC
mode prompt (BTSRTR—bts#—1—1>)

* The BTS router privileged EXEC mode password has been obtained
from the network administrator

Entering or Changing FE Interface IP Addresses

To enter or change FE interface IP addresses, follow the procedure in
[Jable J-17.

Table J-17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step Action
* IMPORTANT

This procedure does not cover all aspects of BTS router operation and programming. Before performing this
procedure, review BTS router initialization, operation, and programming information and procedures in
MWR1941 Wireless Mobile Edge Router Software Configuration Guide; part number 78—13983—01. Have this
publication available for reference while performing this procedure.

1 Obtain the correct IP addresses and subnet masks for the BTS router FE interfaces from the network
administrator.

2 If a HyperTerminal connection for BTS card/module MMI or BTS router (BTSRTR) communication
has not been created, create one as described iqj"able J-1 of this appendix.

3 Connect the LMF computer to the BTS router, and start a communication session as described in
[Jable J-2 in this appendix.

. .. continued on next page
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Fable J -17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step

Action

NOTE

Examples in this procedure show prompts for BTSRTR-bts#—1—1 and BTSRTR-bts#—1-2, but the
procedure can be used for any router in any BTS router group or a router running the canned
configuration file (BTSRTR1 or BTSRTR?2).

At the BTSRTR-bts#—1—-1> user EXEC mode prompt, enter the following to access the privileged EXEC
mode:

enable
A response similar to the following will be displayed:

BTSRTR—DIs#—1—1> enable

Password:
5 Enter the privileged EXEC mode password. A response similar to the following will be displayed:
BTSRTR-DIs#—1—1> enable
Password:
BTSRTR-DIsH#—1—1#
6 At the BTSRTR-bts#—1—1# privileged EXEC mode prompt, display the FE interface IP addresses by
typing:
show ip interface brief
A response similar to the following will be displayed:
BTSRTR-DIs#—1—1# show ip interface brief
Interface IP Address OK? Method
Status Protocol
FastEthernet0/0 192.168.146.1YES
NVRAM up up
Serial0:0 unassigned YES unset
administratively down down
FastEthernet0/1 unassigned YES
unset administratively down down
Seriall:0 unassigned YES unset
administratively down down
BTSRTR-DIsH#—1—1#
7 For a FastEthernet0/0 (fa0/0) or FastEthernet0/1(fa0/1) interface which does not have a correct or an
assigned IP address, enter the following at the router prompt to access the global configuration mode:
configure terminal
A response similar to the following will be displayed:
BTSRTR-DIs#—1—-1# conf t
Enter configuration commands, one per line. End with CNTL/Z.
BTSRTR-DIs#—1—1 (config)#
. .. continued on next page
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Fable J -17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step Action

8 At the global configure mode prompt, enter the following to access the configure interface submode

for the interface requiring IP address assignment/change:
interface fastethernetinterface#
Where interface# = 0/0 or 0/1, as applicable.
A response similar to the following will be displayed:
BTSRTR-DIs#—1—1 (config)# int fa0/1
BTSRTR-DIs#—1—1 (config—if)#
9 At the configure interface submode prompt, assign or change the interface IP address by entering:
ip address IP_addr subnet_mask
Where:
IP_addr = the required IP address for the interface; for example, 192.168.147.1
subnet_mask = the required subnet mask for the interface; for example, 255.255.255.0
A response similar to the following will be displayed:
BTSRTR-DIs#—1—1 (config—if)# ip address 192.168.147.1 255.255.255.0
BTSRTR-DIs#—1—1 (config—if)#

10 | To complete configuration of the interface, enter the following parameter settings, one at a time,

pressing Enter after each:
duplex full
speed 100
keepalive 1
no shutdown

11 Return to the global configuration mode by entering the exit command. A response similar to the

following will be displayed:
BTSRTR-DIs#—1—1 (config—if)# exit
BTSRTR-DIs#—1—1 (config)#

12 | If the IP address and/or parameters for the other FE interface on the router must be assigned or
changed at this time, repeat stepg 4 througl1 for the other FE interface.

13 | Once the correct parameters have been set for all FE interfaces, return to the privileged EXEC mode
prompt by holding down the Ctrl key and pressing z (Ctrl +z). A response similar to the following
will be displayed:

BTSRTR-DIs#—1—1 (config—if)# "z

01:11:27: %SYS—5—CONFIG I: Configured from console by console

BTSRTR-DIsH#—1—1#

NOTE

Entering exit twice, pressing the Enter key after each entry, will also complete the interface

configuration and return the router to the privileged EXEC mode.

. .. continued on next page

Oct 2003 1X SC™ 4812T BTS Optimization/ATP J-77




Entering or Changing Router FE Interface IP Address 68P09258A31-A

Fable J -17: Enter/Change BTS Router FE Interface IP Addresses & Operating Parameters

Step

Action

14

Save the interface configuration changes to the startup configuration file on the CF memory card by
entering the following:

copy running—config startup—config
A response similar to the following will be displayed:

BTSRTR-DIs#—1—1# copy run start
BTSRTR-DIs#—1—1# Destination filename [startup—config]?

15

Press Enter. A response similar to the following will be displayed:

BTSRTR-DIs#—1—1# copy run start

BTSRTR-DIs#—1—1# Destination filename [startup—config]?
Building configuration...

BTSRTR-DIsH—1—1#

16

If all FE IP address entries/changes for the router are complete, enter the following to return the router
to user EXEC mode:

disable
A response similar to the following will be displayed:

BTSRTR—-DIsH#—1—1# disable
BTSRTR-DIsH—1—1>

17

If no other router requires the FE interfaces to be assigned/changed, proceed to ster30.

18

If FE interfaces on another router must be assigned/changed, disconnect the 8—contact modular plug
from the current router CONSOLE port and connect it to the CONSOLE port of the other router.

19

Press the Enter key, and when the router user EXEC mode prompt appears repeat stequ througlE]I6
for the other router.

20

When the router is in user EXEC mode, close the HyperTerminal session and disconnect the LMF
computer and additional components from the BTS router.
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BTS Router Canned Configuration File

This section presents listings of the blue and red router canned
configuration file contents for the MWR 1941 BTS routers. The blue
router is the primary router on the BTS LAN subnet 192.168.146.0, and
the red router is the primary on BTS LAN subnet 192.168.147.0. The
canned configuration files allow communication with the BTS routers
for both on-site FE cabling connectivity verification and for
downloading the routers from the network with the full, site—specific
operational configuration.

Obtaining the Latest Configuration File Content

The files included here are for example only. The correct canned
configuration file content for each BTS router should be generated at the
OMC-R using the /screl/active/bin/gen_btsrtr_canned_config.ksh script.

Configuration File Examples

Examples of both configuration files are provided in the following
subsections.
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“Blue” BTS Router Canned Configuration

! Canned Config file for BTSRTRI1

version 12.2

service timestamps debug uptime
service timestamps log uptime
no service password—encryption
!

hostname BTSRTR1

!

no logging console

!

!

ip subnet—zero

ip classless

ip pim bidir—enable

!

disable—eadi

!
redundancy
mode y—cable
standby use—interface Loopbackl01l health
standby use—interface Loopbackl02 revertive
standby use—interface Multilinkl backhaul

interface loopback 101
description BTSRTR health loopback
no ip address

interface loopback 102
description BTSRTR revertive loopback
no ip address
!
! configure 1 DSO for BTSRTRLINK
!
controller T1 0/0
description 1st span on BTSRTR
framing esf
linecode b8zs
cablelength short 133
clock source line
channel—group 0 timeslots 1-24 speed 64

! MLPPP bundle with BTSRTRLINK.
! This performs IPCP with RPM when BTSRTR is rebooted
interface Multilink 1
ip address negotiated
no ip route—cache
no cdp enable
ppp multilink
multilink—group 1
no shutdown
]

! Setup Serial Interface for PPP and IPCP, no MLPPP at this time

]

interface Serial0/0:0
no ip address
encapsulation ppp
keepalive 1
ppp multilink
multilink—group 1
no shutdown
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! Setup Ethernet Interfaces and HSRP between them
!
interface FastEthernet0/0
ip address 192.168.146.1 255.255.255.0
keepalive 1
speed 100
full—duplex
standby 1 timers 1 3
standby preempt
standby priority 100
standby ip 192.168.146.3
standby name one
standby track Fa0/1 10
standby 1 track Multilinkl 10
! Track the MWR 1941 health interface
standby 1 track Loopbackl01l 10
! Track the MWR 1941 revertive (compensation) interface
standby 1 track Loopbackl02 5
no shutdown
!
interface FastEthernet0/1
ip address 192.168.147.1 255.255.255.0
keepalive 1
speed 100
full—duplex
standby 2 timers 1 3
standby 2 preempt
standby 2 priority 100
standby 2 ip 192.168.147.3
2
2

H R R R

standby name two

standby track Fa0/0 10

standby 2 track Multilinkl 10

! Track the MWR 1941 health interface

standby 2 track Loopbackl01l 10

! Track the MWR 1941 revertive (compensation) interface
standby 2 track Loopbackl02 5

no shutdown

!
! Set a default route to RPM thru BTSRTRLINK
1

ip route 0.0.0.0 0.0.0.0 Multilink 1
!

line con 0
exec—timeout 15 0
password cisco

line aux 0
login
password cisco

line vty 0 4
login
password cisco

end
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“Red” BTS Router Canned Configuration

! Canned Config file for BTSRTR2

version 12.2

service timestamps debug uptime
service timestamps log uptime
no service password—encryption
!

hostname BTSRTR2

!

no logging console

!

!

ip subnet—zero

ip classless

ip pim bidir—enable

!

disable—eadi

!
redundancy
mode y—cable
standby use—interface Loopbackl01l health
standby use—interface Loopbackl02 revertive
standby use—interface Multilinkl backhaul

interface loopback 101
description BTSRTR health loopback
no ip address

interface loopback 102
description BTSRTR revertive loopback
no ip address
!
! configure 1 DSO for BTSRTRLINK
!
controller T1 0/0
description 1st span on BTSRTR
framing esf
linecode b8zs
cablelength short 133
clock source line
channel—group 0 timeslots 1-24 speed 64

! MLPPP bundle with BTSRTRLINK.
! This performs IPCP with RPM when BTSRTR is rebooted
interface Multilink 1
ip address negotiated
no ip route—cache
no cdp enable
ppp multilink
multilink—group 1
no shutdown
]

! Setup Serial Interface for PPP and IPCP, no MLPPP at this time

]

interface Serial0/0:0
no ip address
encapsulation ppp
keepalive 1
ppp multilink
multilink—group 1
no shutdown
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! Setup Ethernet Interfaces and HSRP between them
!
interface FastEthernet0/0
ip address 192.168.146.2 255.255.255.0
keepalive 1
speed 100
full—duplex
standby 1 timers 1 3
standby preempt
standby priority 100
standby ip 192.168.146.3
standby name one
standby track Fa0/1 10
standby 1 track Multilinkl 10
! Track the MWR 1941 health interface
standby 1 track Loopbackl01l 10
! Track the MWR 1941 revertive (compensation) interface
standby 1 track Loopbackl02 5
no shutdown
!
interface FastEthernet0/1
ip address 192.168.147.2 255.255.255.0
keepalive 1
speed 100
full—duplex
standby 2 timers 1 3
standby 2 preempt
standby 2 priority 100
standby 2 ip 192.168.147.3
2
2

H R R R

standby name two

standby track Fa0/0 10

standby 2 track Multilinkl 10

! Track the MWR 1941 health interface

standby 2 track Loopbackl01l 10

! Track the MWR 1941 revertive (compensation) interface
standby 2 track Loopbackl02 5

no shutdown

!
! Set a default route to RPM thru BTSRTRLINK
1

ip route 0.0.0.0 0.0.0.0 Multilink 1
!

line con 0
exec—timeout 15 0
password cisco

line aux 0
login
password cisco

line vty 0 4
login
password cisco

end
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Preparation for Site Turn—over

Prepare the BTS site for turn—over to the control of the OMC-R by
performing the procedures iqj"able J-18 and-Fable J-19.

Table J-18: Prepare for Site Turn—over

Step Action

1 After disconnecting it from the BTS router, shut down the LMF computer.

2 If any additional external support equipment was used during the installation process, shut it down,
disconnect it from the frame.

3 Account for all tools used and parts removed from the frame during the installation, being sure none
were left inside the frame.

4 Visually inspect the frame for any foreign objects left inside, and remove any discovered.

5 Visually inspect all cable connections, ensuring they are connected as required for normal BTS
operation.
6 Be sure all internal frame cables are routed and secured to prevent damage to them when the frame

doors are closed.

7 Be sure all external frame and BTS router cables are routed and secured so they will not interfere with
normal maintenance and operational activities at the site.

8 Be sure the BTS routers are powered up and not reporting alarms other than span alarms.

Returning the Site to OMC-R Control

Follow the procedure iqj"able J-19 to return the site to OMC-R control.

Table J-19: Returning the Site to Operational Control

Step Action

1 Contact the OMC-R, and notify the operator the installation is complete. Request notification from
the operator when the routers have been downloaded with the full site—specific configurations and are
verified as functioning normally.

2 When notified router operation has been verified and the OMC-R can assume control of the site,
perform the following:

2a — On any frames which were opened, close and secure the cabinet doors.
2b — Verify no alarm conditions are being reported to the OMC—-R with the frame doors closed.
2c — Prepare all equipment, tools, and parts removed from the frame for transport from the site.

What to Do Next

The installation of the Packet Backhaul option is complete. When the
site is secured, there are no further actions to perform at the BTS site.
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Numbers

10BaseT/10Base2 Converter, 1-8
LMF to BTS connection, 3-17

1700 MHz Center Frequencies, Calculating, E-8
1700 MHz PCS Channels, E-7

1900 MHz Center Frequencies, Calculating, E-3
1900 MHz PCS Channels, E-2

2—way Splitter, 1-11

3C-PC-COMBO CBL, 1-8

800 MHz CDMA Channels, E-5

800 MHz Center Frequencies, Calculating, E-5

A

ACTIVE LED
GLI2, 6-23
MCC, 6-27

Advantest R3267 Spectrum Analyzer GPIB Address,
F-8

Advantest R3465, 3-57
Calibrating Test Cable, F-24

Advantest R3465 Communications Test Set GPIB
Address, F-12

Advantest R3562 Signal Generator GPIB Address,
F-9

Agilent 8935 Series E6380 (formerly HP 8935) Test
Set GPIB Address, F-10

Agilent E4406A, calibration, F-27

Agilent E4406A Transmitter Tester GPIB Address,
F-6

Agilent E4432B Signal Generator GPIB Address, F-7

Alarm Connector Location/Pin Numbering SC
4850/4850E, 3-121

ALARM LED, GLI2, 6-23

Alarm Monitor window, 3-120

alarm redundancy tests, BBX2, 3-114

Alarm Reporting Display, 3-120

Alarm tests, redundancy, 3-109
Alarm/Redundancy Tests, Distribution Shelf, 3-113
All Cal/Audit procedure, 3-92

All Cal/Audit Test, 3-97

AMR, No control, 6-17

AMR CDI Alarm Input Verification, test data sheets,
A-18

Ancillary Equipment Frame identification, 1-15
Ancillary frame, when to optimize, C-2
Antenna Map, 3-104

ATP, 4-2
generate report, 4-16
Report, 4-16
test matrix/detailed optimization, C-3
Test Prerequisites, 4-5
Test Procedure, 4-9

Automated Acceptance Test Procedure, 4-2

Backplane DIP switch settings, 2-4
Bay Level Offset calibration failure, 6-7

BBX2
alarm redundancy tests, 3-114
Connector, 6-15
gain set point vs BTS output considerations, D-2
No control in the shelf, 6-17

BLO
Calibration, 3-85
Calibration Audit, 3-94
calibration data file, 3-86
Calibration Failure, 6-7
Download, 3-94

BTS
Ethernet LAN interconnect diagram, 3-33
LMF connection, 3-16, 3-17
system software download, 3-4
test data sheets, redundancy/alarm tests, A-17
when to optimize, C-2

BTS frame
DC Distribution Pre—test, 2-10
DC Power Pre—test, 2-8
initial power—up, 2-15

BTS login, GUI environment, 3-26

BTS router communication session, establishing, J-6
BTS router connections, programming, J-7

Create CAL File, 3-98

C

C—CCP Backplane, Troubleshooting, 6-14, 6-15
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C-CCP Shelf, 1-21
Site Serial Number Check List, A-19

Cable
GPIB, 1-10
LAN Cable, 1-10
Null Modem, 3-45
Setting Loss Values, 3-83
Timimg Reference, 1-10

Cable Calibration
HP8921 with HP PCS Interface (HP83236), F-19
Manual, F-19

cable calibration, automatic, test set—up
Agilent 8935, 3-61
Agilent E4406A/E4432B, 3-63

CAL File, 3-98

Calculating Center Frequencies
1700 MHz, E-8
1900 MHz, E-3
800 MHz, E-5

Calibrate Test Cabling
Communications System Analyzer, 3-80
Signal Generator & Spectrum Analyzer, 3-81

Calibrating, Test Equipment, 3-78
Calibrating Cables, Overview, 3-79
Calibrating Test Cable, Advantest R3465, F-24

Calibration
BLO, 3-85
Cable, 1-6
data file, BLO, 3-86
In—Service, H-16
RF Path, Test Equipment Setup, 3-89
RFDS, 3-106
Test Equipment, 1-6
TX Path, 3-86, 3-89

Test Cable Calibration, 1-6
Test Equipment Calibration, 1-6
Calibration Audit Failure, Troubleshooting, 6-8

Cannot communicate to Communications Analyzer,
6-4

Cannot communicate to Power Meter, 6-3
Cannot download CODE to any device card, 6-5
Cannot Download DATA to any device card, 6-5
Cannot ENABLE device, 6-6

Cannot load BLO, 6-8

Cannot Log into cell-site, 6-3

Cannot perform Code Domain Noise Power
measurement, 6-10

Cannot perform Rho or pilot time offset
measurement, 6-9

Cannot perform Txmask measurement, 6-9

CDF, 3-3
site equipage verification, 3-4
site type and equipage data information, 2-2

CDI Alarm
with Alarms Test Box, 3-122
without Alarms Test Box, 3-124

Cell Site
equipage verification, 2-2
preliminary operations, 2-2
types, 3-3

Cell Site Data File. See CDF

CF Memory Card, J-13
Load, J-15, J-29

Channel elements, No or missing, 6-18

Channels
1700 MHz, E-7
1900 MHz, E-2
800 MHz, E-5

Checksum Failure, 6-12
CIO, Connectors, 6-15

CLI, 3-25
Format Conventions, 3-25
Logging Out, 3-30

Clock Sync Module. See CSM

Cobra RFDS
external housing, 1-35
RF connector panel detail, 1-35

Code Domain Power, 4-7

Code Domain Power and Noise Floor Measurement
Failure, Troubleshooting, 6-10

Code Download Failure, Troubleshooting, 6-5
Command Line Interface, 3-25

command terminal, settings, J-3

Common power supply verification, 2-14

Communications Analyzer Communication Failure,
Troubleshooting, 6-4

communications test set, TX acceptance tests, 4-6
configure tftp server application, J-19
Connect LMF computer to BTS router, J-19

Connector Functionality, Backplane,
Troubleshooting, 6-14
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Copy and Load Cal File to to CBSC, 5-2
Copy CAL Files From Diskette to the CBSC, 5-3
Copy CBSC CDF Files to the LMF, 3-11

Copying CAL files from CDMA LMF to the CBSC,
5-2

Copy CAL files to the CBSC, 5-3

CSM
Clock Source, 3-40
clock source, select, 3-40
Enable, 3-41
frequency verification, 3-45
functions, 3-43
LEDs, 3-43
MMI terminal connection, illustration, 3-47
redundancy/alarm tests, 3-116
Reference Source Configuration Error, 6-12
Troubleshooting, 6-12, 6-13

CSM clock source, select, 3-40
CyberTest, 3-57

D

Data Download Failure, Troubleshooting, 6-5

DC Power Pre—test
+27 V BTS frame detail, 2-8
—48 V BTS frame detail, 2-10
BTS Frame, 2-6
RFDS, 2-12
RFDS detail, 2-12

DC Power Problems, 6-19
DC/DC Converter, LED Status Combinations, 6-21
Device Enable (INS) Failure, Troubleshooting, 6-6

Digital Control Problems, C—CCP Backplane
Troubleshooting, 6-16

Digital Multimeter, 1-10
Directional Coupler, 1-10
Distribution shelf, alarm/redundancy tests, 3-113

Download
BLO, 3-94
BTS, 3-35
BTS system software, 3-4
Non-MGLI2 Devices, 3-39
ROM Code, G-2

Download/Enable MGLlIs, 3-38

E
El, isolate BTS from the E1 spans, 3-15
E4406A, calibration, F-27

Enable
CSMs, 3-41
MCCs, 3-42
Redundant GLIs, 3-42

Equipment setup, VSWR, HP Test Set, [-3

Ethernet LAN
interconnect diagram, 3-33
Transceiver, 1-8

Ethernet maintenance connector interface, illustration,
3-17

External Test Equipment Removal, 5-4

F

Folder Structure Overview, 3-7

Foreword, xxi

Frame Error Rate, 4-8

FREQ Monitor Connector, CSM, 6-23
Frequency counter, optional test equipment, 1-11

Frequency Spectrum
Korean PCS (1700 MHz), E-7
North American Cellular Telephone System (800
MHz), E-5
North American PCS (1900 MHz), E-2

G

Gain set point, BBX, D-2

General Safety, xxiii

Generating an ATP Report, 4-16

General optimization checklist, test data sheets, A-5
Gigatronics 8541C Power Meter GPIB Address, F-15
Gigatronics Power Meter, 3-57

GLI. See Master (MGLI2) and Slave (SGLI2) Group
Line Interface

GLI2
Connector, 6-15
Ethernet Connections, 6-15
LED Status, 6-23
No Control through span line connection, 6-16
No Control via LMF, 6-16

GPIB, set address, HP 437B, F-14
GPIB Cable, 1-10
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GPIB Address
Advantest R3267, F-8
Advantest R3465, F-12
Advantest R3562, F-9
Agilent (formerly HP) 8935, F-10
Agilent E4406A, F-6
Agilent E4432B, F-7
Gigatronics 8541C Power Meter, F-15
Hewlett Packard HP8921a & HP83236A/B, F-11
Motorola CyberTest, F-13

GPIB Interface Box, RS232, F-16

GPS
Initialization/Verification, 3-48
receiver operation, test data sheets, A-6
redundancy alarm tests, 3-116
Test Equipment Setup, 3-46

GPS Bad RX Message Type, 6-12
GPS satellite system, 3-41
Graphical User Interface, 3-19

GUI, 3-19
Logging Out, 3-29

H

Hardware Requirements, 1-7

Hewlett Packard HP8921A and HP83236A/B GPIB
Address, F-11

High Stability 10 MHz Rubidium Standard, 1-11
High—impedance Conductive Wrist Strap, 1-10
HP 437, setting GPIB address, F-14

HP 437B, 3-57

HP 83236 A, F-19

HP 83236A, F-18

HP 8921, 3-57

HP 8921A, System Connectivity Test, F-18

HP 8935, 3-57

HP PCS Interface Test Equipment Setup for Manual
Testing, F-23

HP Test Set, VSWR, 1-3

HSO
Initialization/Verification, 3-54
redundancy/alarm tests, 3-116

HSO Initialization/Verification, 3-44

HyperTerminal Connection, Creating, 3-13

|
I and Q values, B-2
In—Service Calibration, H-13, H-16

Individual ATP Test Background
Code Domain Power/Noise Floor, 4-13
Pilot Time Offset, 4-13
RX Frame Error Rate (FER), 4-14
Tx Mask, 4-11
Waveform Quality (Rho), 4-12

Initial Installation of Boards/Modules, preliminary
operations, 2-3

Initial power tests, test data sheets, A-4

Initial power—up
BTS frame, 2-15
RFDS, 2-15

Initialization/Verification
GPS, 3-48
HSO, 3-54
LFR, 3-52
Inter—frame cabling, when to optimize, C-3
I0S Version Verification, J-13
IP Addresses, Agilent E7495A, 3-75
IS-97 specification, B-2
ISB connectors, 6-14
Isolation, T1/E1 Span, 3-15
Itasca Alarms Test Box, 1-11

L

LAN
BTS frame interconnect, illustration, 3-33
Tester, 1-11

LAN Connectors, GLI2, 6-24
LED, CSM, 3-43

LED Status, 6-21
BBX2, 6-27
CSM, 6-22
DC/DC Converter, 6-21
GLI2, 6-23
LPA, 6-28
MCC, 6-27

LFR
Initialization / Verification, 3-52
receiver operation, test data sheets, A-7
redundancy/alarm tests, 3-116

LFR/HSO, Test Equipment Setup, 3-46
LIF, Load Information File, 3-9
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Line Build Out parameters
configure, 5-6
verify, 5-5

LMF, 3-6
1X FER acceptance test, 4-6
BTS connection, 3-17
Ethernet maintenance connector interface detail,
illustration, 3-17
Installation and Update Procedures, 3-10
platform requirements, 1-7
to BTS connection, 3-16, 3-17
TX acceptance tests, 4-6

LMF BTS displays, 3-19

LMF computer and software, 1-7
LMF Operation, 3-18

LMF Removal, 5-8

Load Information File, 3-9

Loading Code, 3-35

Local Maintenance Facility. See LMF
Logging In to a BTS, 3-26

Logging Out, 3-29
CLI, 3-30
GUI, 3-29

Logical BTS, 1-15
Numbering, 1-16

Login, GUI, 3-26
Login Failure, Troubleshooting, 6-3

LPA
redundancy test, 3-118
test data sheets
convergence, A-9
IM Reduction, A-8

LPA Module LED, 6-28
LPAs, Site Serial Number Check List, A-20

Manual, overview, 1-3

Manual Scope and Layout, 1-2

MASTER LED, GLI2, 6-23

MCC, Enable, 3-42

MGLI, redundancy test RFM frame, 3-119
MGLI2, board detail, MMI port connections, 5-6
Miscellaneous errors, Troubleshooting, 6-6
MMI Connection, 3-31

MMI Connector
CSM, 6-23
GLI2, 6-24
MCC, 6-27

MMI equipment setup, 3-32

MMI Interface Kit, 1-9

Module status indicators, 6-21

Motorola CyberTest GPIB Address, F-13
Multi-FER test Failure, Troubleshooting, 6-11

N

NAM, Valid Ranges, 3-103

NECEF, 3-3

No DC input voltage to Power Supply Module, 6-19

No DC voltage +5 +65 or +15 Volts to a specific
GLI2 BBX2 or Switch board, 6-20

No GPS Reference Source, 6-12
Non-GLI2, Download, 3-39
Null Modem Cable, 3-45

O
Online Help, 3-32

Optimization
Process, 3-2
purpose, 1-4
When, 1-5

Optional Test Equipment, 1-11
frequency counter, 1-11

Oscilloscope, 1-11

P
PA Shelves, 1-22

PCMCIA, Ethernet adapter, LMF to BTS connection,
3-17

Pilot Gain, 4-12, 4-13, 4-14

Pilot Time Offset, 4-7

Pin/Signal Information for ARM A Cable, 3-126
Ping, 3-33

PN Offset
programming information, B-2
usage, B-2

PnMask, I and PnMask Q Values, B-3

Power Conversion Shelf (—48 V BTS Only), Site
Serial Number Check List, A-20
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Power Delta Calibration RF
Advantest, H-5 Adapters, 1-10
HP8921A, H-3 Attenuators, 1-10
HP8935, H-8 Load, 1-10
Power Input, 6-14 RF Path Calibration, 3-89
Power Meter, setting GPIB address, HP437B, F-14 REDS
’ Calibration, 3-106
Power meter, TX acceptance tests, 4-6 DC Power Pre—test, 2-12

Description, 3-99

initial power—up, 2-15
Layout, 1-35

Power supply, converter redundancy, 3-111 Parameter Settings, 3-99

Set Configuration Data, 3-105

RFDS calibration, procedure, 3-107

RFDS parameters
Pre—power tests, test data sheets, A-4 checking, 3-100
setting, 3-100

Power Meter Communication Failure,
Troubleshooting, 6-3

Power Supply Module Interface, 6-15

power supply/converter redundancy, 3-111

Preliminary operations

cell Site types, 2-2 RFDS TSU Calibration Channel Frequencies, 3-106
test data sheets, A-3 rho, 4-7
Prepare to Leave the Site ROM Code, Download, G-2

BTS Site Span Configuration Verification, 5-5

! router configuration, initial , J-20
External Test Equipment Removal, 5-4

Router Configuration Files, Canned, J-8

Procedures to Copy Files to a Diskette, 5-2 Router Initial Configuration, J-2

Pushbuttons and Connectors, GLI2, 6-24 router power—up, J-20

PWR/ALM LED Router Serial Communication, J-5
BBX2, 6-27
CSM, 6-22 RS-232 to GPIB Interface, 1-8
DC/DC Converter, 6-21 RS232 GPIB Interface Box, F-16
generic, 6-21 RX, antenna VSWR, test data sheets, A-18
MCC, 6-27

RX Acceptance Tests, Frame Error Rate, 4-8

R S

RDM, 6-14 Sector Configuration, 1-30

Reduced ATP, 4-3, 6-9 Selecting Test Equipment, 3-75

Set Antenna Map Data, 3-104

Set RFDS Configuration Data, 3-105

Set—up for TX Calibration, 3-91

Setting Cable Loss Values, 3-83

Required documents, 1-12 Setting TX Coupler Loss Value, 3-84

Required test equipment, communications system SGLI2, board detail, MMI port connections, 5-6

1 1-9
AnALyzer Shelf Configuration Switch, 2-4

redundancy/alarm tests, 3-109
Redundant GLIs, Enable, 3-42

Reference Distribution Module, 6-14

Required Test Equipment and Software, 1-6 Signal Generator, 3-82

RESET Pushbutton, GLI2, 6-24 signal generator, 1X FER acceptance test, 4-6

Revision History, xxv Site, equipage verification, 3-4
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Site checklist, data sheets, A-3

Site equipage, CDF/NECEF, 3-3

Site I/O board, T1 span cable connection, 5-9
Site Serial Number Check List, A-19
Software Release caveats, 5-2

Span Framing Format
configure, 5-6
verify, 5-5

Span I/O board
E1 span isolation, illustration, 3-15
T1 span isolation, illustration, 3-15

Span Line
connector , 6-14
T1/E1 Verification Equipment, 1-11

Span line, troubleshooting, 6-29

Span line configuration, troubleshooting, 6-32
Span line traffic, No or missing, 6-17

SPANS LED, GLI2, 6-24

Spectral Purity TX Mask, 4-7

Spectrum Analyzer, 1-11, 3-82

Spectrum Analyzer , HPS594E, 3-57
STATUS LED, GLI2, 6-24

SYNC Monitor Connector, CSM, 6-23
System Connectivity Test, HP8921A, F-18

T

T1
isolate BTS from the T1 spans, 3-15
span connection, 5-9

terminal communication settings, J-3

Test data sheets
AMR CDI Alarm Input Verification, A-18
BTS redundancy/alarm tests, A-17
general optimization checklist, A-5
GPS receiver operation, A-6
initial power tests, A-4
LFR receiver operation, A-7
LPA
convergence, A-9
IM Reduction, A-8
pre—power tests, A-4
preliminary operations, A-3
RX antenna VSWR, A-18
site checklist, A-3
TX antenna VSWR, A-17
TX BLO
Offset/Power Output Verification, A-10
Power Output Verification, A-15

Test Equipment
Automatically Selecting, 3-77
Calibrating, 3-78
Connecting test equipment to the BTS, 3-56
Manually Selecting, 3-76
Reference Chart, 3-58
Selecting, 3-75
verification data sheets, A-2
VSWR, I-2

Test equipment
system analyzer, 1-9
TX acceptance tests, 4-6

Test Equipment Setup, 3-56
GPS & LFR/HSO, 3-46
HP PCS Interface, F-23
RF path calibration, 3-89

Test Matrix, C-4
ATP optimization, C-3

Timing Reference Cables, 1-10
Top Interconnect Plate, 1-21

Index-8 1X SC™ 4812T BTS Optimization/ATP

Oct 2003



68P09258A31-A

Index

Troubleshooting

BBX2 Control Good — No (or Missing) Span Line
Traffic, 6-17

BLO Calibration Failure, 6-7

C-CCP Backplane, 6-14, 6-15

Calibration Audit Failure, 6-8

Code Domain Power and Noise Floor Measurement
Failure, 6-10

Code Download Failure, 6-5

Communications Analyzer Communication Failure,
6-4

CSM Checklist, 6-12

Data Download Failure, 6-5

DC Power Problems, 6-19

Device Enable (INS) Failure, 6-6

Login Failure, 6-3

MGLI2 Control Good — No Control over AMR,
6-17

MGLI2 Control Good — No Control over
Co-located GLI2, 6-16

Miscellaneous Failures, 6-6

Multi—-FER Failure, 6-11

No BBX2 Control in the Shelf — No Control over
Co-located GLI2s, 6-17

No DC Input Voltage to any C—CCP Shelf Module,
6-20

No DC Input Voltage to Power Supply Module,
6-19

No GLI2 Control through Span Line Connection,
6-16

No GLI2 Control via LMF, 6-16

No MCC24 Channel Elements, 6-18

Power Meter Communication Failure, 6-3

Rho and Pilot Time Offset Measurement Failure,
6-9

Set span configuration, 6-32

span problems, 6-29

TX and RX Signal Routing, 6-20

TX Mask Measurement Failure, 6-9

TSU NAM
Parameters, 3-102
Program, 3-108

X
acceptance tests, equipment setup, 4-6
antenna VSWR, test data sheets, A-17

TX & RX Path Calibration, 3-85

TX and RX Frequency vs Channel
1700 MHz, E-8
1900 MHz, E-3
800 MHz, E-5

TX and RX Signal Routing, C-CCP Backplane
Troubleshooting, 6-20

TX ATP Setup, 3-72
TX Audit Test, 3-95

TX BLO, test data sheets
Offset/Power Output Verification, A-10
Power Output Verification, A-15

Tx BLO Nominal Offset, Setup for TX Cal, 3-91

TX calibration, 3-92
All Cal/Audit, 3-92
set—up, Agilent 8935, 3-65, 3-68
RX Frame Error Rate (FER) ATP Background, 4-14

TX Code Domain Power/Noise Floor ATP
Background, 4-13

TX Mask Verification, spectrum analyzer display,
illustration, 4-12

TX OUT connection, 4-5

TX Output Acceptance Tests
Code domain power, 4-7
Pilot Time Offset, 4-7
Spectral purity TX mask, 4-7
Waveform quality (rho), 4-7

TX Path, calibration, 3-86

TX path
audit, 3-95
calibration, 3-89

TX path calibration, 3-92

TX Pilot Time Offset ATP Background, 4-13

TX Spectral Purity (Tx Mask) ATP Background, 4-11
TX Waveform Quality (Rho) ATP Background, 4-12

U

Updating Calibration Data Files
Copy and Load Cal File to to CBSC, 5-2
Software Release caveats, 5-2

UTP, LMF to BTS connection, 3-17

Vv

Verification of Test Equipment, data sheets, A-2
Verify GLI ROM code load, 3-37
Voltage Standing Wave Ratio. See VSWR

VSWR
Advantest Test Set, I-5
Calculation, I-4, I-6
Equation, I-4, I-6
manual test setup detail
Advantest illustration, I-7
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HP illustration, I-4, 1-5 When to optimize
required test equipment, [-2 Ancillary — table, C-2
transmit and receive antenna, [-2 BTS, C-2
inter—frame cabling, C-3

w
Walsh channels, 4-13 X
Warm-up, 1-7 Xircom Model PE3-10B2, LMF to BTS connection,
Waveform Quality (tho), 4-7 3-17
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